Notice

Please do not attempt to operate or repair this equipment without adequate training. Any use, operation or repair you perform that is not in accordance with the information contained in this documentation is at your own risk.

Trademark Acknowledgments

Entrust, Sigma and the hexagon design are trademarks, registered trademarks and/or service marks of the Entrust Corporation in the United States and other countries.

Datacard is a registered trademark and service mark of Entrust Corporation in the United States and other countries.

MasterCard is a registered trademark of MasterCard International Incorporated.

Visa is a registered trademark of Visa International Service Association.

All other product names are the property of their respective owners.

Proprietary Notice

The design and information contained in these materials are protected by US and international copyright laws.

All drawings and information herein are the property of Entrust Corporation. All unauthorized use and reproduction is prohibited.

Entrust Corporation
1187 Park Place
Minneapolis, MN 55379
Phone: 952-933-1223
Fax: 952-933-7971
www.entrust.com

© 2021 Entrust Corporation. All rights reserved.
Safety

The following basic safety tips are given to ensure safe installation, operation and maintenance of Datacard® equipment.

- Connect equipment to a grounded power source. Do not defeat or bypass the ground lead.
- Place the equipment on a stable surface (table) and ensure floors in the work area are dry and non-slip.
- Know the location of equipment branch circuit interrupters or circuit breakers and how to turn them on and off in case of emergency.
- Know the location of fire extinguishers and how to use them. ABC type extinguishers may be used on electrical fires.
- Know local procedures for first aid and emergency assistance at the customer facility.
- Use adequate lighting at the equipment location.
- Maintain the recommended temperature and humidity range in the equipment area.

Safe Human Interface

- Use proper lifting techniques when moving or installing the equipment.
- Use standard electrostatic discharge (ESD) precautions when working on or near electrical circuits.
- Do not defeat or disconnect safety interlocks on covers.

⚠️ Warning: To avoid a possible electric shock, always unplug the system before servicing.

Liability

The WARNING and CAUTION labels have been placed on the equipment for your safety. Please do not attempt to operate or repair this equipment without adequate training. Any use, operation, or repair in contravention of this document is at your own risk.

California Prop

Warning: This product contains chemicals, including lead, known to the State of California to cause cancer, and birth defects or other reproductive harm. Wash hands after handling.

For more information on this warning, refer to:

www.datacard.com/califpropwarning.
## Revision Log

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Description of Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>August 2019</td>
<td>First release of this document with part number 527280-005. This release combines part numbers 527280-001 and 527280-004. The information contained in this document is current for XPS Card Printer Driver version 7.5.</td>
</tr>
<tr>
<td>B</td>
<td>January 2020</td>
<td>Updated for XPS Card Printer Driver version 7.6.</td>
</tr>
<tr>
<td>C</td>
<td>August 2020</td>
<td>Updated for XPS Card Printer Driver version 8.0</td>
</tr>
<tr>
<td>D</td>
<td>April 2021</td>
<td>Updated for XPS Card Printer Driver version 8.1</td>
</tr>
</tbody>
</table>
# Contents

## Chapter 1: About the Card Printer Driver
- Supported Operating Systems ........................................... 1  
- Supported Printers ..................................................... 1  
- Driver Task Overview .................................................. 2  
- Printer/Driver Communication ......................................... 2  
  - Printer/Driver Communications Over a Network ....................... 3  
  - Printer/Driver Communications Using a USB Connection ................. 3

## Chapter 2: XPS Card Printer Driver Installation
- Before You Install ..................................................... 5  
- Installation Overview .................................................. 5  
- Identify Your Installation Requirements ................................ 6  
- Prepare to Install the Card Printer Driver ............................. 7  
  - Download the Installation File (Optional) ............................ 7  
  - Start the Installation .................................................. 8  
- Install the Driver ...................................................... 9  
- Update the Card Printer Driver .......................................... 18  
  - Update Restrictions .................................................. 18  
  - Update the Driver .................................................... 19  
  - Update a Shared Printer Client ........................................ 21  
    - Update a Client PC Manually ....................................... 21  
    - Verify the Client Update .......................................... 23  
- Install Support Files .................................................. 24  
- Install User Documentation ............................................. 25  
- Advanced Setup ...................................................... 25  
  - Connect More Than One Printer ...................................... 26  
    - Print to More Than One Printer From One PC ...................... 26  
    - Install Additional Network Printers ................................ 26  
    - Install Additional USB Printers .................................... 26  
- Use the Card Printer Driver for Secure Printing ....................... 28  
  - Secure Printing Overview ........................................... 28  
  - Set Up Secure Printing ............................................. 29  
- Use Printer Sharing .................................................... 30  
  - Printer Sharing Requirements ....................................... 30  
  - Supported Operating Systems ....................................... 31  
  - Tips for Host PC and Client PC Users ................................ 32  
  - Set Up Group Accounts for Using Shared Printers .................... 33  
  - Use Windows Print Manager ......................................... 34  
- Use Printer Pooling ................................................... 35  
  - Printer Pooling Requirements ....................................... 35  
  - Operating Systems Supported for Printer Pooling .................... 36  
  - Tips for Printer Pooling ............................................ 36  
  - Set Up a Printer Pool ............................................... 37
Chapter 3: Card Printer Driver Management Tasks ................................................. 41
The Printer Properties Window ............................................................................. 41
  General Tab ....................................................................................................... 42
  Sharing Tab ....................................................................................................... 42
  Ports Tab .......................................................................................................... 43
    View Network Information ............................................................................. 43
    Change a Network IP Address ...................................................................... 43
  Advanced Tab .................................................................................................... 47
  Color Management Tab .................................................................................... 47
  Security Tab ....................................................................................................... 48
  Printer Status Tab ............................................................................................. 50
    Printer Status ................................................................................................ 51
    Port Type ........................................................................................................ 52
    Printer Information ......................................................................................... 52
    Print a Driver Sample Card ........................................................................... 52
  Hopper Status Tab ............................................................................................. 56
  Card Counts Tab ............................................................................................... 58
  Supplies Tab ...................................................................................................... 60
  About Tab .......................................................................................................... 62
Uninstall the Card Printer Driver ........................................................................ 63
  Remove Devices ............................................................................................... 63
  Use the Driver Installation CD or Downloaded File ...................................... 66
  Use the Start Menu Uninstall Program ............................................................. 69

Chapter 4: Card Design Tasks ............................................................................. 71
Change a Card Design .......................................................................................... 72
Design Tasks in Windows Printing Preferences ................................................ 73
  Layout Tab ........................................................................................................ 73
    Print on Both Sides of the Card .................................................................. 74
    Set Up Duplex Printing ............................................................................... 74
  Advanced Options ............................................................................................. 76
    Paper Size ....................................................................................................... 76
    Copy Count ..................................................................................................... 77
    Disable Printing ............................................................................................ 78
    Disable Printing Examples ......................................................................... 79
    Obscure Black Panel ..................................................................................... 81
    Card Eject Side .............................................................................................. 82
    Color Mode .................................................................................................... 83
    Print Black Image Pixels Using Monochrome ............................................. 85
    Rotate the Card Image .................................................................................. 88
    Split-Ribbon Color Printing ....................................................................... 89
    Input Hopper ................................................................................................. 92
    Impress Card ............................................................................................... 93
    Embosser Topping ....................................................................................... 95
  Print Area Tab .................................................................................................. 96
Print and Topcoat Blocking ................................................................. 96
Select a Preset Mask ................................................................. 97
Use a User-Defined Topcoat Bitmap ........................................ 98
Select a User-Defined Bitmap .................................................. 100
Select an Erase Pattern ............................................................ 101
Retransfer Card Printer Print Area Tab .................................... 103
Color Adjustment Tab ............................................................... 105
Brightness ................................................................. 105
Contrast ................................................................. 106
Color Balance ............................................................... 107
Print Mode Tab ........................................................................ 108
Select the Print Resolution ................................................... 108
Select the Rewrite Option ....................................................... 109
Lamination Tab ........................................................................ 110
Apply an Overlay ................................................................. 110
Debow the Card ............................................................... 111
About Tab .............................................................................. 111
Printer Setup for Rewritable Cards ...................................... 112
Set Up the Printer ................................................................. 112
Set Up Printer Manager ........................................................... 112
Set Up the Card Printer Driver ............................................ 113
UV and Luster Ribbon Support ............................................. 115
Card Design for UV Ribbon .................................................... 116
Print UV Design Elements ...................................................... 117
Escapes ............................................................................... 118
Print Blocking Escapes .......................................................... 119
About Non-Printing Areas ....................................................... 119
Print Blocking Syntax ............................................................ 120
Print Blocking in a Direct-to-Card Printer ......................... 120
Escape Support for Rewritable Cards ...................................... 123
Print Blocking in a Retransfer Card Printer ......................... 123
Magnetic Stripe Escapes ........................................................... 127
Supported Escapes ............................................................... 127
Set Up Magnetic Stripe Escapes ........................................... 128
Input Hopper Selection Escape ............................................. 129
Laminator Escape ................................................................. 130
Impresser Escapes ................................................................. 131
Laminator Impresser Escape .................................................. 131
Tactile Impresser Escape ....................................................... 132
Apply Additional Retransfer Layer Escape ......................... 133
Apply Peel-Off Escape .............................................................. 134
Embosser Escape ................................................................. 135
Embosser Escape Syntax .......................................................... 135
Escape Preamble ............................................................... 135
Embosser Font Number ........................................................... 135
## Emboss/Indent Position
- Emboss Data Restrictions
- Emboss Example

### Magnetic Stripe Fonts

## Chapter 5: Card Printer Driver Troubleshooting
- USB Installation Troubleshooting
- Reinstall the XPS USB Card Printer Driver
- Network Installation Troubleshooting

### Additional USB Troubleshooting
- Update or Uninstall Cannot Complete
- Additional Driver Troubleshooting
  - Messages Linking to Incorrect Printer URL
  - Message 100 Request Not Supported

### Advanced Troubleshooting Tools

## Appendix A: Windows Printer Sharing
- Installation
  - Set Up the Host PC for Printer Sharing
  - Install the Card Printer Driver on the Client PC

## Appendix B: Windows Server Printer Sharing
- Windows Server Installation
  - Set Up the Host PC for Printer Sharing
  - Install the Card Printer Driver on the Client PC

## Appendix C: Using .INI Files with the Card Printer Driver
- Card Printer Driver INI Support
  - Mask K Panel Data
    - Internal Masks
    - External Masks
    - How a Mask Works
    - KMask.INI File Parameters
    - KMask.INI Examples
    - K Panel Mask Escape
    - Internal Driver Masks
      - Two-Pass Masks
      - Three-Pass Masks
      - Five-Pass Masks
      - Create an Image Mask
      - Two-Pass Mask
      - Three-Pass Mask
  - Block K Panel Data
    - KBlock.INI File Parameters
    - Block K Panel Examples
Specify Image Origin Offsets ........................................... C-22
  ImageOriginOffset.INI File Parameters .............................. C-23
Enable Printing from ID Works and IDCentre ........................ C-23
Print Blocking Areas in ID Works and IDCentre ...................... C-24
  Smart Card Chip Blocking Areas ...................................... C-24
  Magnetic Stripe Blocking Areas ..................................... C-25
Disable Magnetic Stripe Escape Parsing ............................... C-26
Print Trapping .............................................................. C-27
  ColorTrap.INI File Parameters ....................................... C-27
  Print Trapping Considerations ....................................... C-33
Use the Rasterization File ............................................... C-33

Appendix D: Print to a File with the XPS Card Printer Driver ........ D-1

Appendix E: Silent Install and Driver Utility Commands ............... E-1
  Prepare the Files ....................................................... E-1
  Silent Install Command ............................................... E-2
    Network Install ..................................................... E-2
    Network Install Examples ......................................... E-3
    USB Install .......................................................... E-3
    USB Install Examples .............................................. E-4
    Silent Install Messages ............................................ E-4
    Install Support Files .............................................. E-5
  Driver Utility Command .............................................. E-6
    Silent Update ....................................................... E-6
    Silent Uninstall ................................................... E-7

Appendix F: Tactile Identifier Mark Conversion ........................ F-1
Chapter 1: About the Card Printer Driver

The XPS Card Printer Driver uses Microsoft XPS print technology to support printing from currently available applications. This chapter provides a task overview of the Card Printer Driver, and a description of the communication between the Card Printer Driver and the card printer.

Supported Operating Systems

The following operating systems are supported by the Card Printer Driver (the latest service pack is recommended):

- Windows 8.1, 32- and 64-bit
- Supported Windows 10 versions, 32- and 64-bit
- Windows Server 2012 R2
- Windows Server 2016
- Windows Server 2019

For more information about PC and operating system requirements, refer to the printer’s Installation and Administrator’s Guide.

Because the Card Printer Driver supports multiple Windows operating systems, the procedures in this Guide assume you can navigate to the appropriate Windows panels for your system. The Guide describes how to set up and use the Card Printer Driver from the appropriate window (for example, Printer Properties). Operating system-specific exceptions are noted, where necessary.

Supported Printers

The Card Printer Driver supports the following printers:

- Entrust® SD Series: SD160™, SD260™, SD260L™, SD360™, SD460™ Card Printers
- Entrust® CD Series: CD800™, CD800 with CLM CD820™ Card Printers
- Entrust® CE840™ Instant Issuance System
- Entrust® CR805™, CR805 with CLM, CR805 with TIM Retransfer Card Printer
- Entrust® CL900™ Desktop Laser Personalization System
- Entrust® Sigma DS1, DS2, DS3, DS3 with CLM, DS3 with TIM Direct to Card Printers
- Entrust® EM1, EM2 Direct to Card Printers

The information in this Guide applies to all supported printers. Printer-specific differences or exceptions are noted, where necessary.
Driver Task Overview

Refer to “Install the Driver” on page 9 for the steps to follow to install the printer and driver.

After the Card Printer Driver has been installed, it does the following:

1. The Card Printer Driver receives card data from an application.
2. The Card Printer Driver processes it for personalizing a card.
3. Optionally, the Card Printer Driver encrypts data transactions with the printer for secure printing.
4. The Card Printer Driver sends the prepared data to the printer.
5. The Card Printer Driver checks the printer for card completion.
6. The Card Printer Driver displays any conditions (messages) associated with the card job.

The information included in this guide does not apply to all printers supported by the Card Printer Driver. Check your printer configuration label to verify your printer model and the features and options it includes.

Printer/Driver Communication

The printer communicates with the PC through the Card Printer Driver using either a USB cable or an Ethernet cable. For both connection types, the printer treats communication as if the PC is connected over a network.

- You can update printer settings using the Printer Manager web interface or the Printer Dashboard. Refer to the printer’s Installation and Administrator’s Guide for information about using Printer Manager, or the Printer Dashboard Help.
- You can customize applications to control card personalization features through the Card Printer Driver. If you use a customized application, follow the instructions in your application.
- Secure printing is available on current models of SD, CD, and CE series printers, the CR805 Retransfer Card Printer, and some Sigma printer models. Print jobs are secured with data protection automatically when the printer is configured to communicate securely. For more information, refer to “Use the Card Printer Driver for Secure Printing” on page 28.
Printer/Driver Communications Over a Network

The Card Printer Driver requires the current printer IP address when it is connected to the printer over a network. Refer to the printer’s User’s Guide for information on how to retrieve the printer’s IP address.

When both the printer and the PC use an organization’s network, the network affects the speed of data transmission, and can affect who can use the printer. The network printer can have many PCs connected to it, and each PC can be connected to multiple printers over the network.

Printer/Driver Communications Using a USB Connection

Connecting the printer and a PC using a USB cable automatically creates a local network. Each time another printer is connected to the PC, it creates a new local network for the new printer.

You can connect up to eight printers to a PC using USB cables.

⚠️ Sigma card printers use a USB-C (USB 3.0) connection. Other printers require a USB 2.0 connection.
Chapter 2: XPS Card Printer Driver Installation

This chapter provides information about how to install the Card Printer Driver.

Before You Install

The Card Printer Driver can be installed using a CD or flash drive shipped with the printer. You also can install it using a downloaded installation file.

Be aware of the following as you plan to install the Card Printer Driver.

- Prepare the printer before installing the Card Printer Driver. Load the printer supplies and cards as described in your printer’s Quick Install Guide or Installation and Administrator’s Guide.

- The Card Printer Driver installation assigns a default printer name. Each printer must have a different name. The installation automatically creates a unique name.

If your site plans to implement printer sharing, have a printer naming plan in place before installing the Card Printer Driver. You cannot rename a printer after sharing is enabled. Refer to “Use Printer Sharing” on page 30 for more information.

Installation Overview

Basic installation includes the following steps:

1. Identify Your Installation Requirements on page 6.
2. Prepare to Install the Card Printer Driver on page 7.
3. Install the driver based on the printer to PC communication method you are using, either a USB or a network connection. Refer to “Install the Driver” on page 9.
4. Update your existing driver installation if your driver version is 4.0 or newer. Refer to “Update the Card Printer Driver” on page 18.
Advanced printer setup consists of:

- Connect More Than One Printer on page 26
- Use the Card Printer Driver for Secure Printing on page 28
- Use Printer Sharing on page 30
- Use Printer Pooling on page 35

## Identify Your Installation Requirements

How you install and set up the Card Printer Driver depends on how many users print to the card printer, the operating system you use to send card data, and other decisions specific to your environment.

Use the following table to locate the information you need to install and use the Card Printer Driver.

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the Driver</td>
<td>The printer ships with an installation CD or flash drive in the printer carton. The flash drive contains the QuickInstaller, which allows you to install the Card Printer Driver on a Sigma card printer. Refer to “Start the Installation” on page 8.</td>
</tr>
<tr>
<td>Download the Driver</td>
<td>You can download the Card Printer Driver installation file from the Entrust website. Refer to “Download the Installation File (Optional)” on page 7.</td>
</tr>
<tr>
<td>Use a USB Connection</td>
<td>Refer to “Install the Driver” on page 9.</td>
</tr>
<tr>
<td>Use a Network Connection</td>
<td>Refer to “Install the Driver” on page 9.</td>
</tr>
<tr>
<td>Update an Existing Driver</td>
<td>If the Card Printer Driver version 4.0 or newer is installed on your PC, you can update the Driver to the current version without uninstalling the previous version. Refer to “Update the Card Printer Driver” on page 18.</td>
</tr>
<tr>
<td>Use Secure Printing</td>
<td>Refer to “Use the Card Printer Driver for Secure Printing” on page 28.</td>
</tr>
<tr>
<td>Connect to More Than One Printer</td>
<td>Refer to “Connect More Than One Printer” on page 26.</td>
</tr>
</tbody>
</table>
Prepare to Install the Card Printer Driver

This section provides information about installing the Card Printer Driver on a PC running a supported Windows operating system. Refer to “Supported Operating Systems” on page 1 and the printer’s Installation and Administrator’s Guide for complete information about installation requirements.

You can install the driver from the CD that ships with the printer, using the QuickInstaller on the flash drive, or from a downloaded file. Most of the installation process is the same.

Download the Installation File (Optional)

You can install the driver from the downloaded Card Printer Driver installation file.

Your network security configuration might prevent the download or installation of the Card Printer Driver installation file. Ask your network support personnel if you need assistance downloading the file and installing the Card Printer Driver.

Download the current version of the installation file from the Entrust website: https://www.entrust.com

1. Click the Menu icon and select Resource Center > Drivers & Downloads.
2. Select your printer model and then select Drivers.
3. Download the Card Printer Driver .exe file to your PC. The file has a name similar to XPSCardPrinter_x.x.x.exe, where x.x.x is the version number.
4. Continue with “Start the Installation”.

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Printer Sharing</td>
<td>Printer sharing allows one or more PCs (clients) to print cards to a printer installed on a different PC (host). Refer to “Use Printer Sharing” on page 30.</td>
</tr>
<tr>
<td>Use Printer Pooling</td>
<td>A printer pool is a group of printers that act as one printer. Print jobs are sent to the pool and are distributed among the available printers. Refer to “Use Printer Pooling” on page 35 and “Set Up a Printer Pool” on page 37.</td>
</tr>
</tbody>
</table>
Start the Installation

1. Log on to the PC as a user with administrator access.

2. Do one of the following:
   - Insert the Driver Installation CD in the PC’s drive.
   - Browse to the location on the PC where you saved the downloaded file. Double-click the downloaded file.
   
   OR
   
   - Follow the instructions in the QuickInstaller.

3. If the Autoplay dialog box displays, click Run autorun.exe.

4. Click Yes on the User Account Control dialog box if it displays.

   - If you are installing the Card Printer Driver on a system running Windows 8 or newer, and the computer has pending Windows updates, the driver installation stops and the following message displays. Finish installing the Windows updates, restart the computer, and then start the driver installation again.

   ![Printer cannot be Installed]

   - If you are installing the Card Printer Driver on a Windows 7 system, the following message displays.

   ![Operating System Warning]

5. When the driver installer Welcome page displays, you can select to install the printer based on a USB or a network connection. Continue with “Install the Driver” on page 9.
Install the Driver

The following instructions describe how to install the driver using either a USB or a network connection. Most of the installation procedure is the same for either method; differences are noted where necessary. If you are installing the Card Printer Driver using the QuickInstaller, follow the installer instructions.

Caution: If you are installing the driver with a USB connection, do not connect the USB cable to the printer until instructed. If you start this procedure with the USB cable connected, problems can result.

1. Plug in and power on the printer. Make sure that the cards and supplies are loaded correctly. Refer to the printer's Quick Install Guide to prepare the printer.

   The printer LCD panel displays Ready when the printer is completely powered on.

2. On the Welcome page, select Install a Network Printer or Install a USB Printer.
3. The installer displays the license agreement. Read the license agreement and click **Accept**.

If you are installing multiple copies of the driver, you only have to accept the license agreement once.

The Card Printer Driver begins loading.

- If you are using a USB connection, continue with **step 4**.
- If you are using a network connection, skip to **step 5**.
USB Installation:

4. When prompted, connect the printer to the PC with a USB cable, as shown on your screen.

Windows searches for the printer and connects the PC and printer. The **Installing USB Driver** page displays.

Continue with step 9.
Network Installation:

5. Connect the printer to the network with an Ethernet cable.

6. Use the printer LCD panel menu system to retrieve the printer’s IP address. Press the down arrow until the IP address displays and record the address. Refer to the printer’s User’s Guide for complete information about how to retrieve the IP address.

- The Card Printer Driver supports both IPv4 and IPv6 addresses for network-connected printers. Refer to your printer’s User’s Guide for complete information about obtaining an IPv6 address.

7. Enter the IP address.

The Installing Network Driver window displays on your PC.

- Click Get IP Address to display a pdf document that describes how to find the IPv4 address of the printer.
When the installer displays the **Printer Properties Ports** tab, click **Configure Port**.
b. Type the IP address in the Printer Name or IP Address field on the Port Settings window.

   If you are entering an IPv6 address, make sure that you enter the complete address. An IPv6 address requires square brackets at the beginning and end of the address.
   Contact your network administrator for more information about the address mode being used.

8. Click OK on the Port Settings window to save your settings and close the window. Then, click Close on the Ports tab to close the Printer Properties window.
9. A browser window opens, which allows you to launch Printer Manager or the Printer Dashboard.

![Certificate Error Notification]

When the browser window opens, a warning message displays indicating a problem with the website's security certificate. Continue to the website to launch the Printer Dashboard or start Printer Manager.

Continue with step 10.
10. When the Card Printer Driver is installed, the **Installation Complete** page displays. Test the printer by printing a sample card. Make sure that **Ready** displays on the LCD screen, and click **Print Sample Card**.

11. Click **Exit** to close the install window.

- The printer icon displays in the Devices and Printers window. Refer to **Chapter 3: "Card Printer Driver Management Tasks"** and **Chapter 4: "Card Design Tasks"**.
- A shortcut to the Printer Dashboard is placed on the desktop and in the Windows Start menu. Use the shortcut to launch the Printer Dashboard if you installed a Sigma card printer, or to start Printer Manager if the printer is a retransfer card printer or an SD, CD, or CE direct-to-card printer.
  - Double-click the shortcut icon to open the Start Printer Dashboard window.

- CE840 instant issuance systems that do not have a printhead installed cannot print a sample card to verify driver operation.
- Card printers that support rewritable card printing cannot print the driver sample card to a rewritable card at this time. You can, however, print the sample card using the print ribbon to verify that the computer and printer are able to communicate. Refer to “Printer Setup for Rewritable Cards” on page 112 for complete information about printing rewritable cards.

For information about how to print a printer test card, refer to the printer’s **User’s Guide**.
ii. Click **Start**. If more than one printer is installed, select a printer from drop-down menu and then click **Start**.

![Start Printer Dashboard Window](image)

iii. A window opens in your default browser. Continue to the website to launch the Printer Dashboard, or start Printer Manager.

For information about using the Printer Dashboard, refer to the Printer Dashboard Help. Refer to the printer’s *Installation and Administrator’s Guide* for information about using Printer Manager.

If necessary, you can install additional support files. Click the second icon (upper left) on the **Welcome** page, and select the items you want to install (such as legacy support files for enhanced backward compatibility). Refer to “Install Support Files” on page 24 for more information.
Update the Card Printer Driver

If the currently installed Card Printer Driver is version 4.0 or newer, you can update to the latest driver version without having to remove all installed printers and reinstall the new driver. Use the Card Printer Driver update process to install the new version. The updated Card Printer Driver retains your printing preferences and selections from the previous version. In addition to individual installed printers, you can update the Card Printer Driver in the following cases:

- You have a number of printers set up as a printer pool.
- If your configuration consists of a host system with shared clients, you can update the Card Printer Driver on the host system. Refer to “Update a Shared Printer Client” on page 21 for information about updating the client systems.

If you need to add a new printer after updating the Card Printer Driver, refer to “Install the Driver” on page 9.

Update Restrictions

The Update the Driver option does not display if any of the following are true.

- You are installing the Card Printer Driver for the first time.
- The installed Card Printer Driver is:
  - Older than version 4.0.

  To find the Card Printer Driver version installed on your computer, open the XPS Card Printer Properties window for a printer and click the About tab. Refer to “About Tab” on page 62.
  - The same version or newer than the version to which you are trying to update.

If you select Install a USB Printer or Install a Network Printer from the installer Welcome page, a message displays stating that you must remove the current driver, and then run the installation again. Refer to “Uninstall the Card Printer Driver” on page 63 for more information.

- The current Card Printer Driver has already been uninstalled.
- The Card Printer Driver is installed on a shared client PC.

If you need to remove the current Card Printer Driver from your PC, click the Remove the Driver icon and follow the instructions (refer to “Uninstall the Card Printer Driver” on page 63). The installer Welcome page then displays with the Install options enabled.
Update the Driver

The Card Printer Driver update requires that you restart your computer. Plan to perform the update when no cards are printing and at a time that does not interfere with your production schedule.

To update the Card Printer Driver:

1. Log on to the PC where the Card Printer Driver is installed.

2. Insert the Driver Installation CD or double-click the downloaded installation file.

   The Installer **Welcome** page displays.

   Click **Update the Driver**.
3. The **Update the Driver** page displays.
   
   Click **Update Now** to start the update process.

![Update the Driver](image1.png)

4. The **Update Complete** page displays.
   
   Click **Restart Now** to restart the computer and complete the update.

![Update Complete](image2.png)
If the update fails to complete, the **Driver Update Failed** dialog box displays. Click **Remove Driver** to remove the driver from the PC. You then can install the driver as a new install (refer to “Install the Driver” on page 9).

The Card Printer Driver occasionally issues a message that it cannot complete the update because there are active print jobs. Refer to “Update or Uninstall Cannot Complete” on page 149 to resolve the issue.

**Update a Shared Printer Client**

If you use printer sharing, the host PC and all client PCs must be at the same version of the Card Printer Driver to work properly.

You must update the Card Printer Driver on each client PC manually.

**Update a Client PC Manually**

To update the Card Printer Driver on a client system, do the following.

You may need to restart the client PC before proceeding with the following steps. If the **Update driver** option displays when you select the printer, you do not need to restart the PC.

1. Make sure that the host computer has been updated. Refer to “Update the Card Printer Driver” on page 18.
2. Open the **Devices and Printers** window on the client PC.
3. Right-click the printer name and select **Update driver** from the menu. The text “Needs new driver” also displays as a Status message.

   ![Driver Update Status](image)

   If **Update driver** does not appear in the menu, send a card to the printer. A message to install the driver displays.

4. If the **Do you trust this printer** dialog box displays, click **Install Driver**.

   The updated Card Printer Driver is installed on the client PC.

5. Restart the client PC to complete the Card Printer Driver update.

   Update each shared client computer using this procedure.

   ![Driver Update Dialog](image)

The Card Printer Driver installs a folder containing several .INI files on the host system (refer to Appendix C: "Using .INI Files with the Card Printer Driver" for complete information how to use the .INI files). The folder is not installed (or updated) automatically on the client system.

Do the following only if you plan to use the .INI files on the client system:

1. Create (or locate) the following folder on the client system:
   
   ```
   C:\ProgramData\Datacard\XPS Card Printer
   ```

   **Note:** If you have other Entrust software applications already installed, the `C:\ProgramData\Datacard\` folder may already exist.

2. On the host system, copy the **XPS Card Printer** folder using the following path:
   
   ```
   C:\ProgramData\Datacard\XPS Card Printer
   ```

3. Paste the **XPS Card Printer** folder in `C:\ProgramData\Datacard\` on the client system.
Verify the Client Update

After the client PC has been updated with the new Card Printer Driver version, verify that the update completed properly and that your settings and preferences were not changed.

1. Open the **Devices and Printers** window on the client PC and right-click the printer icon.
2. Select either **Printer properties** or **Printing preferences** and select the **About** tab.
3. Verify that the driver version is correct.
4. Review your printer properties settings and printing preferences and verify that they are correct. Make sure that any new or changed settings included in the updated driver version are set properly.
5. Print sample cards to confirm that cards print successfully.
Install Support Files

1. Display the Card Printer Installation Welcome window. Refer to “Start the Installation” on page 8.

   You can use the Driver Installation CD, a downloaded file, or the QuickInstaller.

2. Select the Install driver support items icon at the top of the installation window (see right).

   The support options window displays.

3. Select from the following support options and click Install Now.

   - **Shared Printer Client Support:**
     - **Magnetic stripe fonts**—Select this option if the shared printer client PC processes magnetic stripe cards using magnetic stripe fonts.
     - **Custom masking bitmaps**—Select this option if you plan to use custom user-defined bitmaps on the client system. The bitmaps are installed automatically on a host system, but you must select this option to install them on a shared client system. Refer to “The back of the completed card looks like the following:” on page 97 and “Select an Erase Pattern” on page 101 for more information.

   - **Legacy Application Support:**
     - **Legacy magnetic stripe fonts**—Select this option if you have an application that uses magnetic stripe fonts from older generation desktop printers.
     - **XPS Card Printer Plug-in**—Select this option to install the XPS Card Printer plug-in for your ID software. A wizard guides you through the plug-in installation.
4. After you install the needed support files, close the **Card Printer Installation** window.

   Restart your computer after installing the magnetic stripe fonts to make sure that the fonts are available to your application.

### Install User Documentation

Install the card printer documentation files from the separate documentation CD or from the flash drive. The document set can include the following user manuals:

- *Quick Install Guide*
- *XPS Card Printer Driver User’s Guide*
- *User’s Guide*
- *Installation and Administrator’s Guide*
- *User Reference Guide* (certain printers only)
- *OpenCard Data Format Guide* (certain printers only)
- *Software Development Kit (SDK) Programmer’s Reference Guide*
- *XPS Card Printer Plug-in User’s Guide*

### Advanced Setup

Advanced setup options help you set up your installation to fit your operation’s needs. Advanced setup includes the following:

- **Connect More Than One Printer** on page 26
- **Use the Card Printer Driver for Secure Printing** on page 28
- **Use Printer Sharing** on page 30
- **Use Printer Pooling** on page 35
Connect More Than One Printer

There are several options for connecting more than one printer to a PC. You can connect to several printers installed on an Ethernet network, or connect multiple printers to a PC with USB cables.

Print to More Than One Printer From One PC

When you print to more than one printer from one PC, keep the following in mind:

- Keep track of the printer names. When messages display, the title bar of the message displays the name of the printer that issued the message.
- Select the printer to use from within the card production application. Card jobs are sent to the selected printer even if more than one card printer is attached to the PC.
- Each printer has its own icon in the Printers window, and each printer has separate Properties and Printing Preferences windows. Settings are not shared among printers.
- Do not install a mix of non-secure and secure printers on PCs that require secure printing. Refer to your printer’s Installation and Administrator’s Guide for more information about printers that support secure communication.

Install Additional Network Printers

You can connect to multiple network printers from a single PC. To add a network printer, start the XPS Card Printer Installer and follow the procedure for installing a network printer described in “Install the Driver” on page 9. Do this for each additional printer you want to install. Make sure that the IP address of each printer is available to enter when prompted during the installation.

Install Additional USB Printers

Use the following guidelines to install more than one printer with USB cables:

- Connect and install one printer at a time. The PC cannot run more than one installation program at a time.
- You can connect up to eight printers to a PC with USB cables.
- If you need to connect two card printers to a PC with one USB port, use an independently powered, high-speed USB hub (USB 2.0 or 3.0) to which both printers can connect. Do not daisy-chain multiple hubs. (Self-powered hubs are recommended.)
- Each printer must remain powered on and in the Ready state during installation.
For each USB printer installed after the initial USB installation, do the following:

1. Load supplies and power on the printer before starting the installation. Refer to the printer’s *User’s Guide* for the steps to load cards and ribbon.

2. Log on to the PC as a user with administrator access.

3. Connect the Ready printer to the PC with a USB cable.

4. The operating system detects the new device and begins installation. The installation process varies depending on your system’s current setup.
   - A pop-up window may display during installation.
     - If the operating system does not display a pop-up window within a few minutes, check all cables and connections to the printer, and then look at the PC’s **Printers** window to determine whether the icon for the new printer displays. The software sometimes installs without displaying the pop-up window.
   - The operating system usually uses the existing Card Printer Driver files to install the driver for the new printer. Insert the Driver Installation CD only if prompted.
Use the Card Printer Driver for Secure Printing

Secure printing encrypts print commands and card data and transmits the information securely from the PC to the printer. When the Card Printer Driver detects that a printer is enabled for secure communications, it encrypts the data before sending it to the printer. Refer to your printer’s Installation and Administrator’s Guide for more information about printers that support secure communication.

Secure Printing Overview

Printers can use one of three protocols for communication. These protocols are named for the printer command language protocols used to send card print data between the Card Printer Driver and the printer.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Secure/Non-Secure</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>DPCL</td>
<td>Non-Secure</td>
<td>9100</td>
</tr>
<tr>
<td>DPCL2</td>
<td>Non-Secure</td>
<td>9100</td>
</tr>
<tr>
<td>DPCL2Secure</td>
<td>Secure</td>
<td>9111</td>
</tr>
</tbody>
</table>

Printers are shipped with all communication protocols enabled. The Card Printer Driver can establish communication with the printer using any of the enabled protocols. The driver uses the DPCL2Secure protocol for secure communication with the printer. To ensure secure communication, you must disable DPCL2. Printers that do not support secure printing use DPCL only.

You specify the communication protocol to use through the Printer Manager web interface or the Printer Dashboard. Refer to the printer’s Installation and Administrator’s Guide for more information about secure printing requirements and how to use Printer Manager to enable or disable a communication protocol. If you use the Printer Dashboard, refer to the dashboard Help for more information. The following table shows the communication protocol used by the Card Printer Driver based on the Printer Manager or Printer Dashboard Behavior settings.

The Behavior > DPCLSecure protocol is not supported by the printer.
Set Up Secure Printing

Do the following to set up secure printing:

1. Install a printer that supports secure printing. Refer to the printer’s *Installation and Administrator’s Guide* for a list of hardware and software requirements.

2. Install and set up the Card Printer Driver. Refer to “Install the Driver” on page 9.

3. Do one of the following to enable secure printing:
   - If you use Printer Manager:
     i. Sign on as a WebAdmin and select **Printer Setting > Behavior**.
     ii. Set **DPCL2** to **Disabled**, and make sure that **DPCL2Secure** is set to **Enabled**.
        Refer to the printer’s *Installation and Administrator’s Guide* for complete information about using Printer Manager.
     iii. Click **Set Current** to save your changes.
   - If you use the Printer Dashboard:
     i. Sign on as a user with Administrator privileges.
     ii. From the Menu icon, select **Configuration > Settings > Behavior**.
     iii. Set **DPCL2** to **Disabled**, and make sure that **DPCL2Secure** is set to **Enabled**.
        Refer to the Printer Dashboard Help for more information.
     iv. Click **Save** to save your changes.
4. Restart the printer and computer for the settings to take effect.

5. Connect your secure printers to the host and client PCs.

After secure printing is set up, the Card Printer Driver automatically detects and uses secure printing during card production.

Use Printer Sharing

You can share a printer over a network using Microsoft File and Printer Sharing.

Shared printing includes a host PC and up to 10 client PCs. The printer is connected to a host PC that has the Card Printer Driver installed. Client PCs then print to the shared printer over a network. Client PCs do not have the same level of access to the Card Printer Driver as the host PC.

Printer Sharing Requirements

Before sharing a printer over a network, make sure that the following requirements are met:

- Each PC that uses the printer must be connected to the same network, workgroup, or domain.
- The host and the client PC must be using the same type of processor, either 32- or 64-bit.
- The host PC must be configured and enabled for sharing.
- The host PC must remain on at all times with the Windows operating system running.
- The host PC must grant permissions for users that print to the shared printer.
- When multiple user accounts are configured on a shared printer client, users should log off and on when switching from one account to another. Using the Windows “Switch User” feature keeps multiple user accounts logged on and may cause the same message from the printer to display several times.
- Change the host printer name to meet the following requirements:
  - The name of a shared (host) printer is the name you assign plus the server name (which is added by Windows). The server name is the network name of the host PC.
  - For best results, use a name with eight or fewer characters. The printer name, including the server name, cannot be longer than 30 characters.
  - The printer name cannot contain special characters. Follow Windows guidelines for allowed characters and naming restrictions.
• When sending a print job to a shared printer using the driver SDK, send the fully qualified printer name to the printer. For more information about using the SDK, refer to the printer's *Windows Driver Software Development Kit Programmer’s Reference Guide*.

• If you need to rename a printer, do it before you enable printer sharing.

**Caution:** Renaming shared printers is not supported. Do not change printer names after sharing is enabled, because print requests may fail and reinstallation may be necessary.

**Supported Operating Systems**

The Card Printer Driver supports the following host and client operating system combinations. See the appropriate appendix for printer sharing setup information for your host and client systems.

<table>
<thead>
<tr>
<th>Host</th>
<th>Client</th>
<th>Refer to</th>
</tr>
</thead>
<tbody>
<tr>
<td>64-bit: Windows 8.1</td>
<td>64-bit: Windows 8.1</td>
<td>Appendix A: &quot;Windows Printer Sharing&quot;</td>
</tr>
<tr>
<td>Windows 10</td>
<td>Windows 8.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 10</td>
<td></td>
</tr>
<tr>
<td>64-bit: Windows Server 2012 R2</td>
<td>64-bit: Windows 8.1</td>
<td>Appendix B: &quot;Windows Server Printer Sharing&quot;</td>
</tr>
<tr>
<td>Windows Server 2016</td>
<td>Windows 8.1</td>
<td></td>
</tr>
<tr>
<td>Windows Server 2019</td>
<td>Windows 10</td>
<td></td>
</tr>
</tbody>
</table>
## Tips for Host PC and Client PC Users

The user at the host PC has more control over the printer. The host PC typically is located near the printer and is used by administrator-level users.

The following table describes some of the tasks that can be performed at the host and client PCs. Understanding these tips for setting up and managing shared printers can help you install and modify your printer setup for your operation's unique needs.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Printer Sharing Tips</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host PC Users:</strong></td>
<td></td>
</tr>
<tr>
<td>Manage print queue</td>
<td>Use the Windows Print Manager to manage print jobs.</td>
</tr>
<tr>
<td>Secure printing</td>
<td>To ensure secure printing, make sure that:</td>
</tr>
<tr>
<td></td>
<td>• The printer you install and share supports secure printing.</td>
</tr>
<tr>
<td></td>
<td>• Secure printing is enabled in Printer Manager.</td>
</tr>
<tr>
<td></td>
<td>Refer to “Use the Card Printer Driver for Secure Printing” on page 28.</td>
</tr>
<tr>
<td>Security permissions for shared printers</td>
<td>Set up a Windows group account with the users who have the same printer security permissions.</td>
</tr>
<tr>
<td></td>
<td>For more information, refer to:</td>
</tr>
<tr>
<td></td>
<td>“Set Up Group Accounts for Using Shared Printers” on page 33.</td>
</tr>
<tr>
<td>View messages</td>
<td>To set up accounts to view messages:</td>
</tr>
<tr>
<td></td>
<td>• Enable printer sharing on the Windows Printer Properties Sharing tab.</td>
</tr>
<tr>
<td></td>
<td>• Set up applicable user accounts on the Windows Printer Properties Security tab. Select the Print and the Manage this printer permissions for each user or group.</td>
</tr>
<tr>
<td></td>
<td>Selecting both of these settings lets individual users or groups print and view messages from their PCs.</td>
</tr>
<tr>
<td>View printer status, supplies, and card counts</td>
<td>For more information, refer to the following topics:</td>
</tr>
<tr>
<td></td>
<td>• Printer Status Tab on page 50</td>
</tr>
<tr>
<td></td>
<td>• Card Counts Tab on page 58</td>
</tr>
<tr>
<td></td>
<td>• Supplies Tab on page 60</td>
</tr>
<tr>
<td><strong>Client PC Users:</strong></td>
<td></td>
</tr>
<tr>
<td>Allow printing and viewing of messages</td>
<td>Client PC users may be able to view printer messages. The buttons in the message let users resolve some issues without going to the printer. Refer to the “Configure Security” section in the appendix for your operating system.</td>
</tr>
</tbody>
</table>
Set Up Group Accounts for Using Shared Printers

If you want to define which users can both print cards and view messages, we recommend the following:

1. Create a group account.
2. Assign the client user accounts allowed to use the printer to the group account.
3. Use the shared printer’s Printer Properties Security tab and select the Print and Manage this printer permissions to allow the group to print and display messages.

For more information, refer to the Microsoft documentation on setting up group accounts and printer security permissions, and the following instructions for your configuration:

- Appendix A: "Windows Printer Sharing"
- Appendix B: "Windows Server Printer Sharing"
Use Windows Print Manager

Windows Print Manager is one tool available for managing print jobs across your host and client systems. Do not confuse Windows Print Manager (shown) with the printer’s Printer Manager web interface.

If Windows Print Manager is already open, press **F5** to update the current print job status in the Print Manager window.
Use Printer Pooling

Printer pooling is used in card production environments in which an application prints to a group of printers. The user chooses to print to the pool and the pool distributes the print jobs to the next available printer.

- Printer Pooling Requirements
- Operating Systems Supported for Printer Pooling on page 36
- Tips for Printer Pooling on page 36
- Set Up a Printer Pool on page 37

Printer Pooling Requirements

Printer pooling requires that you set up all printers in a pool with the same basic setup, except as noted below. The setup includes connecting printers across a network using an Ethernet cable, using the same ribbons, and setting up for non-interactive printing.

<table>
<thead>
<tr>
<th>All printers in a printer pool must have the same:</th>
<th>With:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model number</td>
<td>The same printing features installed, as outlined in this table. <strong>Note:</strong> Do not place non-secure printers in pools where secure printing is needed. For more information about secure printing, refer to “Use the Card Printer Driver for Secure Printing” on page 28.</td>
</tr>
<tr>
<td>For example, a pool includes:</td>
<td></td>
</tr>
<tr>
<td>Only SD260L models, OR</td>
<td></td>
</tr>
<tr>
<td>Only SD360 models, OR</td>
<td></td>
</tr>
<tr>
<td>Only CD800 models, OR</td>
<td></td>
</tr>
<tr>
<td>Only CR805 models, OR</td>
<td></td>
</tr>
<tr>
<td>Only Sigma DS3 models</td>
<td></td>
</tr>
<tr>
<td>Supplies</td>
<td>The same settings applied. For information about defining printer ribbon settings, resolution, and other print settings, refer to “Design Tasks in Windows Printing Preferences” on page 73.</td>
</tr>
<tr>
<td>Network cable type—Ethernet only</td>
<td>No USB-connected printers. Printer pooling is <strong>not supported</strong> for USB-connected printers.</td>
</tr>
<tr>
<td>Non-interactive printing requirements</td>
<td>No direct, printer-to-PC processing is permitted. Interactive print processing requires a connection to a printer, which is not possible when using a pooled printer. <strong>Note:</strong> Smart card and magnetic stripe read commands cannot be processed on printers in a pool.</td>
</tr>
<tr>
<td>Printer Manager settings and magnetic stripe values</td>
<td>Refer to the printer's <em>Installation and Administrator's Guide</em> for more information.</td>
</tr>
</tbody>
</table>

For instructions to set up printer pooling, refer to “Set Up a Printer Pool” on page 37.
Operating Systems Supported for Printer Pooling

Printer pooling is supported on all Card Printer Driver-supported operating systems. For more information about supported operating systems, refer to the printer’s *Installation and Administrator’s Guide*.

Tips for Printer Pooling

<table>
<thead>
<tr>
<th>Feature</th>
<th>Tip for Printer Pooling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error messages</td>
<td>Messages display the name of the main printer named during the Card Printer Driver installation, rather than the name of the specific printer in error.</td>
</tr>
<tr>
<td></td>
<td>• To locate the printer with the error condition, look at each printer in the pool for warning indicators or LCD messages.</td>
</tr>
<tr>
<td></td>
<td>• Card jobs are held at the printer with the error condition. All subsequent card jobs print to other printers in the pool. The printer with the error is not used by the pool until the error condition is corrected.</td>
</tr>
<tr>
<td></td>
<td>• After correcting the error at the printer, resume or cancel the print job using the error message on the PC.</td>
</tr>
<tr>
<td>Printer Pooling information</td>
<td>Printer status, card count, and supplies information typically shown in the Windows <em>Printer Properties</em> window is not available to printers belonging to a printer pool.</td>
</tr>
<tr>
<td></td>
<td>For these printers, the <em>Printer Status</em> tab displays the status as “Printer pooling,” which indicates that the printer belongs to a printer pool.</td>
</tr>
<tr>
<td></td>
<td>Use Printer Manager to view card counts, supply information, and the status of individual printers in the pool. Refer to the printer’s <em>Installation and Administrator’s Guide</em> for information about using Printer Manager.</td>
</tr>
<tr>
<td>Shared Printers</td>
<td>Shared printers can be part of a printer pool.</td>
</tr>
<tr>
<td>Print Sample Card and Magstripe Test Card are not available</td>
<td>The Print Sample Card and Magstripe Test Card buttons on the <em>Printer Properties</em> window <em>Status</em> tab are not available for a printer belonging to a printer pool. Print sample cards or test cards from the LCD panel on each printer.</td>
</tr>
</tbody>
</table>
Set Up a Printer Pool

The following steps describe how to set up printer pooling for all supported Windows operating systems. Operating system-specific differences are noted, where necessary. The screens shown may differ slightly from those on your system.

1. Install the first network printer on the host PC. Refer to “Install the Driver” on page 9.
2. Connect each additional printer you want to include in the pool to the network using an Ethernet cable.
3. Write down the IP address of each printer. Refer to your printer’s User’s Guide for details about how to obtain the IP address.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Tip for Printer Pooling</th>
</tr>
</thead>
</table>
| Printer pool print queues| A printer that cannot process jobs continues to have jobs assigned to it by the pool controller. The Card Printer Driver does not determine if each printer in the pool is ready to receive card jobs. Remove printers that are not available from the pool until they are functioning and ready to receive print jobs:  
  1. To remove a printer from the pool, open the Printer Properties window and click the Ports tab.  
  2. Remove the check mark from the port assigned to the printer. Some software, such as Microsoft Office (for example, Word, Excel, Access), sends multiple-card (batch) files as a single print job. In this case, the pool sends all cards in the batch to the same printer. Software designed specifically for card production sends each card in the batch as a separate print job. The printer pool distributes these print jobs among the available printers. |
| Multiple active jobs     | • Pooled printers process only the current active job, so only one job is sent to the printer at a time. Pooled printers pause briefly between jobs.  
  • When printers with laminators are pooled, each printer is restricted to processing one card at a time. When not pooled, a laminating printer can have up to three cards in process. |
4. Configure the network printers for printer pooling.
   
a. Display the Devices and Printers window for your operating system.

   Windows Server versions: Select the printer and click Print server properties on the menu bar.

b. Right-click the card printer icon and select Printer properties to display the Printer Properties window.

c. Select the Ports tab.
   
   Windows Server versions: On the Print Server Properties Ports tab, scroll down and highlight the printer to add to the pool. Click Change Port Settings.

d. Click Add Port.
   
The Printer Ports window displays.


f. Follow the instructions in the wizard to add the port. Click Next to display each step in the wizard.

g. In the Printer Name or IP Address field, enter the name or IP address of the printer you are adding.

h. In the Port Name field, enter a name, such as Pooled Printer 2.

i. Click Next.
   
   If the Additional Port Information Required page displays, select Custom and click Next.

j. When the last page of the wizard displays, click Finish.

k. Repeat these steps for each printer you want to add to the pool.

l. Close the Printer Ports window.
m. Disable SNMP for each added printer.

i. On the Ports tab, select a printer that you want to add to the pool and click **Configure Port**.

ii. On the **Configure Standard TCP/IP Port Monitor** window, make sure that SNMP Status Enabled is not checked.

iii. Click **OK** to close the Configure Standard TCP/IP Port Monitor window.

iv. Select the next printer that you want to add to the pool and repeat steps i through iii.

n. Click **Apply** on the Ports tab after all printers and ports have been added and configured.

*Windows Server versions:* Close the Print Server Properties window.

5. Enable printer pooling.

a. On the Devices and Printers window, right-click the printer icon and select **Printer properties**.

b. Select the Ports tab. The list of printer ports displays.

c. Select the Port check box for the printer that you want to represent the pool. (This is the printer that users select when printing to the pool.)

d. Select **Enable printer pooling**.

e. Select the Port check box next to each port that you added and that you want to be part of the printer pool.

f. Click **Apply** to save the settings.

6. Click **OK** to close the Printer Properties window.
Card Printer Driver management tasks are accessed through the Printer Properties window.

This chapter provides information about the Card Printer Driver, including:

- **The Printer Properties Window**
  - General Tab on page 42
  - Sharing Tab on page 42
  - Ports Tab on page 43
  - Advanced Tab on page 47
  - Color Management Tab on page 47
  - Security Tab on page 48
  - Printer Status Tab on page 50
  - Hopper Status Tab on page 56
  - Card Counts Tab on page 58
  - Supplies Tab on page 60
  - About Tab on page 62
- Uninstall the Card Printer Driver on page 63

**The Printer Properties Window**

The Printer Properties window allows you to view the settings and values that Windows uses to communicate with and manage the printer.

To open the Printer Properties window, display the Devices and Printers window on your system. Right-click the icon for the card printer and select **Printer properties**. The window had several tabs that provide information about the printer, and allow you to define the printer to the PC.

The tabs on the Printer Properties window may differ depending on your printer model. Differences are noted where necessary.
General Tab

The General tab contains basic information about the printer. Click Preferences to display the Printing Preferences window, which has settings that define how the card prints. Refer to “Design Tasks in Windows Printing Preferences” on page 73 for complete information about using the Printing Preferences window.

- If you rename the printer on the General tab, all settings on all Printing Preferences tabs are reset to their default values, with no warning message from Windows. If you have specified custom printing preferences settings, the changes will be lost. If you do rename the printer, review and reset your Printing Preferences settings, as needed.
- The Print Test Page button prints a Windows test page to verify PC communication with the printer. On some operating systems, the card printer prints only a small portion of the test page. We recommend that you use the “Printer Status Tab” on page 50 to print a sample card.

Sharing Tab

Use the Sharing tab to set up printer sharing using a host PC and up to ten client PCs. Refer to “Use Printer Sharing” on page 30 and to the appropriate appendix for your operating system for complete information about setting up printer sharing.
Ports Tab

Use the Ports tab to define the IP address of your printer to the PC. Refer to “Install the Driver” on page 9 and “Set Up a Printer Pool” on page 37 for information about defining a port during installation or when setting up a printer pool.

The Ports tab of the Printer Properties window includes the Enable Bidirectional Support check box. The Card Printer Driver always uses bidirectional communication with the printer. Make sure that this option is selected. Otherwise, all printing from the Card Printer Driver is disabled.

View Network Information

When the printer and PC using the Card Printer Driver are connected on a network, the network settings on the PC and the printer must match.

Use the Ports tab on the Card Printer Driver Printer Properties window to enter the printer’s IP address. Refer to the Port Type section described in “Printer Status Tab” on page 50 to see the current IP address setting.

If the printer is set to use DHCP (Dynamic Host Configuration Protocol), the IP address of the printer can change when the printer is powered off and powered back on. If this occurs, the Card Printer Driver issues error message 500.

If the printer IP address changes often, consider using static IP addressing to provide a more reliable connection. Work with your network support group to identify the IP address, subnet mask, and gateway address (if used). Then, refer to the printer’s Installation and Administrator’s Guide for information about setting a static IP address.

The Card Printer Driver supports both IPv4 and IPv6 addresses for network-connected printers. Refer to your printer’s User’s Guide for complete information about retrieving an IPv6 address.

Change a Network IP Address

If you are connecting your PC to a new network printer or if the printer IP address has changed, you need to change the IP address that is defined in the Printer Properties Ports tab.

Follow the procedure to change the port settings based on the operating system you are using:

- Windows 8.1 and Windows 10 on page 44
- Windows Server Systems on page 45
Windows 8.1 and Windows 10

1. Open the **Printer Properties** window and select the **Ports** tab.

2. Select the installed network printer you want to change and click **Configure Port**.

3. On the **Configure Standard TCP/IP Port Monitor** dialog box, enter the new IP address for the printer.

4. Click **OK** to save the new settings and then click **Close** on the Printer Properties window.
Windows Server Systems

Do the following if you are running Windows Server 2012 R2 or Windows Server 2016.

1. Open the Devices and Printers window and click the network printer you want to change. Print server properties displays in the menu bar.

2. Click Print server properties and select the Ports tab on the Print Server Properties window.

3. Scroll down and select the printer whose IP address you want to change. Click Change Port Settings.
4. The Print Server Properties window displays again. Select the printer again and click **Configure Port**.

5. On the **Configure Standard TCP/IP Port Monitor** dialog box, enter the new IP address for the printer.

6. Click **OK** to save the settings, and then click **Close** to exit the Print Server Properties window.
Advanced Tab

The Advanced tab contains additional printer settings. We recommend you keep the defaults set when you install the Card Printer Driver.

- The Card Printer Driver does not support the following options on the Advanced tab:
  - The New Driver button. Use the Card Printer Driver update process to update the driver to a newer version. Refer to “Update the Card Printer Driver” on page 18 for complete information.
  - The Keep printed documents option.

- If your printer is shared or part of a printer pool, the Print directly to the printer option is not supported. The option is supported for USB- or network-connected printers that are not shared or pooled.

- The Print directly to the printer option may not be available, depending on your operating system.

Color Management Tab

Refer to the Printing Preferences window """ on page 104 and the “Color Printing” section of your printer’s Installation and Administrator’s Guide for more information.
Security Tab

Use the Security tab to set printer permissions. If the PC to which the printer is attached has more than one user, set permissions that:

- Give users access to all features of the printer and Card Printer Driver, including messages.
- Display messages to inform users when they need to change the ribbon, load cards, or fix problems.
- Prevent access to the printer by unauthorized users.

1. Log in to the PC as the Creator/Owner.
2. On the Printer Properties window, select the Security tab.
   a. Review the Group or User Names list. If the names for which you want to specify permissions do not appear in the list, add the names.
   b. Click Add to open the Users and Groups dialog box.
   c. Select a name and click Add. Repeat for each name you want to add. When you are done adding names, click OK to close the Users and Groups dialog box.
3. In the Group or User Names list, select the name for which you want to specify permissions.
4. From the Permissions list, select the access for each user or group:
   - To enable printing, select **Allow** permission for **Print**, **Manage this printer**, and **Manage documents**.
   - To prevent a user from printing to the card printer, select **Deny** for all permissions.

5. Click **Apply** to save the changes.
6. Repeat **step 3** through **step 5** to grant access to the printer for other users or groups.
7. Click **OK** to close the Printer Properties window.
Printer Status Tab

The Printer Status tab displays the printer status, port type, IP address, printer information, and any messages that apply to the printer.

If your printer is part of a printer pool:
- Printer status information is not available. The status displays as “Printer pooling.” You can view status information for individual printers in the pool using Printer Manager. Refer to your printer’s Installation and Administrator’s Guide for complete information about using Printer Manager.
- All buttons on the Printer Status tab are unavailable.

1. On the Printer Properties window, select the **Printer Status** tab.

![Printer Status Tab](image)

The date and time the information was retrieved from the printer displays in the lower left area of the tab.

2. Click **Ask Printer for Update** to get the latest information from the printer.
3. You can view and update printer settings using the printer’s Printer Manager web interface or Printer Dashboard. Click Configure Printer to log into Printer Manager or to start the Printer Dashboard. Refer to your printer’s Installation and Administrator’s Guide for information about using Printer Manager, or the Printer Dashboard Help.

If a shared printer client PC is connected to the host computer with a USB cable, the Configure Printer button on the client is unavailable and cannot be used to start Printer Manager or the Printer Dashboard. You must configure the printer settings from the host computer.

Printer Status

The printer status can display as one of the following:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Printer Status</th>
</tr>
</thead>
</table>
| ![Green Checkmark] | **Ready**  
The printer is not processing a card and is available to print. |
| ![Pause] | **Suspended**  
The printer was paused or it is processing a card from another PC that has an error waiting. |
| ![Star] | **Busy**  
The printer is processing a card or a command, or the printer menu system is being used.  
If the printer or a laminator is warming up, a message displays indicating the percent complete. Click Ask Printer for Update to update the warm-up percentage. |
| ![Warning] | **Message**  
The printer has issued a message for a card sent from this PC. The message text displays. |
| ![Timer] | **Initializing**  
The printer is powering on. |
| ![X] | **Unavailable**  
The printer is off, is shutting down, or is not connected. |
Port Type

The Port Type displays the connection type and the printer IP address:

- **USB**—The printer is connected locally via USB.
- **Network**—The printer is connected using a network connection. The network IP address can be either IPv4 or IPv6.

Printer Information

The Printer Information box displays the following:

- **Model** Model name of the printer
- **Serial Number** Printer serial number assigned at the factory
- **Firmware Version** Version of the firmware currently installed in the printer
- **Protocol** DPCL protocol used by the driver to communicate with the printer
- **Option Information** Options or features included in this printer

Print a Driver Sample Card

You can print sample cards from the Printer Status tab to verify that the Card Printer Driver and the printer are communicating.

- The printer sample card shows a basic ID card that can be printed with any ribbon that the printer supports. The test card images and text do not change.
- The magnetic stripe test card is available when the printer includes a magnetic stripe option. The magnetic stripe test card verifies that the Card Printer Driver sends magnetic stripe data to the printer and that the printer encodes it. The test data cannot be changed.
- The laser sample card option lasers predefined data onto a card. The option is available only with desktop laser systems.
The Card Printer Driver includes the following sample cards:

- Printer Sample Card
  ![Printer Sample Card](image1)

- 3-Track ISO Magnetic Stripe
  ![3-Track ISO Magnetic Stripe](image2)

- JIS Magnetic Stripe
  ![JIS Magnetic Stripe](image3)
HINTS & TIPS

- The Card Printer Driver sample cards use the settings specified in the Printing Preferences Layout window, except for the following: Orientation, Print on Both Sides, and Rotate front side card image 180 degrees. Refer to “Design Tasks in Windows Printing Preferences” on page 73 for information about specifying printing preferences.

- The magnetic stripe data sent by the Card Printer Driver requires that the printer be set to encode the three-track ISO format for a three-track module, or the JIS-II format for the single-track module. The magnetic stripe card that prints is determined by the printer settings.

- The name of the magnetic stripe sample card prints on the card.

- If you are printing the sample card to a rewritable card (for card printers that support rewrite only), make sure that the Card Printer Driver, printer, and Printer Manager are configured correctly. Refer to “Printer Setup for Rewritable Cards” on page 112.
To print a sample card:

1. Open the **Printer Properties** window.

2. Select the **Printer Status** tab. If the printer status is something other than **Ready** or **Busy**, determine why the printer is unavailable.

3. Click one of the following:
   - **Print Sample Card**
   - **Print Mag Stripe Test Card**
   - OR
   - **Print Laser Sample Card** (if enabled)

The printer picks the card and prints it. If the card does not print, refer to the “Troubleshooting” section of the printer’s *User’s Guide* to determine the cause of the problem and try to print the sample card again.
Hopper Status Tab

The Hopper Status tab displays information about the input hoppers of CR805, Sigma, and CD Series printers with firmware version greater than D3.18.2. The input hoppers contain sensors that provide additional information about whether cards are loaded in the hopper and the type of card.

The Hopper Status tab does not display if the printer hoppers do not contain sensors.

1. On the Printer Properties window, click the **Hopper Status** tab.

2. Select the hopper for which you want to display information from the **Select Hopper** drop-down list.
The Hopper Status tab provides the following information:

<table>
<thead>
<tr>
<th><strong>Select Hopper</strong></th>
<th>The hopper whose information displays on the tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>The type of hopper.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>The status of the hopper.</td>
</tr>
<tr>
<td></td>
<td><strong>Cards Present</strong></td>
</tr>
<tr>
<td></td>
<td>There are cards in the hopper.</td>
</tr>
<tr>
<td></td>
<td><strong>Empty</strong></td>
</tr>
<tr>
<td></td>
<td>There are no cards in the hopper.</td>
</tr>
<tr>
<td></td>
<td><strong>Cannot Detect</strong></td>
</tr>
<tr>
<td></td>
<td>The Card Printer Driver cannot detect if cards are present in the hopper.</td>
</tr>
<tr>
<td><strong>Card Stock</strong></td>
<td>The type of card stock loaded in the selected hopper.</td>
</tr>
</tbody>
</table>

- You can select the hopper for which you want to view information, including the exception hopper.

  Multi-hopper printers cannot detect if a card is present in the exception slide.

- The printer updates the information when you first display the Hopper Status tab or when you select a different hopper.

- No information displays if the printer is unavailable.
Card Counts Tab

The Card Counts tab of the Printer Properties window shows the number of cards that have been processed by the printer.

1. On the Printer Properties window, click the **Card Counts** tab. The tab displays current and total counts.

![Card Counts Tab Image]

2. Select the hopper for which you want to display information from the **Input Hopper** dropdown list. The page displays the most recent card counts for the selected hopper. If you select **All**, the total card counts for the printer display.

   If your printer is part of a printer pool:
   - Card count information is not available. You can view card count information for individual printers in the pool using Printer Manager. Refer to your printer's *Installation and Administrator's Guide* for complete information about using Printer Manager.
   - The **Ask Printer for Update** button is not available.
The Card Counts tab provides the following information:

<table>
<thead>
<tr>
<th>Picked Total</th>
<th>All the cards the printer has picked from the selected hopper. The default is all the cards the printer has processed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>All cards picked since the last time the count was reset. Current counts can be reset using Printer Manager.</td>
</tr>
<tr>
<td>Completed</td>
<td>The number of cards that completed successfully.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The number of cards that did not process correctly.</td>
</tr>
<tr>
<td>Lost</td>
<td>The number of cards that were picked but did not exit the printer (for example, a jammed card that had to be removed).</td>
</tr>
<tr>
<td>Since last cleaned</td>
<td>The number of cards processed since the last time the printer was cleaned.</td>
</tr>
</tbody>
</table>

- You can select the hopper for which you want to see the card count information, including cards picked from the exception hopper.
- The printer updates the card count information when you first display the Card Counts tab or when you select a different hopper.
- The printer includes cards used for test cards and cleaning cards in the Picked count, but not in Completed count.
- No information displays if the printer is unavailable.
- For Sigma card printers, click the **Clean Printer** button to start the Printer Dashboard. When you sign into the dashboard, the Cleaning Card page displays, so you can start the cleaning process from the dashboard. Refer to the Printer Dashboard Help for more information.

The **Clean Printer** button is not available for non-Sigma printers.
Supplies Tab

The Supplies tab of the Printer Properties window shows the supplies installed in the printer, including the type of supply, the estimated percentage remaining, the part number, and a description of the supply, if one is available.

- The supplies information that displays is determined by the type of printer and any additional installed components.
- For Sigma printers, click the Printer Supplies button to start the Printer Dashboard. When you sign into the dashboard, the Supplies Details page displays, so you can see the supply status in the dashboard. Refer to the Printer Dashboard Help for more information.

The Printer Supplies button is not available for non-Sigma printers.

1. Open the Printer Properties window and click the Supplies tab.

2. The date and time the information was retrieved from the printer displays in the lower-left area of the tab. To get the latest information from the printer, click Ask Printer for Update.

   If your printer is part of a printer pool:
   - Supply information is not available. You can view supply information for individual printers in the pool using Printer Manager. Refer to your printer’s Installation and Administrator’s Guide for complete information about using Printer Manager.
   - The Ask Printer for Update button is unavailable.
The Card Printer Driver Supplies tab displays the following supply information:

<table>
<thead>
<tr>
<th>Supply Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>The supply is installed, and at least 10% of the roll remains.</td>
</tr>
<tr>
<td>Low</td>
<td>The supply is installed, and less than 10% of the roll remains.</td>
</tr>
<tr>
<td>Unknown</td>
<td>The supply is missing or is not valid.</td>
</tr>
</tbody>
</table>

| Remaining | The percent of supply remaining. |
| Supply    | The name of the installed supply. |
| Part Number | The part number of the supply. (If a part number is not available, a series of dashes displays.)
  Ribbons that have a region code display with a prefix of -Rxxx before the part number, where xxx is the region code.
  If using a Sigma printer, the region code is -Sxxx. |
| Description | A short description of the supply, if one is available. For example, a print ribbon can display as YMCKT. If an installed supply is not supported by the printer, “Not supported” displays. If a supply is not installed, “Not installed” displays. **Note:** A card printer configured to print rewritable cards shows the print ribbon as Not installed. |
About Tab

The About tab shows the Card Printer Driver version and any additional information about the driver.

1. On the **Printer Properties** window, click the **About** tab.

2. Click **OK** to close the Printer Properties window.
Uninstall the Card Printer Driver

You can uninstall the Card Printer Driver using either the Driver Installation CD or downloaded file, or by using the uninstall utility from the Windows Start menu.

- If you have multiple user accounts configured on a shared printer client, only one account should be logged on when removing the driver. The Card Printer Driver uninstall process removes the printer from all configured accounts on the PC.
- You must restart your computer after uninstalling the Card Printer Driver.

Remove Devices

You must remove the XPS Card Printer Driver printers using the Windows Devices and Printers window before starting the uninstall process.

If you start the uninstall program before removing the devices, the following message displays:

![Image of uninstall confirmation dialog]

When you click OK, the following message displays. Click OK again and remove the devices before proceeding with the uninstall.

![Image of final uninstall confirmation dialog]
If you are using the Driver Installation CD, the following screen displays:

Do the following to remove the Card Printer Driver devices:

1. Log on to the PC as a user with administrator access.
2. Remove the devices.

Make sure that there are no documents waiting to print before removing the printer. Right-click the printer icon and select **See what’s printing**. The Card Printer Driver occasionally issues a message that it cannot complete the uninstall because there are active print jobs. This situation can occur even when all printers have been removed. Refer to “Update or Uninstall Cannot Complete” on page 149 to resolve the issue.
a. From the Windows Devices and Printers window, right-click the icon for the XPS Card Printer and select **Remove device** from the menu.

![Device Properties Menu]

b. **Click Yes** when the Remove Device message displays. This removes the XPS Card Printer icon from the list of printers.

![Remove Device Message]

c. **Do this for each XPS Card Printer installed on the computer.**

3. **Use one of the following methods to remove the Card Printer Driver from your system.**
   - **Use the Driver Installation CD or Downloaded File**
   - **Use the Start Menu Uninstall Program on page 69**
Use the Driver Installation CD or Downloaded File

1. Make sure that all devices have been removed from the Devices and Printers window. Refer to “Remove Devices” on page 63.

2. Do one of the following:
   - Insert the Driver Installation CD in the PC’s drive.
   - OR
   - Double-click the XPSCardPrinter_x.x.x.exe downloaded file.

   The Card Printer Driver install Welcome page displays. (If the AutoPlay window displays, click Run autorun.exe.)

3. Click the wastebasket icon to start the uninstall process.

4. The Remove the Printer Driver from the PC window displays. Click Remove the Driver.
5. The **XPS Card Printer Uninstall** dialog box displays. If the printer is connected via a USB cable, make sure that the cable is connected to the PC. If the printer connects to a network via Ethernet, you can continue with the uninstall. Click **OK** to continue.

An activity indicator displays as the Card Printer Driver is being removed.
The Driver removed screen displays.

6. **Click Restart Now.**

   If the printer was connected via USB, a message displays to unplug the USB cable.

   ![Image of Driver removed screen](image)

   - **Click OK** after disconnecting the USB cable.
   - **Click Restart Now** to complete the driver removal.

   ![Image of Driver removed screen with USB cable unplug message](image)
Use the Start Menu Uninstall Program

Use the following procedure to remove the Card Printer Driver if you do not have access to, or cannot use, the Driver Installation CD.

1. Make sure that all devices have been removed from the Devices and Printers window. Refer to “Remove Devices” on page 63.

2. Remove the driver from your system. From the Windows Start menu, select All Programs > Datacard Printers and click XPS Card Printer Uninstall.

   Windows 8.1 users: Display the Apps screen and click XPS Card Printer Uninstall. Click Yes when prompted to allow the program to make changes to your computer.

3. The XPS Card Printer Uninstall dialog box displays. If the printer is connected through USB, make sure that the cable is connected to the PC. If the printer connects to a network via Ethernet, you can continue with the uninstall. Click OK to continue.
4. The XPS Card Printer Uninstall dialog box displays a warning that no printer activity occurs while the driver files are removed. Click OK to continue.

5. The XPS Card Printer Uninstall dialog box displays a message that the Card Printer Driver is uninstalled. Unplug the USB cable, if connected. Click OK.

6. Restart your PC following the uninstall. Click Yes to restart. Click No to restart the PC at a later time.

The Card Printer Driver requires a USB printer to be plugged in before starting the driver uninstall process. The printer then must be unplugged at the end of the uninstall. The Card Printer Driver uninstall program also requires the PC to be restarted after the uninstall completes.

If the USB printer is unplugged or not in the Ready state prior to running the uninstall, the USB driver may not install the next time you attempt to install the same printer to the PC. Refer to “Reinstall the XPS USB Card Printer Driver” on page 144 for information about how to remove any driver files that were not removed during the uninstall process.
Chapter 4: Card Design Tasks

This chapter provides information about card design tasks you can perform with the Card Printer Driver.

Use the following information to fine tune your card design and set up your card printing preferences:

- Change a Card Design on page 72
- Design Tasks in Windows Printing Preferences on page 73
  - Layout Tab on page 73
  - Advanced Options on page 76
  - Print Area Tab on page 96
  - on page 104
  - Print Mode Tab on page 108
  - Lamination Tab on page 110
- Printer Setup for Rewritable Cards on page 112
- UV and Luster Ribbon Support on page 115
- Escapes on page 118
- Magnetic Stripe Fonts on page 138
Change a Card Design

Card design refers to the combined features of the printed cards.

An organization can change:

- The arrangement of card components, such as moving a photo to a different position on the card.
- The source for card components, such as using a different camera for taking photos, or using a new file for a logo.
- The components on the card, such as adding a magnetic stripe, a logo, or a bar code.

Whenever the card design changes, review the settings used for the card. Use this checklist to guide your changes. Always:

- Use high-quality photos and graphics.
- Print several samples of the updated card design.
- Use cards with a magnetic stripe or bar code in a reader to verify that the data works as expected.
- Check the Color Adjustment settings if you change a graphic on the card, change the camera for taking photos, or change the location where photos are taken. Refer to “Color Printing” in your printer’s Installation and Administrator’s Guide for information about how to improve the appearance on one element on a card.
- Refer to your printer’s Installation and Administrator’s Guide if you are changing a bar code or magnetic stripe.
Design Tasks in Windows Printing Preferences

The Printing Preferences window allows you to specify default settings that define how your card prints. The values set in the Printing Preferences window are used for all cards printed using the Card Printer Driver unless they are overridden by your card design application or by using an escape.

Do the following to open the Printing Preferences window:

1. Display the Devices and Printers window on your system.
2. Right-click the icon for the card printer and select Printing preferences.

Use the Printing Preferences tabs to set up your printing preferences.

The tabs and options that display in the Printing Preferences window are determined by the printer model and the options installed on the printer. Because the Card Printer Driver supports multiple printer models, the information in the following sections may not apply to all printers. Specific exceptions are noted, where necessary.

Layout Tab

The Layout tab displays when you first select Printing preferences. Use the Layout tab to select the orientation of the card (either Portrait or Landscape) and specify whether to print on both sides of the card.

Click Advanced to display the Advanced Options window, which allows you to define additional printing settings. Refer to “Advanced Options” on page 76 for complete information about specifying additional options.
Print on Both Sides of the Card

You can print on both sides of the card using the Card Printer Driver. The method for printing on both sides depends on the printer model.

- Printers that include a **duplex printing** module automatically turn the card to print on both sides. Check the printer configuration label to determine whether your printer includes duplex printing. Refer to your printer’s *User’s Guide* for more information about reading the configuration label.

- **Simplex printers** support manual duplex printing. The printer prints one side of the card, places the card in the card output hopper, and displays the message **Insert same card side 2 up**. Insert the card into the hopper or manual-feed slot to print on the second side.

Set Up Duplex Printing

Use card production software or another PC application to create a card design.

The following example shows how to set up Microsoft Word for duplex printing.

1. Do the following to set up printing preferences.
   a. Open the printer’s **Printing Preferences** window.
   b. On the Layout tab, select **Flip on Short Edge** from the **Print on Both Sides** drop-down list.
   c. Click **Apply**.
2. Start your application and select the card printer as the current printer.

3. Use the application’s page setup options to set the correct paper size for your printer.

<table>
<thead>
<tr>
<th>Printer</th>
<th>Paper Size</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct-to-Card Printers</td>
<td>ISO ID-1</td>
<td>2.13 x 3.38 in.</td>
</tr>
<tr>
<td>Retransfer Card Printers</td>
<td>ISO ID-1 Retransfer</td>
<td>2.23 x 3.51 in.</td>
</tr>
</tbody>
</table>

4. Set the margins to 0.

5. Format the text and graphics to print on the card.

Refer to the printer’s Installation and Administrator’s Guide for more information about card design.

Your PC application’s Print settings may override the settings specified in the Card Printer Driver. Make sure that your application’s Print settings specify “Print on both sides.”
Advanced Options

Use the Advanced Options window to specify additional print settings. The following sections describe each of the Advanced options.

Paper Size

1. Open the **Printing Preferences** window.
2. On the Layout tab, click **Advanced**.

The correct paper size for your printer displays.

<table>
<thead>
<tr>
<th>Printer Type</th>
<th>Paper Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct-to-card printers</td>
<td>ISO ID-1 (85.60 x 53.98 mm)</td>
</tr>
<tr>
<td>Retransfer card printers</td>
<td>ISO ID-1 Retransfer</td>
</tr>
</tbody>
</table>

If you are printing to a retransfer card printer, both paper size options display. This allows you to select a different paper size if your application (such as Datacard® ID Works® or IDCentre™) does not support the ISO ID-1 Retransfer paper size.

When you print to a retransfer card printer from one of these applications, select the **ISO ID-1 (85.60 x 53.98 mm)** paper size. The Card Printer Driver adjusts the image so that it prints correctly on the larger image canvas used by the retransfer card printer. (Refer to the printer’s *Installation and Administrator’s Guide* for information about the image size used by the retransfer card printer.)

You can further fine-tune the position of the image using the ImageOriginOffset.INI file. Refer to “Specify Image Origin Offsets” on page C-22 for more information about how to use the .INI file and how to set up ID Works and ID Centre to print to a retransfer card printer.
Copy Count

You can select to print from 1 to 255 copies of the same card design.

⚠️ If you are using a card design application, set the number of copies in the application. The application settings override the settings in the Printing Preferences window.

1. Open the **Printing Preferences** window.
2. On the Layout tab, click **Advanced**.
3. Type the number of copies you want to print in the **Copy Count** field. You can enter a value between 1 and 255.
4. Click **OK** to close the Advanced Options window.
5. Click **Apply** to save your changes and then click **OK** to close the Printing Preferences window.
6. Send the cards to print.
Disable Printing

The Disable printing option allows you to send a card through the printer without printing on the card. Use this option to:

- **Encode a magnetic stripe or smart card chip.** Refer to “Encode the Magnetic Stripe Without Printing” on page 79. For smart card encoding, refer to the documentation for your smart card application.

- **Laminate or impress a preprinted card.** Lamination provides extra security and durability for a card. Refer to “Lamination Tab” on page 110 and “Impress Card” on page 93 for information about specifying lamination and impresser options.

- **Impress a card using the tactile impresser module.** Refer to “Impress Card” on page 93 and “Tactile Impresser Escape” on page 132.

- **Emboss and indent a preprinted card.** Refer to “Embosser Escape” on page 135 or your card production software documentation for information about specifying emboss and indent data.

- **Print only on one side of a card.** Some card designs may require printing on only one side of the card. Refer to “Disable Card Side Printing for Special Card Designs” on page 80.

  > If you use ID software, it may override the Disable printing preference. Use your card design and production printing options to control card printing.

To specify a Disable printing option:

1. Open the **Printing Preferences** window.
2. On the Layout tab, click **Advanced**.
3. Click **Disable printing** and select an option from the drop-down list:
   - **Off**—Printing is not disabled. The card design prints normally. This is the default.
   - **All**—Disables all printing. Nothing prints on the card.

   Use this option to encode a magnetic stripe or smart card, or to laminate, impress, or emboss a preprinted card.
- **Front**—Disables printing on the front side of the card. Side 2 of the card design prints on the back of the card.

- **Back**—Disables printing on the back side of the card. Side 1 of the card design prints on the front of the card.

4. Click **OK** to save the setting and close the Advanced Options window.

5. On the Layout tab, click **Apply**. Click **OK** to close the Printing Preferences window.

When you send a job to the printer, the Card Printer Driver discards the printable data based on the Disable printing selection and sends only the data or instructions you want the printer to process.

### Disable Printing Examples

The following examples show how you can use the Disable printing option.

#### Encode the Magnetic Stripe Without Printing

You can use the Card Printer Driver to encode magnetic stripe data on a card without printing on the card.

1. Set the **Disable printing** option to **All**. Refer to “Disable Printing” on page 78.

2. Format the data you want to encode:
   - If you use card production software, use a magnetic stripe field if it is available.
   - If you use other PC software, format the data using magnetic stripe fonts or magnetic stripe escapes. Refer to “Magnetic Stripe Escapes” on page 127 and “Magnetic Stripe Fonts” on page 138.

   The sample card shown has the text “Sports Arts” formatted with a magnetic stripe font. It is sent as encoded data. The other images and text on Page 1 of the card design are discarded.

3. Send the card to the printer to test your setup.

---

If you use card production software to produce cards, you do not need to use the Disable printing option. Use the settings in the software to encode the magnetic stripe without printing.
Disable Card Side Printing for Special Card Designs

If a card design calls for printing on only one side of the card, you can use the Disable printing option to avoid printing on the wrong side of the card or using ribbon for the side of the card with no printing.

If you use ID software for your card design, it may have settings that specify the side of the card to print. You do not need to use the Disable printing option if you use the software settings.

1. Select the Disable Printing option that prints the card design correctly and save your changes. Refer to “Disable Printing” on page 78. Use the following table to determine the correct setting to select:

<table>
<thead>
<tr>
<th>Disable Printing Option</th>
<th>Off</th>
<th>All</th>
<th>Front</th>
<th>Back</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2-sided card design</strong></td>
<td>Prints side 1 on front and side 2 on back</td>
<td>No printing</td>
<td>Disables printing on side 1, prints side 2 on back</td>
<td>Prints side 1 on front, disables printing on side 2</td>
</tr>
<tr>
<td><strong>1-sided card design</strong></td>
<td>Prints side 1 on front</td>
<td>No printing</td>
<td>No printing</td>
<td>Prints side 1 on front</td>
</tr>
</tbody>
</table>

2. Send the card to the printer to test your setup.
Obscure Black Panel

A retransfer card printer can print an image on the black (K) panel of a CMYKP ribbon that hides the information that was printed with the K panel. The information that prints with the K panel can include a name, account number, bar code, and other sensitive information that could be used to compromise the card data. By printing an image over the used black panel, the data is obscured and cannot be read from the used ink ribbon or the retransfer film. The image used is stored in the printer and cannot be changed.

Do the following to specify the Obscure Black Panel option:

1. Open the **Printing Preferences** window.
2. On the Layout tab, select **Advanced**.
3. Click **Obscure Black Panel** and select an option from the drop-down list:
   - **Do not apply**—An image is not printed on the ribbon K panel. This is the default.
   - **Front side only**—An image is printed on the ribbon K panel, and transferred to the retransfer film, to cover the text and images printed with the K panel on the front side of the card.
   - **Back side only**—An image is printed on the ribbon K panel, and transferred to the retransfer film, to cover the text and images printed with the K panel on the back side of the card.
   - **Both sides**—An image is printed on the ribbon K panels, and transferred to the retransfer film, to cover the text and images printed with the K panels on both the front and back sides of the card.
4. Click **OK** to save the setting and close the Advanced Options window.
5. On the Layout tab, click **Apply**, or click **OK** to close the Printing Preferences window.

When you send a job to the printer, the Card Printer Driver sends another command to the printer to print the additional images on the K panel.
The Card Eject Side setting allows you to specify which side of the card is facing up when it is ejected into the output hopper. Cards normally enter the output hopper with the last side printed facing up. For example, a one-sided card always has the front side facing up. A duplex card with printing on both sides enters the output hopper with the back side facing up. However, some sites may want the cards to be stacked in the output hopper with a certain side facing up for easier distribution. By specifying a Card Eject Side option, the printer can flip the card before it enters the output hopper so that the selected side faces up.

Do the following to specify the Card Eject Side option:

1. Open the Printing Preferences window.
2. On the Layout tab, select Advanced.
3. Click Card Eject Side and select an option from the drop-down list:
   - Default—The default eject action is used. The last side printed is facing up when the card is ejected into the output hopper.
   - Front—The front side of the card is facing up when it enters the output hopper.
   - Back—The back side of the card is facing up when it enters the output hopper.
4. Click OK to save the setting and close the Advanced Options window.
5. On the Layout tab, click Apply, or click OK to close the Printing Preferences window.
Color Mode

Color Mode allows a way to specify which algorithm is used for printing color on a card.

Do the following to specify the Color Mode option:

1. Open the **Printing Preferences** window.
2. On the Layout tab, select **Advanced**.
3. Click **Color Mode** and select an option from the drop-down list:
   - For Sigma Printers, you will see these options:
     - **Default** - Driver does not use color mode option.
     - **TrueColor (ICC)** - Uses a color profile that has been calibrated to closely match the output produced by the Artista® VHD Retransfer Color Printing Module Gen 2. Closely matches what is seen on the monitor.
     - **Vivid** - Increases the darkness of TrueColor (ICC) and creates a darker, more saturated color on the printed card.
     - **SD_CD** - Closely matches the legacy SD/CD Printers default.
     - **Custom** - Allows for custom color tables to be used.
   - For CR805 Printers you will see these options:
     - **Default** - Driver does not use color mode option.
     - **TrueColor (ICC)** - Uses a color profile that has been calibrated to closely match the output produced by the Artista® VHD Retransfer Color Printing Module Gen 2. Closely matches what is seen on the monitor.
     - **Vivid** - Increases the darkness of TrueColor (ICC) and creates a darker, more saturated color on the printed card.
     - **Legacy SR/CR** - Closely matches the legacy SR/CR printers. Processes the input colors to provide print output that is similar to that produced by Datacard SR200/SR300/CR500 card printers. The printed card will not be identical because of differences in the print resolution and canvas size used by the CR825 or CE875 printer. You may need to modify your existing card designs to produce the optimal output.
 Legacy SR w LUT - Processes the input colors to provide print output that is similar to that produced by the Datacard SR200/SR300 card printer when it uses a color lookup table (LUT).

4. Click **OK** to save the setting and close the Advanced Options window.

5. On the Layout tab, click **Apply**, or click **OK** to close the Printing Preferences window.
Print Black Image Pixels Using Monochrome

When you use a ribbon that has both color and monochrome, such as YMCKT or CMYKT, the Card Printer Driver evaluates each image to determine if it should be printed as color or monochrome.

Direct-to-card printers and retransfer card printers print color and monochrome using different processes. When you select the **Print black image pixels using monochrome** option, the Card Printer Driver handles the image elements using two different methods.

### Direct-to-Card Printers

Direct-to-card printers print using the color panels first, then print over the color using the black panel. If the image is pure black on a white background, the Card Printer Driver processes it using just the black (K) panel of the print ribbon. If the image contains a pixel of color other than pure black or pure white, it processes the image (including any black portions) using the color panels of the print ribbon.

If the card design requires that the black in an image prints using the K panel (instead of the YMC panels), such as with a bar code, the **Print black image pixels using monochrome** option changes the way the data is processed.

When you set the **Print black image pixels using monochrome** option to **On**, the Card Printer Driver places the seven black-most shades (from a palette of 256 shades) on the K panel image. This allows the printer to use the K panel to print the bars of a bar code embedded in a color image so that the bar code can be read by a scanner.

The following examples show a card design submitted to the driver with the option enabled, and the K-panel image created by the driver and sent to the printer.

- **Design submitted to the driver**
- **K-panel image created by the driver**

When printing a card design with the **Print black image pixels using monochrome** option enabled:

- The black pixels are not removed from the color image. They print with the YMC panels and also with the K panel.
The option applies only to the card side that is being printed in color, for example, the front side for a YMCKT ribbon. It is not needed for KT or K ribbons, or for the back side of a YMCKT-KT ribbon.

The option is ignored if color is not used in the card design.

Retransfer Card Printers

Retransfer card printers print using the black panel first, then print over the black using the color panels. The method used for direct-to-card printers to extract the black image from a color image can leave a white outline around black text or create variations in color across the card. For retransfer card printers, the Card Printer Driver uses a method called print trapping to create an overlap between the color and monochrome pixels in the image. This helps smooth the transition between the color and monochrome portions of the printed image.

The print trapping process scans the color image pixel-by-pixel and creates two images: one image for the color plane and another image for the K plane. Print trapping also inspects neighboring pixels to determine whether print trapping should occur.

- When generating a color image, the print trapping process looks for gray pixels (the pixel RGB values are all equal) and then looks for neighboring color pixels. If color pixels are found, it adds the gray pixel to the color image. Otherwise, it draws the gray pixel as white.

- When generating a monochrome image, the print trapping process looks for color pixels and then looks for neighboring gray pixels. If gray pixels are found, the color pixel is converted to gray and added to the monochrome image. Otherwise, it is left white.

The **Print black image pixels using monochrome** printing preference can cause splotches to appear in photographs. Refer to “Block K Panel Data” on page C-19 for information about how you can use an .INI file to specify an area where the black (K) panel is not used for printing.
The following parameters also affect the print trapping process:

- The number of pixels to check (the pixel spread)
- The direction to apply the pixel spread (left, right, up, or down)
- What is considered gray or white (the RGB value)
- Whether to apply a gradient to spread pixels so that they fade to white the further they get from the color or monochrome edge

When you set **Print black image pixels using monochrome** to **On**, the Card Printer Driver uses default values for the print trapping parameters. The default values should provide the best quality for the majority of card designs.

If necessary, you can adjust the parameter values using the ColorTrap.INI file. The .INI file shipped with the Card Printer Driver contains the default print trapping parameter values. Refer to “Print Trapping” on page C-27 for more information about how to use the .INI file to modify the print trapping parameters.

The **Print black image pixels using monochrome** setting has no effect if the ink ribbon installed in the printer does not have both color and black panels on the same side, such as CMYP-KPi or FCMYP-KP.

**Select Print Black Image Pixels Using Monochrome**

Do the following to specify the **Print black image pixels using monochrome** option:

1. Open the **Printing Preferences** window.
2. On the Layout tab, click **Advanced**.
3. Set **Print black image pixels using monochrome** to **On**.
4. Click **OK** to close the Advanced Options window.
5. Click **Apply** on the Printing Preferences window.
6. Click **OK** to close the window.
Rotate the Card Image

1. Open **Printing Preferences**.
2. On the Layout tab, click **Advanced**.
3. Select the side of the card you want to rotate 180 degrees, and select **On**.

Make sure that if you rotate the back of the card that the text in your card design prints below any feature on the back side of the card (such as a magnetic stripe or signature panel) not on top of it (see the example card shown).

4. Click **OK** to save the setting, and then click **Apply** on the Layout tab.
5. Send the card to print.

If you are using a card production software, the application settings override the settings in Printing Preferences. Make sure to verify that your settings are correct.
Split-Ribbon Color Printing

Two-sided, split-ribbon color printing uses a single ribbon panel set to print both sides of a card. This lets you use less ribbon to print cards in color. The ribbon can be a full-panel or short-panel color ribbon.

Split-ribbon color printing is not supported by retransfer card printers. This option does not display if you are printing to a retransfer card printer.

Most types of cards, including cards with magnetic stripes and smart cards, can be printed using split-ribbon printing.

Before using split-ribbon color printing, become familiar with how your printer uses color printing. Refer to the printer’s Installation and Administrator’s Guide for complete information about color printing.

The order in which the color, black, and topcoat sections of the panel set are used to print the card depends on the type of ribbon installed in the printer and the split-ribbon option selected on the Printing Preferences window. The Card Printer Driver supports the following ribbon types and split-ribbon printing options.

The print ribbons that are supported are determined by the printer model and its options. Some ribbons may not be available for all printers.

<table>
<thead>
<tr>
<th>Ribbon Type</th>
<th>Split Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| YMCKT       | YMCT-K       | • color (YMC) + topcoat (T) front  
• black (K) back |
| YMCKT       | YMC-KT       | • color (YMC) front  
• black (K) + topcoat (T) back  
**Note:** This option does not apply topcoat to the color printing. Color printing fades over time if it lacks a topcoat. Select this option if you are using a laminator, which can apply an overlay to the front of the card. |
| YMCKT       | K-YMCT       | • black (K) front  
• color (YMC) + topcoat (T) back |
| YMCK        | YMC-K        | • color (YMC) front  
• black (K) back  
**Note:** This ribbon type does not include a topcoat panel and is meant to be used with a laminator, which can apply an overlay to one or both sides of the card. |
Before using split-ribbon color printing, be aware of the following:

- Set up your card design with your card production software or a PC application as you normally do.

- Select a split-ribbon option that applies topcoat to the side of the card where any color printing is used. If you use a laminating system, make sure that you set up your lamination options to apply an overlay to the side of the card with color printing. Refer to “Lamination Tab” on page 110 for information about specifying lamination options.

- Install the correct ribbon type in your printer. The split-ribbon option is ignored if the ribbon installed in the printer does not match the selection in the Printing Preferences Advanced Options window.

- When the split-ribbon option specifies only color for a card side (for example, YMCT-K), any black text or monochrome images (including bar codes) on that side of the card are printed using the color panels to simulate black.

  If short-panel color ribbon is installed in the printer, make sure that your card design does not have any black elements on the front side of the card that will print before the color elements. The ribbon split will begin printing the black element using the color panels of the ribbon, resulting in the color elements possibly not printing completely.

---

<table>
<thead>
<tr>
<th>Ribbon Type</th>
<th>Split Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| YMCK        | K-YMC        | - black (K) back  
              - color (YMC) back |
|             |              | **Note:** This ribbon type does not include a topcoat panel and is meant to be used with a laminator, which can apply an overlay to one or both sides of the card. |
| YMCKT-K     | K-YMCKT      | - black (K) front  
              - color (YMC) + black (K) + topcoat (T) back |
| YMCKT-KT    | KT-YMCKT     | - black (K) + topcoat (T) front  
              - color (YMC) + black (K) + topcoat (T) back |
| YMCKT-KT    | YMCKTT-K     | - color (YMC) + black (K) + two topcoat panels (TT) front  
              - black (K) back |
| YMCKF-KT    | YMCKFT-K     | - color (YMC) + black (K) + UV (F) + topcoat (T) front  
              - black (K) back |
| MT-KT       | MTT-K        | - monochrome (M) + two topcoat panels (TT) front  
              - black (K) back |
- When the split-ribbon option specifies black, printing on that side of the card is done only in black, even if the original text and images are in color.

- Based on the split-ribbon option selected, the printer flips the card multiple times to print and apply topcoat. This increases the time it takes to print a card, and the cards may be stacked upside down in the output hopper.

- If you use the split-ribbon option with manual duplex printing on a simplex printer, a message displays on the printer LCD panel each time you have to flip the card to print the other side. A card may be flipped multiple times.

Do the following to apply split-ribbon color printing:

1. Open the **Printing Preferences** window.
2. On the Layout tab, click **Advanced**.
3. Select a **Split ribbon** option from the drop-down list. The default is **No**, split-ribbon printing is not used.
4. Click **OK** to save your selection and then click **Apply** on the Layout tab.
Input Hopper

For printers that have an optional multi-hopper, the Input Hopper setting allows you to select the hopper to use when you print a card. This setting does not display for single-hopper printers.

You also can use an escape to specify the input hopper to use. Refer to “Input Hopper Selection Escape” on page 129 for more information.

You cannot use the printing preferences option or an escape to specify an input hopper if you use interactive mode printing. Refer to the SDK Programmer’s Reference Guide for information about how to use the SDK to specify an input hopper in an interactive job.

1. Open the Printing Preferences window.
2. On the Layout tab, click Advanced.
3. Click Input hopper and select the hopper number. You can select any of the input hoppers, including the Exception hopper. The default is hopper 1.
4. Click OK to save your selection and then click Apply on the Layout tab.
Impress Card

The Card Printer Driver supports two different types of impressers. Printers with the optional laminator can have an optional impresser installed in the laminator that impresses on the front of the card. The optional Tactile Impression Module (TIM) mounts on the back of some printers and can impress on the front or back side of the card. Printers cannot have both a laminator and tactile impression module.

Laminator Impresser

If your laminator system is equipped with the optional impresser, you can select to add an impression to the front of the card. The impresser uses an installed die to stamp an impression on the card. The impresser uses heat to fuse the laminator overlay material to the card, adding an extra measure of security.

Use the Card Printer Driver to specify if you want to impress the card. The impresser can stamp up to three impressions on either the left, center, or right part of the card front. Impreser settings are specified using Printer Manager or the Printer Dashboard. Refer to the “Laminator” section of the printer’s Installation and Administrator’s Guide for information about using Printer Manager, or the Printer Dashboard Help.

The Laminator Impress Card setting displays only when your laminator has an impresser installed. If the Card Printer Driver is installed on a shared printer client or is part of a printer pool, always make sure that an impresser is installed in the laminator before using this setting.

You also can use a laminator impresser escape to impress a card. Refer to “Laminator Impreser Escape” on page 131.

Do the following to impress a card:

1. Open the Printing Preferences window.
2. On the Layout tab, click Advanced.
3. Click Laminator Impress Card and select Front. (The default Impress card option is None.)
4. Click OK to save your selection and then click Apply on the Layout tab.
5. Print sample cards to verify that they are being impressed properly.
Tactile Impresser

Some Sigma DS and retransfer card printers support the optional tactile impression module (TIM) that is installed at the back of the printer.

If your printer has the optional tactile impression module installed, you can select to add an impression to the front or back of the card. The impresser uses an installed die to stamp an impression on the card, and can include an optional installed foil that is fused into the impression. The tactile impresser uses heat to create the impression and fuse the foil to the card.

Sigma DS Card Printers can impress a card without using foil. Retransfer card printers always use foil when impressing a card. Refer to the Tactile Impression Module User’s Guide for more information.

The tactile impresser can stamp an impression in one of three positions on the card. Impresser positions are specified using Printer Manager or the Printer Dashboard. Refer to the printer’s Installation and Administrator’s Guide or the Printer Dashboard Help for information about TIM settings.

The Card Printer Driver allows you to select to impress the card. When you use the Printing Preferences setting, only the first impress position is used. You also can use a tactile impresser escape to impress a card. Refer to “Tactile Impresser Escape” on page 132. Using an escape allows you to specify any of the three possible positions of the impression on the card.

The Tactile Impress Card option displays only when the Tactile Impression Module is installed on the printer.

Do the following to impress a card with the tactile impression module:

1. Open the Printing Preferences window.
2. On the Layout tab, click Advanced.
3. Click Tactile Impress Card and select from the following impress options:
   - None. This is the default setting.
   - Front. The impression is on the front of the card.
   - Back. The impression is on the back of the card.
4. Click OK to save your selection and then click Apply on the Layout tab.
5. Print sample cards to verify that they are being impressed properly.
Embosser Topping

Printers that include an embosser typically apply topping foil to the embossed characters on a card. The embosser topping option allows you to specify whether or not to apply topping foil to the embossed characters. The setting applies to all embossed cards.

Do the following to change the embosser topping option:

1. Open the Printing Preferences window.
2. On the Layout tab, click Advanced.
3. Click Embosser topping and select an option from the drop-down list:
   - On—Topping foil is applied to embossed characters. This is the default.
   - Off—Topping foil is not applied to embossed characters.
4. Click OK to save the setting and close the Advanced Options window.
5. On the Layout tab, click Apply, or click OK to close the Printing Preferences window.
Print Area Tab

The Print Area tab allows you to specify printing and non-printing areas on the card.

- For card printers that support printing to rewritable cards, you use the Print Area tab to specify erase options (refer to “Select an Erase Pattern” on page 101). Refer to “Printer Setup for Rewritable Cards” on page 112 for a complete discussion of how to set up your system to use the rewritable feature.

- A retransfer card printer uses the Print Area tab to block printing over the smart card chip on the front of the card and specify the area to which to apply the inhibit or panel of the ink ribbon on the back of the card. Refer to “Retransfer Card Printer Print Area Tab” on page 103.

Print and Topcoat Blocking

The Card Printer Driver can prevent printing and topcoat application on specific areas of the card. This includes the magnetic stripe, smart card chip, signature panel, or another area that must remain unprinted or without topcoat.

The Print Area tab provides a selection of standard blocking patterns that use a driver preset mask, which automatically applies the proper dimensions and locations of a smart card chip and magnetic stripes for print blocking. For more information about non-printing areas of a card, refer to the printer’s Installation and Administrator’s Guide.

- If the predefined blocking selections offered by the Card Printer Driver do not fit the card design, you can use escapes to define custom rectangular areas for printing and topcoat application, including defining more than one blocking area per side of a card. Refer to “Print Blocking Escapes” on page 119.

- You also can create a custom topcoat blocking pattern that is not available with the topcoat settings offered by the Card Printer Driver or through escapes. The custom pattern can be a non-rectangular shape or another shape based on a graphic image bitmap, such as a logo. Refer to “The back of the completed card looks like the following:” on page 97.

To return the Print Area tab to the default settings, click Restore Defaults. The default print and topcoat settings are:

- Front Side Print Area: Print and topcoat entire side of card
- Back Side Print Area: Print and topcoat entire side of card
- Custom bitmap is not selected

If you are using YMCK or YMCK-K ribbon (ribbons without a topcoat panel), the topcoat blocking preferences are ignored. Print blocking preferences function normally.
Select a Preset Mask

Do the following to select a preset mask for magnetic stripe or smart card areas:

1. Open the **Printing Preferences** window.
2. Select the **Print Area** tab.
3. For the side of the card with the non-printing area, select **Block printing and topcoat over this area**, and then select the area from the list.

The Print Blocking and Topcoat Blocking icons display the location of the card element.

The example shown blocks printing and topcoat application on the ISO 3-Track Magnetic Stripe area on the back of the card. The text shown on the back of the card design is formatted with a magnetic stripe font and is encoded.

4. Click **Apply** to save the setting, and then click **OK**.
5. Send the card to print.

The back of the completed card looks like the following:

The narrow white area above and below the magnetic stripe indicates the non-printing area. It is slightly larger than the feature, in this case the magnetic stripe.
Use a User-Defined Topcoat Bitmap

User-defined bitmaps allow you to apply topcoat to a card in custom patterns or shapes when the predefined blocking areas and escapes are not sufficient. The bitmap files are installed as part of the Card Printer Driver Installation in the C:\CardPrinter folder. If you previously used an older-generation desktop printer, the bitmap files may already be on your PC.

The topcoat bitmap used depends on the card side and orientation you specify.

<table>
<thead>
<tr>
<th>Side</th>
<th>Orientation</th>
<th>Bitmap File</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Portrait</td>
<td>CRDPortTopcoatFront.bmp</td>
</tr>
<tr>
<td>2</td>
<td>Portrait</td>
<td>CRDPortTopcoatBack.bmp</td>
</tr>
<tr>
<td>1</td>
<td>Landscape</td>
<td>CRDLandTopcoatFront.bmp</td>
</tr>
<tr>
<td>2</td>
<td>Landscape</td>
<td>CRDLandTopcoatBack.bmp</td>
</tr>
</tbody>
</table>

If the bitmap files are already installed on your computer, a new driver installation or update does not overwrite the existing files.
Modify a User-Defined Bitmap

Creating a custom bitmap is not recommended. Instead, modify the bitmap files provided with the driver. The bitmap files are black-and-white, one-bit-per-pixel files that contain the specifications for blocking. The white areas of the bitmap represent the topcoat blocking area, and the black area represents the topcoat areas. Each bitmap has a sample image that illustrates the card orientation. Use a graphics editing program, such as Microsoft Paint, to modify the driver-provided bitmap.

1. Open the driver-provided bitmap that describes the card side and orientation of your card design.

2. Draw a black shape over any sample images you want to remove.

   If the card design includes more than one blocking area, you must create all blocking areas in the bitmap file, including smart card chip or magnetic stripe areas. Refer to your printer’s *Installation and Administrator’s Guide* for the dimensions of non-printing areas for magnetic stripes and smart card chips.
3. Create a new blocking area by drawing a white shape or pasting a graphic. The following example shows a possible signature area below the magnetic stripe area on the back of a card. The magnetic stripe and signature areas were created by drawing a white rectangle on the black background of the file CRDLandTopcoatBack.bmp.

![Signature Area Example]

4. Save the file using the same name in the C:\CardPrinter folder.

**HINTS & TIPS**

- If you use a user-defined topcoat bitmap, you must define all card elements in the bitmap, including smart card chip and magnetic stripe locations. Driver-defined preset masks or ID software topcoat blocking areas are not used.

- The purpose of topcoat is to protect the printed image on a card. Any area with color printing eventually fades if it lacks a topcoat. Make sure that most color printing is covered with topcoat.

**Select a User-Defined Bitmap**

1. Open the **Printing Preferences** window.
2. Select the **Print Area** tab.
3. For the side of the card that you want to use the user-defined bitmap, select **Ignore topcoat selection. Use my bitmap for topcoat**. The Topcoat Blocking icon displays as BMP.

   The driver uses the correct bitmap from c:\cardprinter folder based on the card orientation you specified on the Layout tab.

4. Click **Apply** to save the setting, and then click **OK** to close the Printing Preferences window.
5. Send the card to print.
6. Inspect the card to verify the topcoat is being applied correctly. Print sample cards until you are satisfied that the topcoat meets your card design requirements.
Select an Erase Pattern

When a printer is configured to print to rewritable cards, you use the Print Area tab to specify the erase option to use. The Print Area tab erase options display only when the Print Mode tab Rewrite option has been selected. Refer to “Select the Rewrite Option” on page 109.

The options for erase patterns include entire card, which erases the whole card, or a user-defined bitmap, which erases a portion of the card.

The user-defined erase patterns use bitmap files that are installed as part of the Card Printer Driver installation. The following files are installed in the C:\CardPrinter folder:

<table>
<thead>
<tr>
<th>Orientation</th>
<th>Bitmap file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portrait</td>
<td>CRDPortEraseFront.bmp</td>
</tr>
<tr>
<td>Landscape</td>
<td>CRDLandEraseFront.bmp</td>
</tr>
</tbody>
</table>

Rewritable cards are erased and printed only on the front side of the card.

You can modify the bitmap files to erase just a portion of the card, based on your card design. The bitmap files are black-and-white, one-bit-per-pixel files that allow you to specify the erase area. The white areas of the bitmap represent the part of the card that will not be erased, and the black area represents the area to erase. Use a graphics editing program, such as Microsoft Paint, to modify the driver-provided bitmap.

1. Open the driver-provided bitmap that describes the orientation of your card design.
2. Create a new erase pattern by drawing a shape that corresponds to the erase area of the card. The example shows a custom erase area that erases just the middle portion of a portrait-oriented card.

3. Save the file with the same name and in the same location (C:\CardPrinter).

Do the following to select an erase pattern on the Print Area tab:

1. Open the Printing Preferences window.
2. Select the Print Area tab.
3. Select one of the following options:
   - **Erase and print entire side of card**—The entire front of the card is erased before writing.
   - **Use my bitmap for erasing the card**—The driver uses the correct custom bitmap to erase the card, based on the card orientation specified on the Layout tab.
     
     The Print Blocking icon displays as BMP.
4. Click **Apply** to save the setting, and then click **OK** to close the Printing Preferences window.

Printing rewritable cards requires several settings in Printer Manager and in the Card Printer Driver. Refer to “Printer Setup for Rewritable Cards” on page 112 for a complete discussion of how to set up your system to use the rewritable feature.
Retransfer Card Printer Print Area Tab

A retransfer card printer uses the ink ribbon to print images on the retransfer film, which is then bonded to the card using a heated roller. When you print to a retransfer card printer, you use the Print Area tab to select a preset mask to do the following:

- Block the application of peel-off over the smart card chip on the front of the card. This prevents the retransfer film (and any printing) from adhering to the chip.
- Apply the inhibitor panel or peel-off of the ink ribbon to the back of the card. The inhibitor panel prevents ink or retransfer film from bonding to the magnetic stripe.

Retransfer card printers can apply a second layer of retransfer film to the card. The second layer does not contain any images, and is applied to provide added durability to the card.

You also can use an escape to specify a second retransfer layer. Refer to “Apply Additional Retransfer Layer Escape” on page 133.

If the predefined blocking selections offered by the Card Printer Driver do not fit the card design, for example, if the card includes a signature panel, you can use escapes to define custom rectangular areas that are not printed. Refer to “Print Blocking in a Retransfer Card Printer” on page 123.

Do the following to select a preset mask:

1. Open the Printing Preferences window.
2. Select the Print Area tab.
3. For each side of the card with a non-printing area, select Block printing over this area, and then select the area from the drop-down list.

   The Print Blocking icon displays the location of the card element.
4. Click the check box next to Apply additional layers of retransfer material for front, back or both sides of the card to apply a second layer of retransfer film to the card. If the box is not checked, only one layer of retransfer material is applied.

5. Click Apply to save the setting, and then click OK to close the Printing Preferences window.
6. Send the card to print.
- You cannot apply retransfer film over the magnetic stripe or signature panel on the back side of the card. You will not have the option to apply a second layer of retransfer film if your card has a magnetic stripe or signature panel on the front or back side. A second layer of film applied over those features would make them unusable.
- Primerless ribbons (ribbons without a primer panel) do not support cards with a magnetic stripe or signature panel, so you can select to apply a second layer of retransfer film to the card.
- When you select to block printing over a feature (smart card chip or magnetic stripe), the retransfer film overlaps all edges of the feature by 0.5 mm. This makes the actual non-printing area smaller than the feature and creates a clean edge as the retransfer film is applied to the card. It does not affect the function of the feature.

When you select to block printing over a feature (smart card chip or magnetic stripe), the retransfer film overlaps all edges of the feature by 0.5 mm. This makes the actual non-printing area smaller than the feature and creates a clean edge as the retransfer film is applied to the card. It does not affect the function of the feature.

The completed card looks like the following:

The dotted lines inside the smart card chip and the magnetic stripe areas indicate the 0.5 mm overlap of the retransfer film over the feature.
Color Adjustment Tab

The Card Printer Driver allows you to adjust the color printing on a card using the Printing Preferences window.

Using the Color Adjustment tab, you can change the following:

- The brightness of color printing on the card
- The contrast of color printing on the card
- The color balance of color printing on the card

1. On the Printing Preferences window, select the Color Adjustment tab.

   The tab contains the Original image and the Adjusted image. They show how your changes look on a card.

2. Select Enable Color Adjustment to adjust the settings.

Brightness

The Brightness setting changes the overall lightness or darkness of the card.

1. Click the up arrow to make the image lighter, or the down arrow to make the image darker.

   The Adjusted image shows the effect of the new setting.

2. Click Apply after each change to save it.

3. To verify changes, do one of the following:
   - Print one or more cards from your card production software.
   - Print a sample card from the Printer Properties > Printer Status page.
4. Evaluate the appearance of the cards.
5. Repeat these steps until the cards meet your requirements.
6. Click Apply to save the new values.

Contrast

The Contrast setting changes the degree of difference between the light and dark values of an image.

1. Click the up arrow to increase contrast, or the down arrow to decrease contrast.
   
   The Adjusted image shows the effect of the new setting.
2. Click Apply after each change to save it.
3. To verify changes, do one of the following:
   - Print one or more cards from your card production software.
   - Print a sample card from the Printer Properties > Printer Status page.
4. Evaluate the appearance of the cards.
5. Repeat these steps until the cards meet your requirements.
6. Click Apply to save the new values.
Color Balance

1. Evaluate the image for color balance. Does the card have a yellow cast or do photos have a greenish tint?

   If most of the card prints with the correct colors, consider using a graphics application to change the logo or other part of the card that needs color improvement.

2. Determine which color needs adjustment.

   Click the up arrow to increase a color, or the down arrow to decrease the color.
   - The Adjusted image shows the effect of the new setting.
   - If changing the obvious color does not produce the desired effect, try changing the other two.

3. Click Apply after each change to save it.

4. To verify changes, do one of the following:
   - Print one or more cards from your card production software.
   - Print a sample card from the Printer Properties > Status page.

5. Evaluate the appearance of the cards.

6. Repeat these steps until the cards meet your requirements.

7. Click Apply to save the new values.

Hints & Tips

- The settings on the Color Adjustment page affect the color printing of all cards sent from the PC that uses the Card Printer Driver.

- Text and images formatted as black (K) are not affected by color adjustment.

- To return the Color Adjustment settings to their default values, click Restore Defaults.
Print Mode Tab

The Print Mode tab allows you to specify the print resolution to use when printing a card.

For card printers that support printing to rewritable cards, use the Print Mode tab to tell the printer to use the rewrite feature. Refer to “Select the Rewrite Option” on page 109.

The Print Mode tab does not display for the following:
- Retransfer card printers. The Card Printer Driver always renders images at a resolution of 600 x 600 dpi.
  If an application provides images at 600 dpi, the driver maintains that resolution. If an application provides images at other resolutions, the driver scales the image to be the correct size at 600 dpi.
- CE840 system, if the printer does not have a printhead installed.

Select the Print Resolution

1. Open the Printing Preferences window.
2. Select the Print Mode tab.
3. Select the desired print resolution. The Print Mode tab has the following three options.
   - Always use standard resolution (300x300 dpi)—This is the default selection.
   - Always use best possible resolution
   - Custom—The Custom option allows you to select a resolution from the Color and Monochrome drop-down lists.
4. Click Apply to save your changes, and then click OK to close the Printing Preferences window.
Select the Rewrite Option

When a card printer supports rewritable card printing, the Rewrite check box is enabled on the Print Mode tab. If the printer does not support rewritable cards, the Rewrite option is not available.

When you select the Rewrite option on the Print Mode tab, the Print Area tab displays the erase options for a rewritable card. Refer to “Select an Erase Pattern” on page 101.

1. Open the Printing Preferences window.
2. Select the Print Mode tab.
3. Select the Print using rewritable cards check box.
   
   Only valid Print Resolution options are available.

4. Click Apply to save your changes and then click OK to close the Printing Preferences window.

Printing rewritable cards requires several settings in Printer Manager and in the Card Printer Driver. Refer to “Printer Setup for Rewritable Cards” on page 112 for a complete discussion about how to set up your system to use the rewritable feature.
Lamination Tab

The Lamination tab displays only if the printer is part of a laminator system. It allows you to specify how you want to apply overlay material to your card.

The laminator system can have one or two laminators (labeled L1 and L2) that can apply a patch or topcoat overlay to one or both sides of a card. Refer to your printer’s User’s Guide and Installation and Administrator’s Guide for complete information about setting up a laminator system and the types of overlay materials available.

You can use escapes to override the printing preferences set on the Lamination tab on a card-by-card basis. Refer to “Laminator Escape” on page 130.

Apply an Overlay

Do the following to specify lamination settings:

1. Open the Printing Preferences window.
2. Select the Lamination tab.
3. Select a Laminate card option for each laminator. You can select from the following:
   - Do not apply—No overlay material is applied.
   - Front side only—Applies the overlay to the front of the card.
   - Back side only—Applies the overlay to the back of the card.
   - Both sides—Applies the overlay material to both sides of the card.
   - Twice on front side—Applies two layers of the overlay material to the front of the card. Use this option only with a topcoat overlay.
4. Click Apply to save your changes, and then click OK to close the Printing Preferences window.

- The default Laminate card setting for both L1 and L2 is Do not apply. You must specify a lamination option on the Lamination tab or no overlay material is applied to the card.
- If an L2 laminator is not installed, Not installed displays and the L2 options are not available.
Debow the Card

When you apply an overlay to a card, the card may become bowed slightly due to heat from the laminator.

Select the **Debow card** option on the Lamination tab to use the debow mechanism in the laminator to return the card to its proper shape.

- The Debow card option is not selected by default. You must select the option after setting the lamination options.
- If you use ID software to specify lamination options, you can select the Debow card option on the Lamination tab to make sure that cards are debowed after they are laminated. You also can use a debow escape to debow the card. Refer to “Laminator Escape” on page 130.
- The debow settings—such as the amount (distance) of debow, the direction of debow (up or down), and the time the debow action is applied—are set in Printer Manager or the Printer Dashboard. You may need to print several cards to determine the best debow settings for your card type. Refer to your printer’s *Installation and Administrator’s Guide* for information about using Printer Manager, or the Printer Dashboard Help.

A retransfer card printer debows the card after each printer retransfer operation. The Debow card setting in the Lamination tab applies only to the debow operation performed when overlay material is applied in an attached laminator.

About Tab

The About tab shows the Card Printer Driver version and any additional information about the driver. Refer to “About Tab” on page 62.
Printer Setup for Rewritable Cards

Printing rewritable cards on a printer that supports the rewrite option requires that the printer, Printer Manager, and the Card Printer Driver all are set up properly.

Set Up the Printer

Do the following to prepare the printer to print rewritable cards:

1. Open the printer cover and remove the print ribbon cartridge.
2. Remove the print ribbon from the cartridge and set it aside.
   Make sure that the cleaning roller with the replaceable cleaning sleeve is installed.
3. Return the print ribbon cartridge to the printer.
4. Close the printer cover.
5. Have rewritable cards available to insert into the printer.

Refer to your printer’s User’s Guide for complete information about each of these steps.

Set Up Printer Manager

Use Printer Manager to enable rewritable printing. Do the following to access Printer Manager and specify rewritable settings:

1. Open the Windows Devices and Printers window.
2. Right-click the XPS Card Printer icon and select Printer properties.
3. Select the Printer Status tab.
4. Confirm that the Printer Information list shows that the printer supports Rewritable Cards.
5. Click Configure Printer to launch Printer Manager.
7. Select **Print** from the Printer Setting menu.

8. On the Print page, change the **RewritableCardEnable** setting to **Enabled**.

Change the other Rewritable settings, as needed. Refer to the Printer Manager **Print** settings section in your printer’s *Installation and Administrator’s Guide* for more information about the Rewritable card settings.

9. Scroll to the bottom of the page and click **Set Current**.

10. Log out of Printer Manager and close the browser window.

**Set Up the Card Printer Driver**

To set up the Card Printer Driver to print rewritable cards, do the following:

1. Open the Windows **Devices and Printers** window.

2. Right-click the XPS Card Printer icon and select **Printing preferences**.

3. Select the **Print Mode** tab.
4. Select the **Print using rewritable cards** check box. Refer to “Select the Rewrite Option” on page 109.

Selecting the Rewrite option on the **Print Mode** tab enables the erase options on the **Print Area** tab.

5. Select the **Print Area** tab.

6. Select the erase option you want to use. Refer to “Select an Erase Pattern” on page 101 for more information.

The printer is ready to print rewritable cards. You can print the following:

- A driver sample card. Refer to “Print a Driver Sample Card” on page 52.
- A test card from Printer Manager. Refer to the Printer Manager **Testcard** section in the printer’s **Installation and Administrator’s Guide**.
- A card from your card design software. Refer to the Elements of Card Design chapter in the printer’s **Installation and Administrator’s Guide**.

A printer configured to print rewritable cards prints card designs as though they were printed using a monochrome ribbon.
UV and Luster Ribbon Support

Color print ribbons with a UV fluorescent (F) or luster (L) panel are supported by the Card Printer Driver. UV printing is colorless under normal lighting and is meant to provide an additional form of security. Luster printing enhances card appearance with visible color-shifting iridescent print with UV fluorescing properties.

The Card Printer Driver supports UV and luster printing from multiple applications. The driver detects when a UV or luster ribbon is installed in the printer and determines the text and graphics to print with the correct panel.

To identify the card design elements to print using the UV or luster panel, the driver looks for the color R:217, G:217, B:217. This is a light gray color and is a standard selection from the Microsoft Office color chooser.

Card design software allows you to specify the card elements to print using the UV or L panel, so that you do not need to use the defined RGB color.

Refer to your printer’s Installation and Administrator’s Guide for more information about the UV or luster ribbon supported by the printer and how to use it.
Card Design for UV Ribbon

Creating a card design that uses UV ribbon has some special considerations.

When a UV element is placed over the top of a color or black (K) element, these elements print as though the UV element isn’t there. Although the UV element is colorless under normal lighting, be aware of the following when creating your card design:

- Text with a UV shadow prints so that the text characters display under normal lighting and a UV shadow appears below and to the right of each character under a UV light source. The UV ink prints only where the shadow appears (it does not print over the text).

- UV printed over other colors does not block those colors. Non-UV text or images behind the UV element print as though no UV element exists.

- UV printed over other colors does not fluoresce with the same intensity. Design your card to place UV elements where there is no other printing so that it appears over the white card background.

- UV text and images printed behind non-UV elements are “punched out” (the UV printing is not visible) where the color or K element overlaps the UV element.

- UV dashed line printed over black displays two intensities

- Color (gold) dashed line printed

- UV dashed line printed behind a black rectangle—the black prints over the UV element
Printers can print UV elements on both the front and the back of the card. A two-sided card design with UV on both the front and back uses two panel sets of the ribbon.

- If the card design contains the UV color, but UV ribbon is not detected in the printer, UV elements are treated as normal color elements.
- Do not print an entire card using the UV panel.

### Print UV Design Elements

The following items will print with the UV panel:

- Text set to the UV color.
- Vector graphics set to the UV color. Vector graphics have components such as lines and fills that the driver processes into a shape.
- Raster images (or bitmaps), such as photographs, with the pixel color set to the UV color or white.
  - You cannot print color photographs with the UV panel directly. To print an image using the UV panel, the application must create a two-color image with white as one color and the UV color as the other color.
  - UV raster images always print over other card elements even if they are placed behind the element in the card design.

Card Layout as Designed:
UV raster image placed under text

Card as Printed:
UV raster image prints over text
Escapes

Escapes are formatted text that the Card Printer Driver converts to printer commands to support a number of operations, including the following:

- Block printing
- Apply topcoat
- Erase and write rewritable cards
- Encode magnetic stripe data
- Select an input hopper
- Laminate a card
- Debow a card in the laminator
- Impress a card
- Apply a second layer of retransfer film
- Apply Peel-off region
- Emboss/indent a card

Escapes override printing preferences set in the Card Printer Driver or in a card design application. You can use escapes to change printing controls on a card-by-card basis without having to reset your printing preferences.

Hints & Tips

- For each escape, make sure that the text is consistent (use the same font, font size, and color). Use a common font that is easy to see, and is different from, the text you want to print on the card.

- Each escape must fit on a single line with no formatting or carriage returns. Use a small font size to make sure that there is enough room for long escape strings.

- Do not align escape text to be on the same horizontal line as printed text.

- Make each escape its own line of text on the card design.

- Do not place the escape as the first line at the top of the card design page when using Microsoft Word.
Print Blocking Escapes

The Card Printer Driver provides several methods to prevent printing and topcoat on specific areas of the card. Refer to “Non-Printing Areas” in your printer’s Installation and Administrator’s Guide and “Print Area Tab” on page 96 for more information.

By default, the entire surface of the card is available for printing and topcoating. But when cards have a magnetic stripe, a smart card chip, or another non-printable area, such as a signature panel or hologram, you must define those areas so that the printer does not print or apply topcoat to them.

Use escapes to block non-standard areas, or to define more than one blocking area per side of a card. Escapes are specific sequences of characters that mark data with a special purpose. The Card Printer Driver recognizes the following types of print blocking and topcoat escapes:

- Print Block (PB)
- Topcoat Add (TA)
- Topcoat Remove (TR)

- A retransfer card printer uses the print block escape to block printing over the smart card chip on the front of the card and to specify where to apply the inhibitor or peel-off on the card back to prevent printing on the magnetic stripe and signature panel. Refer to “Print Blocking in a Retransfer Card Printer” on page 123 for complete information.
  
  The retransfer card printer does not use the topcoat add (TA) and topcoat remove (TR) escapes.

- If you use YMCK or YMCK-K ribbon (ribbons without a topcoat panel), the topcoat escapes are ignored. Print blocking escapes function normally.

About Non-Printing Areas

- If the card has more than one non-printing area on a side (for example, a magnetic stripe and a signature panel), you must define all non-printing areas using print blocking escapes. An escape applies to the side of the card where it appears in the card design.

- Non-printing areas defined using print blocking escapes always override the driver Printing Preferences settings.

- Each print blocking area defined by an escape is a rectangular shape.

- Each blocking rectangle is defined by four values separated by a space.

- You can specify more than one area of the same type in the escape string by placing a semicolon (;) character between each set of values.
Print Blocking Syntax

The syntax or structure of each print blocking escape is ~XX%n1 n2 n3 n4?, where:

~ The beginning of the escape.

XX The type of action:
- PB—Print Block
- TA—Topcoat Add
- TR—Topcoat Remove

% The start of values.

n1* The distance (in mm) from the top of the card to the start of the print blocking area.

n2* The distance (in mm) from the left edge of the card to the start of the print blocking area.

n3* The width (in mm) of the print blocking area.

n4 The height (in mm) of the print blocking area.

? The end of the escape.

* Separate the measurements with a space when entering the escape.

Print Blocking in a Direct-to-Card Printer

The following examples show how to determine the values for the block print escape.

- The dimensions shown in the following examples are for general reference. The size, shape, and location of the magnetic stripe, smart card chip, or signature panel can vary based on the card stock you use. Test your escapes to make sure that the blocking areas are correct.

- Blocking typically extends 0.05 inch (1.27 mm) outside the edges of a feature. The diagrams and dimensions shown include the extended blocking region.
The following example shows the direct-to-card print blocking dimensions for a three-track magnetic stripe area.

**Landscape**
- $n_1 = 3.2$ mm
- $n_2 = 0$
- $n_3 = 86$ mm
- $n_4 = 14.7$ mm

**Portrait**
- $n_1 = 0$
- $n_2 = 3.5$ mm
- $n_3 = 14$ mm
- $n_4 = 86$ mm

The following example shows sample direct-to-card print blocking dimensions for a smart card chip. The actual measurements can vary depending on the size and location of the chip.

**Landscape**
- $n_1 = 17.3$ mm
- $n_2 = 8$ mm
- $n_3 = 14.3$ mm
- $n_4 = 13$ mm

**Portrait**
- $n_1 = 8$ mm
- $n_2 = 23.6$ mm
- $n_3 = 13$ mm
- $n_4 = 14$ mm
Block Print Escape

A block print escape begins with `~PB%`.

**Examples:**

| ~PB%10 10 55 15? | Printing is blocked in one area. |
| ~PB%3.2 0 86 14.7;20 13 60 9? | Printing is blocked in two areas, such as a magnetic stripe and signature panel. |
| ~PB%? | No printing is blocked on the current card. |

Topcoat Add Escape

The topcoat add escape applies topcoat only in the area defined in the escape. Topcoat is not applied to other areas of the card. All full-color printing should be covered with topcoat, so use this option with care.

The topcoat add escape begins with `~TA%`.

**Examples:**

| ~TA%0 0 85.6 37? | Topcoat is applied to one large area of the card. |
| ~TA%16.8 0 37.1 5;30.5 45.23 15 15? | Topcoat is applied in two areas. |

Topcoat Remove Escape

With a topcoat remove escape, the topcoat is not applied to the areas defined by the escape. All other areas of the card have topcoat.

The topcoat remove escape begins with `~TR%`.

**Full-Card Topcoat Options**

- Use the escape `~TR%?` to override the Card Printer Driver preset masks and **topcoat the entire card side**.
- Use the escape `~TA%?` to override the Card Printer Driver preset masks and **apply no topcoat to the entire card side**.

Print several cards using your card design and application to verify that printing and topcoat are applied as you intend.
Escape Support for Rewritable Cards

When rewritable printing is enabled, you can use print blocking and topcoat escapes to specify the write and erase areas.

Use topcoat escapes to control the erase area. The areas where topcoat would be applied is where the card is erased.

**Examples:**

<table>
<thead>
<tr>
<th>Escape</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>~TA%?</td>
<td>The card is not erased.</td>
</tr>
<tr>
<td>~TR%</td>
<td>Erases the entire card.</td>
</tr>
<tr>
<td>~TA%0 0 50 42?</td>
<td>Erases the top half of a portrait-oriented card.</td>
</tr>
</tbody>
</table>

Use print blocking escapes to control rewritable printing just as you would standard printing.

Print Blocking in a Retransfer Card Printer

A retransfer card printer uses the print block escape to do the following:

- Block the application of primer over the smart card chip on the front of the card. This prevents the retransfer film (and any printing) from adhering to the chip.

- Apply the inhibitor or peel-off panel of the ink ribbon to the back of the card. The inhibitor panel prevents ink or retransfer film from bonding to the magnetic stripe and signature panel.

- Apply the inhibitor (example CMYKP-KPi) or peel-off panel (example CMYKKPo) of the ink ribbon to the back of the card. The inhibitor panel prevents ink or retransfer film from bonding to the magnetic stripe and signature panel.

- Print blocking in a retransfer card printer is designed to leave card features such as the smart card chip, magnetic stripe, and signature panel free of printing. It is not designed to block printing over other areas of the card.

- You do not need to block retransfer printing over a hologram. However, if your card stock includes a hologram, modify your card design so that no color printing takes place over the hologram. Overlap the hologram by 0.5 mm to avoid a white border around the hologram.

The retransfer print block escape uses the standard syntax, `~PB%n1 n2 n3 n4?` (refer to “Print Blocking Syntax” on page 120). The topcoat add and topcoat remove escapes are not used with the retransfer card printer.

The retransfer film must overlap the selected feature (smart card chip, magnetic stripe, and signature panel) by 0.5 mm. This makes the actual non-printing area smaller than the feature and
creates a clean edge as the retransfer film is applied to the card. It does not affect the function of
the feature. The dashed lines in the following examples represent the overlap onto the feature.

The dimensions shown in the following examples are for general reference. The size, shape, and
location of the magnetic stripe, signature panel, or smart card chip can vary based on the card
stock you use. Test your escapes to make sure that the blocking areas are correct.

**Magnetic Stripe Print Blocking**

The following example shows retransfer card printer print blocking dimensions, and the escape
values to enter, for a three-track magnetic stripe area.

**Signature Panel Print Blocking**

The location and size of signature panels can vary widely. Measure the signature panel and set up
the escapes in your card design to apply inhibitor or peel-off to the signature panel and prevent
the application of retransfer film over the panel. Use the following information as a guide to enter the escape values. The dashed lines represent the retransfer film overlap onto the
signature panel.
If the card design has no printing to the left of the signature panel: Start the inhibitor at the left edge of the card, using a retransfer film overlap of 0.5 mm on the top and bottom edges, and 1.0 mm on the right edge of the signature panel.

If the card design has printing to the left of the signature panel: Start the inhibitor inside the signature panel, using a retransfer film overlap of 0.5 mm on the left, top, and bottom edges, and 1.0 mm on the right edge of the panel.

Smart Card Chip Print Blocking

The following illustration shows sample retransfer card printer print blocking dimensions, and the escape values to enter, for a smart card chip. The actual measurements can vary depending on the size and location of the chip.
**Landscape**
- \( n_1 = 19 \text{ mm} \)
- \( n_2 = 9.5 \text{ mm} \)
- \( n_3 = 10.5 \text{ mm} \)
- \( n_4 = 10 \text{ mm} \)

**Portrait**
- \( n_1 = 9.5 \text{ mm} \)
- \( n_2 = 25.5 \text{ mm} \)
- \( n_3 = 9.5 \text{ mm} \)
- \( n_4 = 10.5 \text{ mm} \)
Magnetic Stripe Escapes

Use magnetic stripe escapes when an application cannot format magnetic stripe data or if an application does not allow you to select the driver’s magnetic stripe fonts. The data to encode on a magnetic stripe is entered as text and can look like data to print. The Card Printer Driver uses the magnetic stripe escapes to identify the data to encode. Data contained within the escape is not printed.

The Card Printer Driver uses the tilde (~) symbol to indicate the beginning of a magnetic stripe escape. If your organization uses the tilde in magnetic stripe data, the MSDisable.INI file allows you to disable the parsing of magnetic stripe escapes, preventing the Card Printer Driver from identifying the data as an escape. This allows the tilde to be encoded in the magnetic stripe data. Refer to “Disable Magnetic Stripe Escape Parsing” on page C-26.

Supported Escapes

The escape defines the track for the data. Because the data format for each track is set in the printer, you must enter the type of data the format requires. The Card Printer Driver supports several escape systems that allow compatibility with card designs defined for various card printers. The following table shows the default ISO data format for each track. The Syntax column shows the general escape format for providing data to the printer. The Example column shows how the data looks when formatted.

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Track</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>~&lt;track#&gt; &lt;Start Sentinel&gt; &lt;data&gt; &lt;End Sentinel&gt;</td>
<td>1 (IATA)</td>
<td>~1%ENCODING WITH ESCAPES?</td>
</tr>
<tr>
<td></td>
<td>2 (ABA)</td>
<td>~2;1234567890?</td>
</tr>
<tr>
<td></td>
<td>3 (TTS)</td>
<td>~3;1234567890?</td>
</tr>
<tr>
<td>The only Start Sentinel permitted for tracks 2 and 3 is a semicolon (;)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Used by Entrust Datacard, JVC, and Fargo printers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>~&lt;track#&gt;&lt;data&gt;</td>
<td>1 (IATA)</td>
<td>~1ENCODING WITH ESCAPES</td>
</tr>
<tr>
<td>Used by Eltron/Zebra printers</td>
<td></td>
<td>~21234567890</td>
</tr>
<tr>
<td></td>
<td>3 (TTS)</td>
<td>~31234567890</td>
</tr>
<tr>
<td>~&lt;track#&gt;=&lt;data&gt;</td>
<td>1 (IATA)</td>
<td>~1=ENCODING WITH ESCAPES</td>
</tr>
<tr>
<td>Used by Atlantek printers</td>
<td></td>
<td>~2=1234567890</td>
</tr>
<tr>
<td></td>
<td>3 (TTS)</td>
<td>~3=1234567890</td>
</tr>
</tbody>
</table>
Set Up Magnetic Stripe Escapes

1. Format the text and graphics to print on the card. Use card production software or another application to create the card design.

2. Type the encode data (text) for one track. Locate an area on the card where typing the data to encode does not affect other card design components.

   The example shown uses the syntax:
   ~<track#><Start Sentinel><Data> <End Sentinel>

   The text for track 1 has the format: ~1%Zachary Hamilton 12345 Finance?

3. Repeat step 2 for each track of magnetic stripe data.

4. With magnetic stripe cards in the printer, send the card to print.

5. Verify that the encoding was successful by passing the card through a magnetic stripe reader.

HINTS & TIPS

- Do not put data for two tracks on the same line.

- Use a small font size to keep the text to encode on one line. Do not allow the text to encode to wrap to another line.

- Do not enter data to print on the same line as data to encode. It will not print.

- If necessary, you can use two or more lines of text for one track. Start and end each line with escapes, and enter a carriage return at the end of the line. The Card Printer Driver adds (appends) lines for the same track together.

When the Card Printer Driver adds lines of text for the same track, the sequence is determined by the application. Test your application with the Card Printer Driver to make sure that the data is in the correct order.

- The data to encode can be on side 1 (front) or side 2 (back) of the card design. Magnetic stripe data sent by the Card Printer Driver is always encoded on side 2 of the card.

- Magnetic stripe data is converted to uppercase letters if needed.

- The printer displays a message if characters unsupported by a track format are sent in the magnetic stripe data.
Input Hopper Selection Escape

Some printer models offer an optional multi-hopper that has six input hoppers. The Card Printer Driver allows you to specify the number of the hopper to use on the Advanced Options page of the Printing Preferences Layout tab. However, this option applies the hopper selection to all cards sent to the printer.

Using a hopper selection escape allows you to specify the input hopper to use as part of each print job from any application.

You cannot use the input hopper escape to specify an input hopper if you use interactive mode printing. Refer to the SDK Programmer’s Reference Guide for information about how to use the SDK to specify an input hopper in an interactive job.

The syntax for an input hopper selection escape is `~HS%x?`, where:

- `~` Indicates the start of the escape.
- `HS` Identifies the escape as a hopper selection escape.
- `%` Indicates the start of a hopper value.
- `x` Specifies the hopper number to use. `x` can be any value between 1 and 6, or 0 to select the exception slide.
- `?` Indicates the end of the escape.

For example, the escape `~HS%5?` tells the Card Printer Driver to pick a card for the print job from input hopper 5; `~HS%0?` picks the card from the exception slide.

**Hints & Tips**

- The input hopper selection value specified by the escape overrides the value set on the Printing Preferences Layout tab.
- If a printer does not have a multi-hopper, the escape is ignored. The card prints from the single hopper, or manual card input slot. No error is logged or displayed.
- If the value of `x` is anything other than 1, 2, 3, 4, 5, 6, or 0, the Card Printer Driver picks a card from hopper 1.
- The escape sets the printing preference for the input hopper by job. The application you use determines how the escape is interpreted:
  - Some applications, such as Microsoft Word, send a multipage, multicard document as a single job. The driver uses the first escape it encounters for all cards in the job. Any other escapes, even though they may be valid, are ignored.
  - Card production applications usually send a separate job for each card. This allows you to specify a different hopper for each card in a batch of printed cards.
Laminator Escape

Lamination systems can use escapes to control the application of overlay on a card and to debow the card.

The syntax for a laminator escape is ~LM%Lxy;D?, where:

- ~ Indicates the beginning of the escape.
- LM Identifies the escape as a laminator escape.
- % Indicates the start of laminator values.
- L Indicates a laminator action.
- x Specifies the laminator number to use, where x = 1 or 2.
- y Specifies the card side to laminate. y can have the following values: F (front), B (back), A (both sides), T (front side twice), or N (do not apply).
- ; A separator character that allows you to specify more than one lamination option in the escape.
- D Debows the card.
- ? Indicates the end of the escape.

Examples:

<table>
<thead>
<tr>
<th>Escape</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>~LM%L1F;L2B;D?</td>
<td>Laminate front side using L1, back side using L2, debow the card</td>
</tr>
<tr>
<td>~LM%L1A;D?</td>
<td>Laminate both sides using L1, debow the card</td>
</tr>
<tr>
<td>~LM%L1T?</td>
<td>Laminate front side twice using L1; the card is not debowed</td>
</tr>
<tr>
<td>~LM%D?</td>
<td>Debow the card only (no overlay is applied)</td>
</tr>
<tr>
<td>~LM%L1N;L2N?</td>
<td>Do not laminate the card. Use this escape to override the Laminate card settings in the Printing Preferences Lamination tab, for example, for a single card.</td>
</tr>
</tbody>
</table>

Hints & Tips

- The order of the escape Lxy elements is not important. The Card Printer Driver orders the L1 and L2 lamination and debow actions in the proper sequence.
- The escape control characters are not case-sensitive.
- Leading and trailing spaces in the escape string are removed by the Card Printer Driver.
- Only one escape is used.
  - If more than one escape is entered in the same text string, only the first escape is used. Subsequent escapes, even if they are valid, are not processed.
  - If multiple escapes are entered separately, only the last escape is used.
- Embedded spaces in the escape string make the escape invalid.
- Invalid escapes print on the card as regular text. This provides a record of what went wrong and lets you know that the card was not laminated. The following can invalidate an escape:
  - A missing laminator number or any character other than 1 or 2.
  - A missing laminator action or any character other than F, B, A, T, or N.
  - More than one instance of a laminator number (for example, ~LM%L1F;L1B? has two L1 actions).
- If a laminator is not installed, the escape is ignored and the card prints using other valid job options. No error messages are issued.

**Impresser Escapes**

You can use an impresser escape to stamp an impression on the card.

**Laminator Impresser Escape**

If your laminator system is equipped with the optional impresser, you can use a laminator escape to impress the card.

The syntax for a laminator impresser escape is ~IM%?, where:

- ~ Indicates the beginning of the escape.
- IM Identifies the escape as an impresser escape.
- % Tells the Card Printer Driver to send the impresser action.
- N Disables the impresser and overrides the Laminator Impress Card printing preference, if it is enabled.
- ? Indicates the end of the escape.

**Examples:**

<table>
<thead>
<tr>
<th>~IM%?</th>
<th>Impresses the card.</th>
</tr>
</thead>
<tbody>
<tr>
<td>~IM%N?</td>
<td>Does not impress the card.</td>
</tr>
</tbody>
</table>
If an impresser is not installed, the escape is ignored and the card prints using other valid job options. No error messages are issued.

Tactile Impresser Escape

If your system has the tactile impression module installed, you can use a tactile impresser escape to impress the card. (Also refer to “Tactile Impresser” on page 94.)

The syntax for a tactile impresser escape is ~IT%yL?, where:

- ~ Indicates the beginning of the escape.
- IT Identifies the escape as a tactile impresser escape.
- % Indicates the start of the tactile impresser values.
- y Specifies the card side to impress. y can have the following values: F (front), B (back), or N (None).
- L Specifies the position of the impression. You can specify one of 3 possible horizontal positions on the card: 1, 2, or 3. The impresser positions are specified using either the Printer Dashboard or Printer Manager. Only one impression is allowed per side. (Note: The vertical position of the impression is a mechanical adjustment that cannot be changed by a user.)
- ? Indicates the end of the escape.

Examples:

| ~IT%F1? | Impresses the front of the card at position 1. |
| ~IT%B3? | Impresses the back of the card at position 3. |
| ~IT%F2? | Impresses the front of the card at position 2. |
| ~IT%N? | Do not impress the card. Use this escape to override the Tactile Impress Card setting in the Printing Preferences > Layout > Advanced tab. |

Hints & Tips

- The tactile impression module does not support impressing on both sides. If escapes are entered for both sides of the card, the driver uses the first escape and ignores the second escape.
- If the tactile impression module is not installed, the escape is ignored and the card prints using other valid job options. No error messages are issued.
Apply Additional Retransfer Layer Escape

When you use the Card Printer Driver with a retransfer card printer, you can use an escape to apply a second layer of retransfer film to a card for added durability. The second layer does not contain any images, and is applied strictly to provide additional protection for the card. (Also refer to "" on page 88.)

The syntax for a second retransfer layer escape is \texttt{~RT\%XRx?}, where:

\begin{itemize}
\item \texttt{~} Indicates the beginning of the escape.
\item \texttt{RT} Identifies the escape as a retransfer layer escape.
\item \texttt{\%} Indicates the start of the escape values.
\item \texttt{XR} Specifies that an extra retransfer layer is to be applied.
\item \texttt{x} Specifies the card side to apply the extra retransfer layer. \texttt{x} can have the following values: F (front), B (back), A (both sides), or N (do not apply).
\item \texttt{?} Indicates the end of the escape.
\end{itemize}

\textbf{Examples:}

\begin{tabular}{|l|l|}
\hline
\texttt{~RT\%XRF?} & Apply a second retransfer layer to the front of the card. \\
\hline
\texttt{~RT\%XRF2?} & Apply a third retransfer layer to the front of the card. \\
\hline
\texttt{~RT\%XRB?} & Apply a second retransfer layer to the back of the card. \\
\hline
\texttt{~RT\%XRA?} & Apply a second retransfer layer to both sides of the card. \\
\hline
\texttt{~RT\%XRN?} & Do not apply a second retransfer layer to the card. Use this escape to override the second retransfer layer setting in the \textit{Printing Preferences > Print Area} tab. \\
\hline
\end{tabular}
Apply Peel-Off Escape

If the predefined selections offered by the Card Printer Driver do not fit the card design, use escapes to define a custom rectangular areas that are not printed.

This only applies for ribbons that have peel-off (example CMYKKPo)

The peel-off region is shown in escapes as \(\text{~PB\% 0 0 25.4 50.8?}\).

Driver will allow user to add as many as 3 layers of retransfer material in the front and 2 layers of peel off in the back. It is understood that adding 2 layers of peel off in the back will waste ribbon panels. So the following configuration are in scope:

**Examples:**

<table>
<thead>
<tr>
<th>Escape Sequence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>~PB% 0 0 25.4 50.8?</code></td>
<td>Apply 1 layer of retransfer material on the front, and 1 layer of retransfer material and peel-off region on the back.</td>
</tr>
<tr>
<td><code>~RT%XRB?</code></td>
<td>Apply 1 layer of retransfer material on the front, and 2 layer of retransfer material and peel-off region on the back.</td>
</tr>
<tr>
<td><code>~PB% 0 0 25.4 50.8?</code></td>
<td>Apply 2 layer of retransfer material on the front, and 1 layer of retransfer material and peel-off region on the back.</td>
</tr>
<tr>
<td><code>~RT%XRF XRB?</code></td>
<td>Apply 2 layer of retransfer material on the front, and 2 layer of retransfer material and peel-off region on the back.</td>
</tr>
<tr>
<td><code>~RT%XRF?</code></td>
<td>Apply 3 layer of retransfer material on the front, and 1 layer of retransfer material and peel-off region on the back.</td>
</tr>
<tr>
<td><code>~RT%XRF2 XRB?</code></td>
<td>Apply 3 layer of retransfer material on the front, and 2 layer of retransfer material and peel-off region on the back.</td>
</tr>
</tbody>
</table>
Embosser Escape

Use an embosser escape to specify the font and position of embossed and indented data. An embosser escape is made up of the following elements:

- **Escape preamble**—Tells the Card Printer Driver that the text characters following are part of an embosser escape and not text for rendering on the card.
- **Embosser font number**—The font number CE systems use to specify the emboss or indent character set, the front or back of the card, and in some cases the supply to use.
- **Emboss/Indent position**—Two values that specify the starting location of the emboss/indent operation.
- **Emboss data**—The text to be embossed or indented at a given location using the font number specified.

**Embosser Escape Syntax**

The embosser escape syntax is: `~EM%font#;horz_offset;vert_offset;data`

Use a semicolon (;) character to separate embosser escape elements.

**Escape Preamble**

In the preamble, the characters `~EM%` identify the beginning of an emboss escape.

**Embosser Font Number**

The usable font numbers are based on the emboss wheel installed in the embosser. Several fonts from the following list typically are supported by a given wheel:

<table>
<thead>
<tr>
<th>Font Number</th>
<th>Font Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Emboss Standard Gothic [front 10 cpi]</td>
</tr>
<tr>
<td>2</td>
<td>Emboss Farrington 7B [front 7 cpi]</td>
</tr>
<tr>
<td>3</td>
<td>Indent OCRB [back 10 cpi]</td>
</tr>
<tr>
<td>4</td>
<td>Indent Master Card Slanted [back 14 cpi]</td>
</tr>
<tr>
<td>5</td>
<td>Indent OCRB Size IV [front 7 cpi]</td>
</tr>
<tr>
<td>6</td>
<td>Indent Master Card Slanted [front 14 cpi]</td>
</tr>
<tr>
<td>7</td>
<td>Indent OCRB Front [front 10 cpi]</td>
</tr>
<tr>
<td>8</td>
<td>Indent Master Card Inverted [back 7 cpi]</td>
</tr>
<tr>
<td>9</td>
<td>Indent Helvetica [front 14 cpi white ribbon]</td>
</tr>
</tbody>
</table>
10  Indent Helvetica [front 14 cpi black ribbon]*

11  Tactile Identifier Mark (refer to Appendix F: "Tactile Identifier Mark Conversion")

* **Note:** Add 20 (decimal) to override default side.

## Emboss/Indent Position

The emboss/indent position indicates the start of the emboss or indent data.

<table>
<thead>
<tr>
<th><strong>horz_offset</strong></th>
<th>Whole number in mils (1/1000 of an inch) from left edge of card to center of first character</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>vert_offset</strong></td>
<td>Whole number in mils (1/1000 of an inch) from bottom edge of card to the vertical midpoint of the characters</td>
</tr>
</tbody>
</table>

The following restrictions apply to the horizontal and vertical offsets.

### Horizontal Offset Limits

<table>
<thead>
<tr>
<th><strong>Topping</strong></th>
<th><strong>Maximum Value</strong></th>
<th><strong>Minimum Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>3025</td>
<td>280</td>
</tr>
<tr>
<td>Off</td>
<td>3275</td>
<td>100</td>
</tr>
</tbody>
</table>

### Vertical Offset Limits

<table>
<thead>
<tr>
<th><strong>Topping</strong></th>
<th><strong>Maximum Value</strong></th>
<th><strong>Minimum Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>860</td>
<td>135</td>
</tr>
<tr>
<td>Off</td>
<td>1460</td>
<td>135</td>
</tr>
</tbody>
</table>

## Emboss Data Restrictions

Embosser data has the following restrictions for the characters allowed.

- The emboss data range is from 20 hex to FF hex.
- Reserved XML characters (3c hex and 3e hex) are not allowed as emboss characters.
- For data greater than 127 ASCII, you must use an escape. For example, use `&#181;` to emboss a Katakana character (B5 hex).
Emboss Example

The embosser escapes define emboss and indent data to produce the following card. The sample card shows the location of each embossed element. The escapes can be placed anywhere on the card design that does not contain data to be printed.

```
~EM%2;401;843;0001 3416 7890 1286
~EM%10;401;650;0001
~EM%1;800;480;2007
~EM%1;1600;480;10/17
~EM%1;401;328;Janice Holloway
```

![Check Card diagram]
**Magnetic Stripe Fonts**

The Card Printer Driver provides fonts to format magnetic stripe data. Use these fonts when magnetic stripe escapes cannot be used.

1. Use the application’s page setup feature to set the paper size to the proper size for your printer, either ISO ID-1 or ISO ID-1 Retransfer. Specify the page margins to match the card design.

2. Format the text and graphics to print on the card.

3. Type the data to encode using a standard font, such as Arial.
   - Use a small font size to minimize the amount of space used for encoded data.
   - Do not put data for two tracks on the same line.
   - Do not allow text to encode to wrap to another line.
   - Data to encode can be on side 1 (front) or side 2 (back) of the card.

4. Add an extra space character to the end of the data.

5. Select a line of data up to, but not including, the extra space character and apply one of the following fonts:
   - Mag Track 1 XPS Card Printer
   - Mag Track 2 XPS Card Printer
   - Mag Track 3 XPS Card Printer
   - Mag Track JIS XPS Card Printer

6. Repeat steps 3 through 5 for each line of text to encode.

7. Send the card to print.

8. Verify that the encoding was successful by passing the card through a card reader.
**Hints & Tips**

- Do not use character formatting, such as kerning.
- Do not use smart quotes. Straight quotation marks are allowed.
- Use a small font size to shorten the lines of text to encode.
- Keep text to print on a different line from text to encode.
- When the Card Printer Driver adds lines of text for the same track, the sequence is determined by the application. Test your application with the Card Printer Driver to make sure that the data is in the correct order.
- Magnetic stripe data sent by the Card Printer Driver is always encoded on side 2 of the card.
- Magnetic stripe data is converted to uppercase letters if needed.
- If characters unsupported by a track format are sent within the magnetic stripe data, the printer displays a message.

If you have an existing application that uses magnetic stripe fonts from older generation printers, the Card Printer Driver recognizes these fonts. If the fonts are not installed on your computer, use the “Legacy Application Support” option on the driver installation Support Files screen to install them. Refer to “Install Support Files” on page 24 for more information.
Chapter 5: Card Printer Driver Troubleshooting

This chapter describes the following:

- Installation Troubleshooting
- Additional USB Troubleshooting on page 149
- Additional Driver Troubleshooting on page 150

Installation Troubleshooting

The Card Printer Driver Installation CD or flash drive is included in the printer shipping carton. You also can download the driver from the Entrust website. Select Menu > Resource Center > Drivers & Downloads. Select your printer model and then select Drivers.

This section describes issues that could prevent a successful installation and provides recommended solutions to those issues. Select from the following topics:

- USB Installation Troubleshooting on page 142
- Network Installation Troubleshooting on page 148
## USB Installation Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The cable is loose.</td>
<td>Reconnect the USB cable to the ports on the PC and the printer. Power the printer off, and then back on. If the PC and printer still do not communicate, restart the PC.</td>
</tr>
<tr>
<td>The data cable is damaged or frayed.</td>
<td>Power off the printer. Replace the cable if you have a spare. Contact your service provider to order a new data cable.</td>
</tr>
</tbody>
</table>
| The system has a temporary communication problem. | Check the following:  
- USB extension cables can cause communication problems. The recommended USB cable is 6-ft. (2 meters) long. Make sure that the cable is rated for USB 2.0 or USB-C (3.0) data transmission.  
- If you are using a USB hub, a self-powered hub is recommended. |
| The card printer does not install when the USB cable is connected. | If a previous printer installation attempt was unsuccessful, Device Manager might still show an entry for the printer. Remove the printer entry from Device Manager before reinstalling the printer:  
1. Disconnect the printer from the PC.  
2. Open the Windows Device Manager.  
3. Locate the device to delete. The device might be called “Unknown device” or it might be located under the Printers or Network Adapters folder. The device might be marked with a yellow question mark or exclamation point.  
4. Select the device, and right-click to display a pop-up menu.  
5. Select **Remove device** from the pop-up menu.  
6. Click **Yes** or **OK** to confirm removal of the device.  
8. Reinstall the printer. |
<p>| Error message states the USB is not detected. | The USB installer timed out before a printer was detected. Remove the Card Printer Driver from the Device Manager before reinstalling the printer. |
| The USB cable is connected before the Card Printer Driver is installed. | The first printer installed on a PC using a USB connection must be installed from the driver CD, from a downloaded Card Printer Driver .exe file, or using the Quick Installer on the flash drive. Connect the USB cable to the printer when you are prompted. Do not connect the cable before starting the installation. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Print Sample Card button is not available.</td>
<td>The Print Sample Card button in Printer Properties is enabled when the printer and Card Printer Driver communicate normally. If Print Sample Card is not available, make sure that <strong>Ready</strong> displays on the printer LCD panel. <strong>Note</strong>: The Print Sample Card button is not available when printer pooling is enabled.</td>
</tr>
<tr>
<td>The PC USB port does not communicate with the printer USB port.</td>
<td>Power management on the PC has shut down USB communication. Check the following:</td>
</tr>
<tr>
<td></td>
<td>• Open the Windows Device Manager and display the list of USB devices. Disable shutdown for each hub in the list. Restart the PC for the changes to take effect, if necessary.</td>
</tr>
<tr>
<td></td>
<td>• Hibernation on a laptop PC requires several moments to enable USB communication. Unplug the USB printer port and then connect it again.</td>
</tr>
<tr>
<td></td>
<td>• Replace the PC port or the PC. Contact your PC or port vendor if you need assistance.</td>
</tr>
<tr>
<td>The printer does not install or print on the PC when the PC is connected to a remote network using VPN Client software.</td>
<td>VPN Client software can prevent the installation and use of other devices. Choose one of the following solutions:</td>
</tr>
<tr>
<td></td>
<td>• Configure your VPN software to allow local network connections.</td>
</tr>
<tr>
<td></td>
<td>• Disconnect the VPN Client software from the network. Then, install the USB printer and Card Printer Driver, or resume printing.</td>
</tr>
<tr>
<td>The USB printer driver fails to install on a PC that had a previous USB driver installed.</td>
<td>The USB printer was not uninstalled correctly. Refer to “Reinstall the XPS USB Card Printer Driver”.</td>
</tr>
<tr>
<td>Installing the Card Printer Driver while printing cards causes printing to fail.</td>
<td>Printing to a USB printer fails with error 505, USB communication issue, if a new network or USB driver install is started while printing cards. Restart the PC to recover. Make sure that all cards have finished printing and there are no print jobs in the print queue before starting a new driver install.</td>
</tr>
</tbody>
</table>
Reinstall the XPS USB Card Printer Driver

The Card Printer Driver requires a USB printer to be plugged in before starting the driver uninstall process. The printer then must be unplugged at the end of the uninstall. The Card Printer Driver uninstall program also requires the PC to be restarted after the uninstall completes. Refer to “Uninstall the Card Printer Driver” on page 63 for complete uninstall instructions.

There may be occasions when it is not possible to complete one, or more, of these steps during the uninstall process. For example:

- The printer is unplugged and temporarily moved to another location
- The printer is not powered on when the uninstall starts

If the USB printer is not plugged in and in **Ready** status prior to running the uninstall, some of the Card Printer Driver support files may not be removed from the PC. If you then attempt to reinstall the same printer to the PC, the USB driver may not install and issue an error.

Use the following procedure to reinstall the USB Card Printer Driver.

- Some of the steps described in this procedure may not apply in all situations. Continue with the procedure to remove the Card Printer Driver files.
- Some of the steps described in this procedure may not apply in all situations. Continue with the procedure to remove the Card Printer Driver files.

1. If the printer is available and **Ready**, plug in the USB cable to the PC.
2. Open the Windows **Devices and Printers** window. If the XPS Card Printer device displays in the window, do the following to remove the device:

   On the **Devices and Printers** window, right-click the icon for the XPS Card Printer and select **Remove device** from the menu. This removes the XPS Card Printer icon from the list of printers. If there are multiple XPS Card Printer icons, do this for each one.

   If the XPS Card Printer Driver icon does not appear in the **Devices and Printers** window, continue with step 3.
3. Right-click in the Devices and Printers window and select **Device Manager**.
4. In the Device Manager window, select **View > Show Hidden Devices**.

5. Expand the **Network Adapters** list. A list of all network adapters installed on the computer displays.
Do one of the following to remove the device:

- If the printer is plugged in to the computer, the **XPS Card Printer High Speed USB Connection** entry displays in the list of network adapters. Right-click the entry and select **Uninstall** (or **Uninstall device**) from the menu.

  The entry may be followed by an exclamation mark or question mark.

  ![Device Manager](image)

  If a confirmation window displays, confirm that you want to delete the device. This uninstalls the device and removes the adapter from the list.

- If the printer is not plugged in to the computer, the **XPS Card Printer High Speed USB Connection** entry does not display in the list of network adapters. Run the XPS Card Printer Uninstall program from the Windows Start menu to remove the driver files.

6. Unplug the printer USB cable from the computer, if it is plugged in.
7. Restart the computer.
8. Install the XPS Card Printer Driver as described in “Install the Driver” on page 9.
## Network Installation Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The network cable is loose.</td>
<td>Reconnect the data cable to the network port and the printer, making sure that it is snapped in. Restart the printer.</td>
</tr>
</tbody>
</table>
| The Status page of Printer Properties shows the printer is not available, but the printer displays **Ready** on the LCD screen. | Follow your network troubleshooting procedures to isolate and test each component of the computer-to-printer communication link. Suggestions:  
  - Check the computer-to-network connection by accessing a network resource, such as a network drive.  
  - Have the network administrator test communication between a server and the printer.  
  - Make sure that the user is logged in to the network. |
| The printer is not configured with the correct network address.          | Make sure that the server name or IP address has been entered correctly in the Port Settings or Configure Port dialog box on the computer. For information about retrieving the printer’s IP address, refer to the card printer’s *User’s Guide*. Make sure that **Ready** displays on the printer’s LCD panel. |
Additional USB Troubleshooting

- If a USB-connected printer is powered on before the computer, the printer may appear as offline and cards sent to the printer do not print. Power on the computer first to prevent this from occurring. To remedy the offline status, unplug the printer's USB cable and then plug it back in.

- A USB-connected printer on a Windows 10 system may be placed in offline status following an update to the Card Printer Driver from a previous version. Do the following to return the printer to online status:
  a. Select Start > Settings > Devices > Printers & Scanners.
  b. Select the XPS Card Printer and click Open Queue.
  c. Click the Printer menu and remove the check mark next to Use Printer Offline.

Update or Uninstall Cannot Complete

The Card Printer Driver occasionally issues a message that it cannot complete an update or uninstall because there are active print jobs. This situation can occur even when all printers have been removed as part of the uninstall. Do the following to resolve the issue.

1. Open a command prompt window. Select Run as administrator when opening the window.
2. Enter the following command:
   ```
   net stop spooler
   ```
   A message displays when the spooler has stopped successfully.
3. Open the C:\Windows\System32\spool\PRINTERS folder on your computer. Delete all files from the folder.
4. In the command prompt window, enter the following command:
   ```
   net start spooler
   ```
   You also can shut down and restart the computer to start the spooler.
   A message displays when the spooler has started.

The Card Printer Driver now can be updated or uninstalled.
Additional Driver Troubleshooting

Messages Linking to Incorrect Printer URL

**Problem:** For all error messages, the driver links to the Sigma version when clicking the **Help** button.

**Solution:** To display help for a other printers, use the flowing URL links and replace the xxx at the end with the corresponding error code.

- To display Sigma printer errors the URL is
  https://www.entrust.com/knowledgebase/hardware/error-code-xxx-14

- To display CD printer errors the URL is
  https://www.entrust.com/knowledgebase/hardware/error-code-xxx

- To display CR printer errors the URL is

- To display CE printer errors the URL is
  https://www.entrust.com/knowledgebase/hardware/error-code-xxx-3

- To display SD printer errors the URL is
  https://www.entrust.com/knowledgebase/hardware/error-code-xxx-8

- To display CL900 printer errors the URL is
  https://www.entrust.com/knowledgebase/hardware/error-code-xxx-2

**Message 100 Request Not Supported**

**Problem:** Message 100 request not supported.

**Cause:** This issue occurs when:

- User has changed the ribbon on printer.
- User has updated the printer IP address on the ports tab.
- User has connected a different printer to the driver.

**Solution:**

- User should open “The Printer Properties Window” on page 41 and select the **Printer Status** tab and click **Ask Printer for Update** to get the latest information from the printer.

- User should open “The Printer Properties Window” on page 41 and select the **Supplies** tab Supplies tab and click **Ask Printer for Update** to get the latest information from the printer.
Advanced Troubleshooting Tools

For additional troubleshooting topics, refer to the printer’s *User’s Guide*.

Printer Manager and the Printer Dashboard also provide additional troubleshooting tools. Refer to the printer’s *Installation and Administrator’s Guide* for information about using Printer Manager, or the Printer Dashboard Help.
Appendix A: Windows Printer Sharing

This appendix provides information about how to install and share the Card Printer Driver on a host and client PC running 64-bit Windows 8.1 or Windows 10.

Installation

Printer sharing involves setting up the host PC for sharing, then installing and setting up the Card Printer Driver on each client system that prints to the printer.

Set Up the Host PC for Printer Sharing

1. Install the XPS Card Printer Driver on the host PC. Refer to “Install the Driver” on page 9.
2. Configure the host PC for printer sharing.
   a. From the Windows Control Panel, select Network and Internet > Network and Sharing Center.
   b. Select Change advanced sharing settings from the left column. The Advanced sharing settings window or the Network profile options display. If the Advanced sharing settings list displays, select the network profile you want to work with.
   c. On the Network profile options page, select the following options (these are the default settings).

<table>
<thead>
<tr>
<th>Field</th>
<th>Select option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network discovery</td>
<td>Turn on network discovery</td>
</tr>
<tr>
<td>File and printer sharing</td>
<td>Turn on file and printer sharing</td>
</tr>
<tr>
<td>Password protected sharing</td>
<td>Turn on password protected sharing</td>
</tr>
</tbody>
</table>

   d. If you selected (turned on) any options in this step, click Save changes. Close the Network and Sharing Center window.
3. Enable printer sharing.
   a. Open the **Devices and Printers** window and right-click the card printer icon. Select **Printer properties** to display the **Printer Properties** window.
   b. Allow printer sharing.
      i. On the **Printer Properties** window, select the **Sharing** tab.
      ii. Select **Share this printer**. The printer name displays in the **Share name** field. Write down the printer name. Refer to “Printer Sharing Requirements” on page 30 for more information about naming the host printer.
      iii. Select **Render print jobs on client computers**.
      iv. Click **Apply** to store these settings.

![Printer Properties Window]

Remember to record the printer name and host PC name. You need these names to install the Card Printer Driver on the client PC. For more about printer names, refer to “Use device naming rules for shared printers” on page 33.

4. Find the full computer name of the host PC and write it down.
   a. From the Windows Control Panel, select **System and Security > System**.
   b. Write down the name of the computer found in the **Full computer name** field on the **System** window.
   c. Close the **System** window.

![System Window]
5. Configure security for sharing printing and viewing print error messages.
   a. From the Printer Properties window, select the Security tab.
   b. Review the Group or user names list. Make sure that the default settings on the Security tab have the following printer-sharing permissions:
      - Everyone has Print permission set to Allow (refer to the figure at right).
      - Only CREATOR OWNER has Manage documents permission set to Allow. This lets the owner both view printer error messages and perform document-related administrator tasks at the PC.
   c. If you made any changes, click Apply to save your updates.
   d. Add users or groups.
      i. From the Security tab, click Add. The Select Users or Groups dialog box displays.
      ii. Click Advanced and then Object Types.
      iii. Select the check boxes for Users and Groups and click OK. The Select Users or Groups dialog box displays.
      iv. Click Find Now. A list of user and group names displays.
      v. Select each name to add and click OK. The name(s) you selected display in the Select Users or Groups dialog box.
      vi. When you finish adding names, click OK. The names display on the Security tab. Each name you added has Print permission.
      vii. If you want to revoke Print permission and prevent a user or group from printing, select the user or group and clear the Allow check box for the Print permission.

Do not select the Manage documents or the Deny check boxes for any user or group. Only the CREATOR OWNER should have Manage documents permission set to Allow, which is the default.
e. Allow users or groups to view printing error messages.
   i. From the Security tab, select a user or group and select Allow for the Manage this printer permission.
   ii. Repeat for each user or group.
   iii. Click Apply to save changes for each name.

6. Configure the host PC printing preferences.
   a. On the Devices and Printers window, right-click the card printer icon and select Printing preferences. The Printing Preferences window displays.
   b. Specify your printing preferences. Refer to “Design Tasks in Windows Printing Preferences” on page 73.
   c. Click OK to close the Printing Preferences window.
Install the Card Printer Driver on the Client PC

The client PC must be running 64-bit Windows 8.1 or Windows 10. Refer to “Printer Sharing Requirements” on page 30 for a list of supported host/client operating system combinations.

The following instructions may vary slightly based on the operating system of the client PC.

1. Make sure that the Card Printer Driver is installed and set up on the host PC.

2. Log on to the client PC with a user account that has administrator privileges and matches an account and password on the host PC.

   - Start at the Login screen of the client PC and review the user names displayed. Look for a user with administrator access that matches a user name on the host PC. If one is not listed, set up a user account and password on the client PC to match an administrator account from the host PC.

   OR

   - Log on to the host PC from the client PC using a network access as follows:
     - Use Windows File Explorer or My Computer to locate the host PC.
     - Select the host PC. The Enter Network Password dialog box displays.
     - Enter your password and click OK. The host PC desktop displays.

   You must log on to the host PC across the network by using a different user account than was used to install the printer on the host.

   After you log on to the host PC using the network, keep the window open until the installation completes.
3. Add the printer to the client PC.
   a. Open the Windows Devices and Printers window.
   b. Select Add a printer. The Add Printer wizard displays.
   c. Select Add a network, wireless or Bluetooth printer.
      The system searches for networked printers and displays the Select a printer page.
   d. Select the printer to which you want to connect.
      If the printer does not display in the list:
      i. Click The printer that I want isn’t listed. The Find a printer by name or TCP/IP address page displays.
      ii. Click Select a shared printer by name.
   e. Enter the name of the host PC and the shared printer name by doing one of the following:
      ♦ Use the names you wrote down during the host PC installation using the format: 
        \host PC name\shared printer name
      ♦ If you don’t have the printer name, enter the host PC name using the format:
        \host PC name\
      When you type the last backslash without a printer name, a list of host printers displays in a drop-down list.
      Select the shared printer from the drop-down list.
f. Click Next. If the Do you trust this printer? dialog box displays, click Install Driver.

Windows installs the Card Printer Driver. The message “You've successfully added printer name” displays when the installation is complete. Click Next.

g. Close any open windows.

h. Click Finish to end the Add Printer wizard.

4. If card production software is installed on this computer, or if you need other support files, such as magnetic stripe fonts, install the Printer Plug-in or support files from the Driver Installation CD. For instructions, refer to “Install Support Files” on page 24.

The Card Printer Driver installs a folder containing several .INI files on the host system (refer to Appendix C: “Using .INI Files with the Card Printer Driver” for complete information about using the .INI files). The folder is not installed automatically on the client system.

Do the following only if you plan to use the .INI files on the client system:
1. Create (or locate) the following folder on the client system:
   C:\ProgramData\Datacard\XPS Card Printer
   **Note:** If you have other Entrust Datacard software applications already installed, the C:\ProgramData\Datacard\ folder may already exist.

2. On the host system, copy the XPS Card Printer folder using the following path:
   C:\ProgramData\Datacard\XPS Card Printer

3. Paste the XPS Card Printer folder in C:\ProgramData\Datacard\ on the client system.

5. Configure the client PC printing preferences.

   a. From the Devices and Printers window, right-click the card printer icon and select Printing preferences. The Printing Preferences window displays.

   b. Specify your printing preferences.

      Refer to “Design Tasks in Windows Printing Preferences” on page 73 for more information.

   c. Click OK to close the Printing Preferences window.
Appendix B: Windows Server Printer Sharing

This appendix provides information about how to install and share the Card Printer Driver on a host PC running a supported Windows Server version (refer to “Supported Operating Systems” on page 1).

Windows Server Installation

Printer sharing involves setting up the host PC for sharing, then installing and setting up the Card Printer Driver on each client system that prints to the printer.

Set Up the Host PC for Printer Sharing

1. Install the XPS Card Printer Driver on the host PC. Refer to “Install the Driver” on page 9.
2. Configure the host PC for printer sharing.
   a. From the Windows Control Panel, select Network and Internet > Network and Sharing Center.
   b. Select Change advanced sharing settings from the left column. The Advanced sharing settings window or the Network profile options display. If the Advanced sharing settings list displays, select the network profile you want to work with.

The Advanced sharing settings display varies depending on a system’s setup. In addition, based on its setup, the system may open one of the profiles and display the options shown in step 2c.

   c. On the network profile options page, select the following options:

   Field                        | Select option
   -----------------------------|-----------------------------
   Network discovery            | Turn on network discovery
   File and printer sharing     | Turn on file and printer sharing
   Password protected sharing   | Turn on password protected sharing

   d. Click Save changes to close the Advanced sharing settings window.
3. Write down the printer name and host PC name.

   Remember to record the printer device name. You need this printer name to install the Card Printer Driver on the client PC.

   a. Display the Devices and Printers window. Select the card printer icon and click Print server properties in the menu bar. The Printer Properties window displays.

   b. Select the General tab on the Printer Properties window to display the printer device name.

   c. Write down the name of the printer.

   d. Display the System properties window for your computer.

   e. Write down the host PC name found in the Full Computer Name field.

   f. Close the System properties window.

4. Enable printer sharing.

   a. Select the Sharing tab on the Printer Properties window.

   b. Click Change Sharing Options. The shaded fields become active.

   c. Select Share this printer.

      Make sure that a printer name displays in the Share name field. Refer to “Printer Sharing Requirements” on page 30 for more information about naming the host printer.

      The printer Share name is assigned by the Windows operating system. This displays as the same printer name (or an abbreviated version of the printer name) you wrote down earlier.

   d. Select Render print jobs on client computers.

   e. Click Apply to apply these settings.
5. Configure security.

Skip this Configure security section if you want to accept the following defaults:
- All users (the Everyone account) can print.
- Only the person who enabled sharing on the printer (the Creator Owner account) can view printer error messages at the client PC.

Users at the client PC can view printer error messages from Windows Print Manager. These printer errors can be resolved at the printer LCD screen or host PC.

For more information, refer to “Security permissions for shared printers” on page 32, and “View messages” on page 32.

a. Select the Security tab on the Printer Properties window.

b. Review the Group or user names list. Do the following to add users to the list.

i. Click Add. The Users or Groups dialog box displays.

![Select Users or Groups dialog box]

ii. Select the name you want to add, and click Add. Repeat for each name you want to add.
iii. If the names or groups do not display in the list, add the names or a group as follows. Repeat for each name you want to add.

- Click **Advanced**. The **Select Users or Groups** dialog box displays.

- Select **Object Types**. The **Object Types** window displays.

- Select **Users**.

- Click **OK**. The **Select Users or Groups** search window displays.

- Click **Find Now**. A list of user names displays in the search results section.

- Select each name you want to add.
– Click OK. The Select Users or Groups window displays the names you selected.

iv. When you finish adding names, click OK to close the Users and Groups dialog box.

C. In the Names list, select the name or group to set up.

Do not select the Manage documents or the Deny check boxes for any user or group. Select Allow for Manage Printer if you want a user or group to view messages.

i. Select Allow for permissions you want to apply to the user or group.

ii. Clear the Allow check box for permissions you want to deny the user or group.

iii. Click Apply to save your changes. Make sure that you save changes for each name.

6. Configure the host PC printing preferences.

a. On the Devices and Printers window, right-click the card printer icon and select Printing preferences. The Printing Preferences window displays.

b. Specify your printing preferences. Refer to “Design Tasks in Windows Printing Preferences” on page 73.

c. Click OK to close the Printing Preferences window.
Install the Card Printer Driver on the Client PC

The client PC must be running 64-bit Windows 8.1 or Windows 10. Refer to “Printer Sharing Requirements” on page 30 for a list of supported host/client operating system combinations.

Differences between operating systems are noted, as needed.

1. Make sure that the Card Printer Driver is installed and set up on the host PC.
   
   Before you log on to the client PC, look for a user account that matches an account on the host PC. If there is no matching user account, set up the user account and password on the client PC.

2. Log in to the client PC with a user account that has administrator privileges and matches an account and password on the host PC.

3. Add the printer to the client PC.
   
   a. Display the Devices and Printers window.
   
   b. Select Add a printer. The Add Printer wizard displays.
   
   c. Select Add a network, wireless, or Bluetooth printer.
      
      The system searches for networked printers and displays the Select a printer page.
   
   d. Select the printer to which you want to connect.
      
      If the printer does not display in the list:
   
      i. Click The printer that I want isn’t listed. The Find a printer by name or TCP/IP address page displays.
   
      ii. Click Select a shared printer by name.
   
   e. Enter the name of the host PC and the shared printer name by doing one of the following:
      
      ♦ Use the names you wrote down during the host PC installation using the format:
        \host PC name\shared printer name
      
      ♦ If you do not have the printer name, enter the host PC name. Use the format:
        \host PC name\

      When you type the last backslash without the printer name, a list of host printers displays in a drop-down list.
      
      Select the shared printer from the drop-down list.
   
   f. Click Next. A series of messages display and you are prompted to install the printer driver.
g. Click **Install driver**. When a message displays that you successfully added the printer, click **Next**.

h. Close any open windows.

i. Click **Finish** to close the wizard. The shared card printer icon displays in the **Devices and Printers** window of the client PC.

4. If card production software is installed on this computer, or if you need other support files, such as magnetic stripe fonts, install the XPS Card Printer Plug-in or support files from the Driver Installation CD. For instructions, refer to “Install Support Files” on page 24.

The Card Printer Driver installs a folder containing several .INI files on the host system (refer to Appendix C: "Using .INI Files with the Card Printer Driver" for complete information about using the .INI files). The folder is not installed automatically on the client system. Do the following only if you plan to use the .INI files on the client system:

1. Create (or locate) the following folder on the client system:
   
   C:\ProgramData\Datacard\XPS Card Printer

   **Note:** If you have other Entrust Datacard software applications already installed, the C:\ProgramData\Datacard\ folder may already exist.

2. On the host system, copy the **XPS Card Printer** folder using the following path:
   
   C:\ProgramData\Datacard\XPS Card Printer

3. Paste the **XPS Card Printer** folder in C:\ProgramData\Datacard\ on the client system.

5. Configure the client PC printing preferences.

   a. From the **Devices and Printers** window, right-click the card printer icon and select **Printing preferences**. The Printing Preferences window displays.

   b. Specify your printing preferences.

      Refer to “Design Tasks in Windows Printing Preferences” on page 73 for more information.

   c. Click **OK** to close the **Printing Preferences** window.
Appendix C: Using .INI Files with the Card Printer Driver

The Card Printer Driver supports several functions through the use of .INI files. This appendix describes how you can modify and use the .INI files to customize the Card Printer Driver.

Card Printer Driver INI Support

The Card Printer Driver installation program installs several .INI files that you can modify. The following .INI files are installed in C:\ProgramData\Datacard\XPS Card Printer\SampleINI:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KMask.INI</td>
<td>Masks cardholder information on the print ribbon K panel.</td>
</tr>
<tr>
<td>KBlock.INI</td>
<td>Defines areas of a card where the K panel is not used to print card data.</td>
</tr>
<tr>
<td>ImageOriginOffset.INI</td>
<td>Adjusts the image origin to align an image on the card.</td>
</tr>
<tr>
<td>MSDisable.INI</td>
<td>Disables the parsing of magnetic stripe escapes in a card design.</td>
</tr>
<tr>
<td>ColorTrap.INI</td>
<td>Creates an overlap of pixels in the color and monochrome images sent to the printer to avoid gaps between the color (CMY) and black (K) areas.</td>
</tr>
<tr>
<td>Rasterization.INI</td>
<td>Improves the font rendering so that all characters print correctly.</td>
</tr>
</tbody>
</table>

If you cannot see the Program Data folder, make sure that the option to show hidden files is selected for your operating system.
To use an .INI file, copy the file from the SampleINI folder to C:\ProgramData\Datacard\XPS Card Printer. Open the file using a text editing program, such as Notepad, and customize the .INI file to meet your requirements. The Card Printer Driver uses the .INI file when it is present in C:\ProgramData\Datacard\XPS Card Printer.

Card Printer Driver best practices recommend that you copy (not move) the .INI file to the XPS Card Printer folder. This maintains the default settings in the original file for reference.

You can copy more than one .INI file to the folder. However, some files are used only for certain printers as noted in the following sections.

The copied file may be flagged as Read-only. If it does not allow you save your changes, right-click the file, select Properties, and clear the Read-only check box.

The following sections describe how to customize and use each of the .INI files.

- Mask K Panel Data on page C-3
- Block K Panel Data on page C-19
- Specify Image Origin Offsets on page C-22
- Disable Magnetic Stripe Escape Parsing on page C-26
- Print Trapping on page C-27
- Use the Rasterization File on page C-33
Mask K Panel Data

- K-panel data masking is supported only on direct-to-card printers.
- K-panel data masking requires the monochrome print resolution to be set to 300 x 300. A print resolution set to 300 x 600 or 300 x 1200 is not supported.

K-panel data masking prevents certain cardholder information, such as the user’s name and account number, from being read from the K panel of a used print ribbon. To do this, the Card Printer Driver makes several copies of the card image that is to be printed using the K panel, then applies a mask to each copy that blocks different portions of the printing on that copy. When all the copies are printed, the card contains the complete image. However, each K panel of the print ribbon contains only a part of the card information. You can use K-panel data masking on both the front and back of the card.

- Because K-panel data masking prints the card information using multiple copies of the card image, it uses several panel sets of the print ribbon.
  - To conserve ribbon, use this feature only with monochrome ribbon. Although it is supported for color ribbon with a K panel, it will use multiple complete panel sets, wasting the color panels.
- K-panel data masking decreases the number of cards that can be printed per roll of ribbon.
- Performance is affected, and can vary depending on the number of masks used.

Internal Masks

The Card Printer Driver contains default internal masks that are designed to mask entire characters wherever possible. The internal masks consist of 2-, 3-, and 5-pass front and back masks that are based on typical cards designs. They are used if no external masks are defined. Refer to “Internal Driver Masks” on page C-11 for images of the internal masks.
External Masks

You also can define your own external masks that are customized for your card design. Because the internal masks are based on typical card designs, they may not meet your needs.

The following default external masks are located in C:\ProgramData\Datacard\XPS Card Printer\bitmaps. Similar to the internal masks, the default external masks are based on typical card designs. You can use these external masks as is, or use them as samples to create your own masks, as needed. For example, you might create a set of front and back 5-pass masks.

The external masks can have any name. Each back side mask uses the same name as the front side mask, with the text Back as part of the name. For example, VisaMask01of02.png and VisaMask01of02Back.png, and so on.

Store the custom masks in the bitmaps folder. Refer to “KMask.INI File Parameters” on page C-6 for complete information about how to modify the .INI file.

Refer to “Create an Image Mask” on page C-12 for information about how to create custom image masks.

<table>
<thead>
<tr>
<th>Number of Masks</th>
<th>Default External Mask Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-Pass Mask</td>
<td>Mask01of02.png</td>
</tr>
<tr>
<td></td>
<td>Mask02of02.png</td>
</tr>
<tr>
<td></td>
<td>Mask01of02Back.png</td>
</tr>
<tr>
<td></td>
<td>Mask02of02Back.png</td>
</tr>
<tr>
<td>3-Pass Mask</td>
<td>Mask01Of03.png</td>
</tr>
<tr>
<td></td>
<td>Mask02Of03.png</td>
</tr>
<tr>
<td></td>
<td>Mask03Of03.png</td>
</tr>
<tr>
<td></td>
<td>Mask01Of03Back.png</td>
</tr>
<tr>
<td></td>
<td>Mask02Of03Back.png</td>
</tr>
<tr>
<td></td>
<td>Mask03Of03Back.png</td>
</tr>
</tbody>
</table>

The internal masks are used if external masks are not available, if they are not configured for the card design (for example, by using escapes), or if there is an error in the .INI file setup.
How a Mask Works

Each mask is a 638 x 1013, 1 bit per pixel (bpp) black-and-white PNG image. Card data that lies under a black mask pixel prints on the card.

The mask design is for a landscape-orientation card. However, the images have a portrait-orientation, because that is the orientation expected by the printer.

The following images illustrate how a data mask works.
KMask.INI File Parameters

The driver creates the extra K panel images and applies the masks when the KMask.INI file is present in C:\ProgramData\Datacard\XPS Card Printer and the parameters MaskKPanel and MaskKBackPanel are set to 1.

The KMask.INI file that is installed has the following format.

[AllPrintersFlags]
MaskKPanel=1
MaskKBackPanel=1
UseExternal=1
MaxBitmapCount=3
Ext01of02=Mask01of02.png
Ext02of02=Mask02of02.png
Ext01of03=Mask01Of03.png
Ext02of03=Mask02Of03.png
Ext03of03=Mask03Of03.png

[GoldCard]
Ext01of02=01of02.png
Ext02of02=02of02.png
Ext01of03=VertStripe_0001.png
Ext02of03=VertStripe_0002.png
Ext03of03=VertStripe_0003.png
Ext01of05=01of05.png
Ext02of05=02of05.png
Ext03of05=03of05.png
Ext04of05=04of05.png
Ext05of05=05of05.png

[blueCard]
Ext01of02=01of02.png
Ext02of02=02of02.png
Ext01of03=VertStripe_0001.png
Ext02of03=VertStripe_0002.png
Ext03of03=VertStripe_0003.png
Ext01of05=01of05.png
Ext02of05=02of05.png
Ext03of05=03of05.png
Ext04of05=04of05.png
Ext05of05=05of05.png

[MultiInputHopper_1]
Ext01of02=Mask01of02.png
Ext02of02=Mask02of02.png
Ext01of03=Mask01Of03.png
Ext02of03=Mask02Of03.png
Ext03of03=Mask03Of03.png
Use a text editor to edit the KMask.INI file, as needed, to use the internal or external mask images.

[AllPrintersFlags]—The items in this section are used by all printers or are the default values for printers that do not have their own section.

- **MaskKPanel** or **MaskKBackPanel**—Specify whether you want to use K panel data masking on the front (MaskKPanel) and back (MaskKBackPanel) of the card:
  - **0** = Disable
  - **1** = Enable

- You can specify the following mask options:
  - Mask front only
  - Mask back only
  - Mask front and back

Refer to “KMash.INI Examples” on page C-10.

- Mask escapes override this setting. Refer to “K Panel Mask Escape” on page C-10.

- **UseExternal**—Specify if you want to use external mask images stored in the bitmaps subdirectory: C:\ProgramData\Datacard\XPS Card Printer\bitmaps.
  - **0** = Use internal masks
  - **1** = Use external masks

  If the **UseExternal** setting is missing or has any value other than **1**, the internal default mask images are used. The internal masks also are used if the external masks are not available or if there is an error in the .INI file setup.

- **MaxBitmapCount**—The maximum number of masks to use. The default value is 3. You can specify 2, 3, or 5. The driver randomly uses a set of 2, 3, or 5 masks, up to the maximum, depending on the value specified. For example, if **MaxBitmapCount** is set to 3, the driver may use 2 masks when masking the K panel for one card, then use 3 masks for the next card.

  You do not need to add the back side mask names to the KMask.INI file. The Card Printer Driver uses the correct back side masks from the bitmaps folder if **MaskKBackPanel=1**.

The following external mask files are used when a 2-pass mask is selected by the driver. Each image mask must be a 1 bpp black-and-white PNG file.

- **Ext01of02**—Specify the name of the first of two image masks to use.
- **Ext02of02**—Specify the name of the second of two image masks use.
The following external mask files are used when a 3-pass mask is selected by the driver. Each image mask must be a 1 bpp black-and-white PNG file.

- **Ext01of03**—Specify the name of the first of three image masks to use.
- **Ext02of03**—Specify the name of the second of three image masks to use.
- **Ext03of03**—Specify the name of the third of three image masks to use.

The following external mask files are used when a 5-pass mask is selected by the driver. Each image mask must be a 1 bpp black-and-white PNG file.

- **Ext01of05**—Specify the name of the first of five image masks to use.
- **Ext02of05**—Specify the name of the second of five image masks to use.
- **Ext03of05**—Specify the name of the third of five image masks to use.
- **Ext04of05**—Specify the name of the fourth of five image masks to use.
- **Ext05of05**—Specify the name of the fifth of five image masks to use.

**[GoldCard]/[blueCard]**—The masks in these sections are used for a card that has the escape text `~KM%Name?` as part of the card design. The mask images defined in this section are used instead of the mask images in the [AllPrintersFlags] section. Edit the mask files specified in the section to meet your card design needs. You can add multiple sections and specify the names of the mask files to use, based on the card design.

**[MultiInputHopper_X]**—Use these sections to specify the set of masks to use based on the input hopper number (for multi-hopper systems), where X=1–6. You can specify the input hopper using an escape (refer to “Input Hopper Selection Escape” on page 129), select the input hopper using the Printing Preferences window (refer to “Input Hopper” on page 92), or by using the SDK. The masks specified in the MultiInputHopper_X section then are used.

If external masks are enabled (**UseExternal=1**), the Card Printer Driver uses the following sequence to determine which masks to use.

1. If a mask escape is specified and there is a matching section in the .INI file, use the images specified in that section. If the external masks are not available, or there is an error in the escape text or the .INI file setup, the default internal masks are used.
2. If a hopper number is specified and it has a matching section in the .INI file, use the images specified in that section.
3. Use the default external mask images if they are specified in the .INI file.
4. Use the internal mask images.
KMask.INI Examples

The following setup examples illustrate how the Card Printer Driver applies the KMask.INI settings depending on the values specified in the [AllPrintersFlags] section.

```
[AllPrintersFlags]
MaskKPanel=1
MaskKBackPanel=1
UseExternal=1
MaxBitmapCount=3
```

<table>
<thead>
<tr>
<th>MaskKPanel=1</th>
<th>MaskKBackPanel=0</th>
<th>Mask the front and back of the card using the front masks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>MaskKPanel=1</td>
<td>MaskKBackPanel=1</td>
<td>Mask the card front using the front masks. Mask the card back using the back masks.</td>
</tr>
<tr>
<td>MaskKPanel=0</td>
<td>MaskKBackPanel=1</td>
<td>No masks are applied to the card. Masking the card back only is not supported.</td>
</tr>
<tr>
<td>MaskKPanel=0</td>
<td>MaskKBackPanel=0</td>
<td>No masks are applied to either the front or back of the card.</td>
</tr>
</tbody>
</table>

K Panel Mask Escape

You can enter an escape as part of your card design to specify the masking images to use. The syntax for the K panel mask escape is `~KM%Name?`, where:

- `~` Indicates the start of the escape.
- `KM` Identifies the escape as a K panel mask escape.
- `%` Indicates the start of the mask values.
- `Name` Specifies the external image masks to be used. When the KMask.INI file is installed, it includes two sample sections ([GoldCard] and [blueCard]) that illustrate how to specify the files to use with an escape. You can edit the names of the sample sections and the names of the mask files to use. You also can add multiple sections, based on your card design.
- `?` Indicates the end of the escape.

Examples:

```
~KM%xGoldCard? | Use the masks specified in the [GoldCard] section. |
~KM%blueCard? | Use the masks specified in the [blueCard] section. |
~KM%MultiInputHopper_4? | Use the masks specified in the [MultiInputHopper_4] section. |
```
Internal Driver Masks

The following illustrations show the internal 2-, 3-pass, and 5-pass K-panel masks stored in the Card Printer Driver. The masks are based on a sample card design. The internal masks are used if external masks are not specified.

Two-Pass Masks

Front Panel Masks

Pass 1 of 2
Prints other black card elements

Pass 2 of 2

Back Panel Masks

Pass 1 of 2
Prints other black card elements

Pass 2 of 2

Three-Pass Masks

Front Panel Masks

Pass 1 of 3
Prints other black card elements

Pass 2 of 3

Pass 3 of 3

Back Panel Masks

Pass 1 of 3
Prints other black card elements

Pass 2 of 3

Pass 3 of 3

Five-Pass Masks

Front Panel Masks

Pass 1 of 5
Prints other black card elements

Pass 2 of 5

Pass 3 of 5

Pass 4 of 5

Pass 5 of 5

Back Panel Masks

Pass 1 of 5

Pass 2 of 5
Prints other black card elements

Pass 3 of 5

Pass 4 of 5

Pass 5 of 5

Create an Image Mask

K panel data masking requires a set of mask images that are aligned to the card design so that the characters positioned under a black rectangle print and characters under a white rectangle do not print. When all the masks in a set are applied sequentially to the same card image, each character is “unmasked” by one of the masks.

One mask in the set also prints all the non-secure information in addition to some of the secure information.

You may need to create your own image masks based on your card design. The internal masks stored in the Card Printer Driver are based on a typical card design, which may not meet your needs.
Do the following to create a set of image masks that are appropriate to your card design.

The following examples describe creating 2- and 3-pass image masks for the front of a card. Follow a similar procedure to create 5-pass image masks, and 2-, 3-, and 5-pass masks for the card back.

1. Install an image editing program that can draw color rectangles, swap colors, and save images as 1 bpp PNG images. (The examples in this section use the image editor that is bundled with the Snagit screen capture tool.)

2. Using the graphics editor, open the 638 x 1013 pixel card image that represents the card design you plan to mask.

You can get a correctly sized image by printing the card design to a file. Refer to Appendix D: “Print to a File with the XPS Card Printer Driver” for complete information.

Continue with “Two-Pass Mask” on page C-14 or “Three-Pass Mask” on page C-16, depending on your requirements.
Two-Pass Mask

1. In the open card image file, draw red rectangles around random characters.

2. Remove the black text by doing a color substitution of black to white. This removes the black text by converting it to white.

3. Save two copies of this image: Mask01of02.png and Mask02of02.png.
4. Open Mask01of02.png in the graphics editor and do the following color substitutions in order:
   a. White to Black
   b. Red to White

   The image after the substitutions looks as follows (everything under black will print):

   ![Mask01of02]

5. Save the image, Mask01of02 as a 1 bit per pixel (bpp), 2-color png image.

6. Open Mask02of02.png in the graphics editor and do the color substitution red to black.

   The resulting image looks as follows (this is the inverse of Mask01of02.png):

   ![Mask02of02]

7. Save the image, Mask0 2of02 as a 1 bpp (2-color) png image.
8. Rename the mask image files, as needed.

   The masks can vary depending on the card design. Rename the masks as appropriate for your design.

Three-Pass Mask

A three-pass mask uses a similar process to the two-pass mask, with the printable areas divided among three images.

1. In the open card image file, draw red or green rectangles around random characters.

2. Remove the black text by doing a color substitution of black to white. This removes the black text by converting it to white. Refer to step 2 in “Two-Pass Mask” on page C-14.

3. Save three copies of the image: Mask01of03.png, Mask02of03.png, and Mask03of03.png.
4. Open Mask01of03.png in the graphics editor and do the following color substitutions in order:
   a. White to Black
   b. Red to White
   c. Green to White
   The image after the substitutions looks as follows (everything under black prints on the card):

   ![Mask01of03](image)

5. Save the image, Mask01of03 as a 1 bpp (2-color) png image.

6. Open Mask02of03.png in the graphics editor and do the following color substitution:
   a. Red to Black
   b. Green to White
   The resulting image looks as follows (this is the inverse of Mask01of03.png):

   ![Mask02of03](image)
7. Save the image, Mask02of03 as a 1 bpp (2-color) png image.

8. Open Mask03of03.png in the graphics editor and do the following color substitution:
   a. Red to White
   b. Green to Black

   The resulting image looks as follows (this is the inverse of Mask01of03.png):

   ![Image](image_url)

9. Save the image, Mask03of03, as a 1 bpp (2-color) png image.

10. Rename the mask image files, as needed.

    The masks can vary depending on the card design. Rename the masks as appropriate for your design.
Block K Panel Data

- The settings in the KBlock.INI file apply only when you print to a direct-to-card printer.
- The Print black image pixels using monochrome printing preference must be set to On for the .INI file to be used.

You can define areas of a card where the K panel is not used to print the card data. For example, when you specify the Card Printer Driver printing preference Print black image pixels using monochrome, it can increase the print quality of a bar code, but can cause splotches to appear in photographs (refer to “Print Black Image Pixels Using Monochrome” on page 85).

KBlock.INI File Parameters

The KBlock.INI file parameters define a rectangular area where the K panel is not used. Any black pixels in the card design that fall within the defined area are not printed using the K panel but are printed using the color panels of the ribbon.

The KBlock.INI file has the following format:

```
[PreventKPrintFront]
Left=0
Top=0
Right=0
Bottom=0
colorExtractGrayThreshold=6

[PreventKPrintBack]
Left=0
Top=0
Right=0
Bottom=0
colorExtractGrayThreshold=6
```

You can use the .INI file parameters to prevent K panel printing on the front and back sides of the card. A value of 0 in the Left, Top, Right, and Bottom parameters means that no K panel blocking occurs and printing with the K panel is allowed.

- **Left**—The x-coordinate of the upper-left corner of the rectangle, measured from the left edge of a portrait-oriented card.
- **Top**—The y-coordinate of the upper-left corner of the rectangle, measured from top edge of a portrait-oriented card.
- **Right**—The x-coordinate of the lower-right corner of the rectangle, measured from the left edge of a portrait-oriented card.
- **Bottom**—The y-coordinate of the lower-right corner of the rectangle, measured from top edge of a portrait-oriented card.
- **colorExtractGrayThreshold**—The printing threshold used for K panel printing. A higher value means that the K panel prints darker. Very high values can prevent bar codes from being read. The default value is 6.

The Left, Top, Right, and Bottom parameter values are defined in millimeters (mm) and are relative to a card with a portrait orientation.

If the card design has a landscape orientation, calculate the values after rotating the card to the right 90 degrees (refer to the example on the following page).

### Block K Panel Examples

The following illustration shows how to specify the area to be blocked. The red circle in the top left corner of the image refers to the **Left** and **Top** coordinates in the KBlock.INI file. The purple circle in the bottom right corner of the image refers to the **Right** and **Bottom** coordinates. Any black pixels inside the white rectangle defined by the coordinates do not print with the K panel.

```
[PreventKPrintFront]
Left=17.78
Top=58.42
Right=38.1
Bottom=76.2
colorExtractGrayThreshold=10
```

```
[PreventKPrintBack]
Left=0
Top=0
Right=0
Bottom=0
colorExtractGrayThreshold=6
```
The following illustration shows how you rotate a landscape card to specify the non-printing coordinates.

[PreventKPrintFront]
Left=17.78
Top=7.0
Right=35.56
Bottom=24.0
colorExtractGrayThreshold=10

[PreventKPrintBack]
Left=0
Top=0
Right=0
Bottom=0
colorExtractGrayThreshold=6
Specify Image Origin Offsets

The settings in the ImageOriginOffset.INI file apply only when you print to a retransfer card printer from an application that does not support the ISO ID-1 Retransfer paper size. Refer to the printer’s *Installation and Administrator’s Guide* for a complete discussion of image size on a retransfer card printer.

Some older ID personalization applications, such as ID Works or IDCentre, were designed to support direct-to-card printers, such as the SD360 or CD800. Because a retransfer card printer uses a larger, over-the-edge image size, cards printed from these applications do not cover the entire card surface. This can leave a 1.5 mm white edge on the trailing edges of the card (the bottom and right edges for a landscape card).

The Card Printer Driver supports printing from these applications by adjusting the image origin to better align the image on the card. The Card Printer Driver automatically offsets the image by 37 pixels on the x axis and 34 pixels on the y axis, based on an origin point at the upper left corner of the image. The ImageOriginOffset.INI file allows you to fine-tune these default image origin settings.

In the Card Printer Driver, select the **ISO ID-1 (85.60 x 53.98)** paper size from the *Printing Preferences > Layout > Advanced* window. The driver then aligns the card image over the card so that it prints properly on a retransfer card printer.
ImageOriginOffset.INI File Parameters

You can change the image offset values (the amount that the image is adjusted) using the ImageOriginOffset.INI file to fine-tune the image origin on the card. The values entered in the INI file are applied to the defaults in the Card Printer Driver. The ImageOriginOffset.INI has the following format:

[ImageOriginOffset]

XOriginPixelOffset=-5
YOriginPixelOffset=5

- **XOriginPixelOffset**—Specify the number of pixels to shift the image origin along the x axis. This value is added to, or subtracted from, the default x offset of 37 pixels.
- **YOriginPixelOffset**—Specify the number of pixels to shift the image origin along the y axis. This value is added to, or subtracted from, the default y offset of 34 pixels.

Enable Printing from ID Works and IDCentre

Do the following to print to a retransfer card printer from ID Works or IDCentre:

1. Install the XPS Card Printer Driver, version 7.3.649-D2 or newer.
2. Install the XPS Card Printer Plug-in from the Driver support options window of the Card Printer Installation file. Refer to “Install Support Files” on page 24 for complete information.
3. Assign the XPS Card Printer Plug-in to the retransfer card printer. Follow the instructions in the Datacard® XPS Card Printer Plug-in User’s Guide. The guide is installed as part of the Plug-in install.
4. Select **ISO ID-1 (85.60 x 53.98 mm)** as the paper size in the printer’s **Printing Preferences > Layout > Advanced Options** window. Refer to “Paper Size” on page 76 for complete information.
5. Modify the print blocking areas as described in “Print Blocking Areas in ID Works and IDCentre” on page C-24.
Print Blocking Areas in ID Works and IDCentre

ID Works and IDCentre have predefined areas that prevent printing over a contact smart card chip and magnetic stripe. Because these areas are sized and positioned for a direct-to-card printer, you must modify them before printing to a retransfer card printer.

The settings in these applications override the Card Printer Driver settings. You must modify the blocking areas in the application for each project’s card design to allow proper print blocking on the retransfer card printer.

Smart Card Chip Blocking Areas

The required smart card chip blocking area for a retransfer card printer is smaller than that for a direct-to-card printer. You must adjust the position and size of the blocking area to align properly with the chip when the image prints on the retransfer printer.

- If you do not adjust the smart card field position and size, the retransfer card printer leaves a white rectangle around the chip, similar to a direct-to-card printer. The area around the chip also may contain material that can easily scratch off the card.
- Contactless chip cards do not require an adjustment.

Do the following to adjust the smart card chip size and position for a retransfer card printer.

The dimensions shown below are for a typical smart card chip size and location. You may need to make additional adjustments based on your card stock.

1. Open the ID Works or IDCentre Designer and open the properties for each smart card contact chip field in the project.

2. For a landscape card, change the smart card field **Position** and **Size** values to the following:

   - **Left**: 0.3542 inches
   - **Top**: 0.7188 inches
   - **Width**: 0.4792 inches
   - **Height**: 0.4167 inches

3. Click **OK** to save the changes,

4. Print a card and confirm that the non-printed rectangle falls just inside the edges of the chip. You may need to print several test cards to confirm that the blocking area is positioned properly.

Refer to your printer’s *Installation and Administrator’s Guide* for complete information about smart card non-printing areas for the retransfer card printer.
Magnetic Stripe Blocking Areas

The ink ribbon used by a retransfer card printer can include a back-side inhibitor panel or peel-off that blocks printing over the magnetic stripe. Because the predefined print blocking area for a magnetic stripe in ID Works or ID Centre is sized and positioned for a direct-to-card printer, printing is blocked over an area that is slightly wider than the magnetic stripe. To print to the edge of the magnetic stripe, you must adjust the size and position defined by the magnetic stripe field.

Do the following to adjust the size and position of the magnetic stripe field for the retransfer card printer.

- Open the ID Works or IDCentre Designer and open the properties for each magnetic stripe field in the project.
- For a landscape card, change the magnetic stripe field's **Position** and **Size** values to the following:
  - Top: 0.1979 inches
  - Height: 0.4479 inches
- Click **OK** to save the changes
- Print a card and confirm that the non-printed rectangle falls just inside the edges of the stripe. Make additional adjustments, if needed.

Refer to your printer’s *Installation and Administrator’s Guide* for complete information about magnetic stripe non-printing areas for the retransfer card printer.
Disable Magnetic Stripe Escape Parsing

Some organizations use the tilde (˜) symbol in their magnetic stripe data. However, the Card Printer Driver uses the tilde to indicate the beginning of a magnetic stripe escape. The MSDisable.INI file disables the parsing of magnetic stripe escapes, preventing the Card Printer Driver from identifying the data as an escape. This allows the tilde to be encoded in the magnetic stripe data.

The MSDisable.INI file has the following format:

```
[Magstripe]
disableMagstripeParsing=1
```

When the MSDisable.INI file is present in C:\ProgramData\Datacard\XPS Card Printer, magnetic stripe data containing the tilde is not interpreted as an escape.

- MSDisable.INI does not disable the following:
  - Magnetic stripe fonts (refer to “Magnetic Stripe Fonts” on page 138).
  - The magnetic stripe API used by the Card Printer Driver SDK (refer to the Windows XPS Driver SDK Programmer’s Reference Guide).

- MSDisable.INI does disable the following:
  - Magnetic stripe encoding on the Print Mag Stripe Test Card, though the card prints normally (refer to “Print a Driver Sample Card” on page 52).
  - Magnetic stripe encoding from the ID Works application.
Print Trapping

- The settings in the ColorTrap.INI file apply only when you print to a retransfer card printer.
- The Print black image pixels using monochrome printing preference must be set to On for the .INI file to be used. Refer to “Print Black Image Pixels Using Monochrome” on page 85 for information about how retransfer printers separate color and black image pixels.

The ColorTrap.INI file allows you to fine-tune the print trapping process. Use it to change the parameter values used for print trapping if the default values do not produce acceptable print quality.

ColorTrap.INI File Parameters

The ColorTrap.INI file has the following format:

```
[ColorTrapFront]
colorPixelSpread=2
monoPixelSpread=1
grayscaleVariance=1
whiteThreshold=255
colorTrapDirection=L
monoTrapDirection=R
spreadGradient=0
colorToGrayAlgorithm=0

[ColorTrapBack]
colorPixelSpread=2
monoPixelSpread=1
grayscaleVariance=1
whiteThreshold=255
colorTrapDirection=L
monoTrapDirection=R
spreadGradient=0
colorToGrayAlgorithm=0
```

The values in the .INI file are the default values used by the Card Printer Driver when you select Print black image pixels using monochrome.
Use the .INI file parameters to modify the print trapping values for the front and back sides of the card.

- **colorPixelSpread**—The number of gray pixels that can overlap onto the color image. For example, the default value of 2 looks for gray pixels that are two pixels out from the pixel being evaluated and adds them to the color image. The allowed range is between 0 and 5 pixels.

  | colorPixelSpread=2 | Fewer color pixels extend into the white area. |
  | colorPixelSpread=5 | More color pixels extend into the white area. |

- **monoPixelSpread**—The number of color pixels that can overlap onto the monochrome image. For example, the default value of 1 looks for color pixels that are one pixel out from the pixel being evaluated and adds them to the monochrome image. The allowed range is between 0 and 5 pixels.

- **grayscaleVariance**—The RGB value difference between pixels that are considered to be gray. The larger the value, the more pixels are considered to be gray and are placed on the monochrome image. The allowed range is between 0 and 20.

  | grayscaleVariance=0 | No gray pixels are moved to the monochrome image. |
  | grayscaleVariance=5 | More gray pixels are identified and moved to the monochrome image. The color image has very few gray pixels. |
• **whiteThreshold**—The threshold RGB value of what is considered to be a white pixel. A value of 255 is considered pure white. The lower the threshold value, the more pixels are considered to be white. The range is from 0 to 255.

<table>
<thead>
<tr>
<th>whiteThreshold=255</th>
<th>All gray pixels are excluded.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="whiteThreshold=255" alt="Image" /></td>
<td><img src="whiteThreshold=255" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>whiteThreshold=200</th>
<th>More pixels are considered to be white (a white line goes through the star).</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="whiteThreshold=200" alt="Image" /></td>
<td><img src="whiteThreshold=200" alt="Image" /></td>
</tr>
</tbody>
</table>

• **colorTrapDirection**—The direction in which adjacent gray pixels are evaluated and added to the color image. The directions are Left (L), Right (R), Up (U), and Down (D). The default value L (Left) is used if the value specified is not valid.

• **monoTrapDirection**—The direction in which adjacent color pixels are evaluated, converted to gray, and added to the monochrome image. The directions are Left (L), Right (R), Up (U), and Down (D). The default value R (Right) is used if the value specified is not valid.

<table>
<thead>
<tr>
<th>monoTrapDirection=R</th>
<th>The monochrome pixels are spread to the right.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="monoTrapDirection=R" alt="Image" /></td>
<td><img src="monoTrapDirection=R" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>monoTrapDirection=L</th>
<th>The monochrome pixels are spread to the left.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="monoTrapDirection=L" alt="Image" /></td>
<td><img src="monoTrapDirection=L" alt="Image" /></td>
</tr>
</tbody>
</table>
• **spreadGradient**—The gradient applied to the image to pixels so that they fade to white the further they get from the color or monochrome edge. Edge borders are more distinct when no spread gradient is applied. Possible values are:

<table>
<thead>
<tr>
<th>Value</th>
<th>Algorithm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>None</td>
<td>No gradient is generated.</td>
</tr>
</tbody>
</table>
| 1     | Linear    | Modifies each pixel using the following:  
1. Takes the difference from true white of each component of the current pixel's color.  
2. Multiplies that value by a percentage determined by how many physical pixels away the current pixel is from a true white (255,255,255) pixel.  
3. Continues until the current pixel is true white. |
| 2     | FastToWhite | Similar to the Linear algorithm (spreadGradient=1), but faster. It modifies each pixel by doing the following:  
1. Takes the difference from true white of each component of the current pixel's color.  
2. Divides that value by the square of the current pixel's position between the original color and true white.  
3. Continues until the current pixel is true white. |

The following shows the difference when using a spreadGradient of 0 (None) and 1 (Linear).

- **spreadGradient=0**  
  ![Image 1](null)  
  The inner and outer edge borders are more distinct when no spread gradient is applied.

- **spreadGradient=1**  
  ![Image 2](null)  
  The borders are less distinct when a gradient is applied.
- **colorToGrayAlgorithm**—The color-to-gray conversion method to use. Each method uses a different algorithm to convert the color pixels to grayscale. The algorithms use the following values to determine the color-to-gray conversion:

  
P
  Current pixel color

  PR, PG, PB
  Current pixel RGB component

  WR, WG, WB
  Color weight constant, where:
  - WR = 0.299
  - WG = 0.587
  - WB = 0.114

Specify one of the following:

<table>
<thead>
<tr>
<th>Value</th>
<th>Algorithm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Luma_BT601</td>
<td>Calculates the largest integer value not larger than the sum of each color component by respective weight. This is the default value. It is used if the value specified is not valid. Algorithm: ( \text{floor}(\text{PR} \times \text{WR}) + (\text{PG} \times \text{WG}) + (\text{PB} \times \text{WB})) )</td>
</tr>
<tr>
<td>1</td>
<td>Luma_BT709</td>
<td>Calculates the largest integer value not larger than the sum of each color component using a special weighting. Algorithm: ( \text{floor}(\text{PR} \times 0.2126) + (\text{PG} \times 0.7152) + (\text{PB} \times 0.0722)) )</td>
</tr>
<tr>
<td>2</td>
<td>AverageDesaturation</td>
<td>Takes the strongest and weakest RGB component of a pixel and uses the average of the two. Algorithm: ( (\text{max(PR, PG, PB) + min(PR, PG, PB)}) / 2 )</td>
</tr>
<tr>
<td>3</td>
<td>MaxDecomposition</td>
<td>Takes the strongest RGB component of a pixel. Algorithm: ( \text{max(PR, PG, PB)} )</td>
</tr>
<tr>
<td>4</td>
<td>MinDecomposition</td>
<td>Takes the weakest RGB component of a pixel. Algorithm: ( \text{min(PR, PG, PB)} )</td>
</tr>
<tr>
<td>5</td>
<td>GrayAverage</td>
<td>Takes the average of all RGB components of a pixel. Algorithm: ( (\text{PR} + \text{PG} + \text{PB}) / 3 )</td>
</tr>
<tr>
<td>Value</td>
<td>Algorithm</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>6</td>
<td>MaxBlueGreen</td>
<td>Uses the average of the green and blue components of a pixel. Algorithm:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(PG + PB) / 2</td>
</tr>
<tr>
<td>7</td>
<td>MaxGreenRed</td>
<td>Uses the average of the green and red components of a pixel. Algorithm:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(PR + PG) / 2</td>
</tr>
<tr>
<td>8</td>
<td>MaxBlueRed</td>
<td>Uses the average of the blue and red components of a pixel. Algorithm:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(PR + PB) / 2</td>
</tr>
<tr>
<td>9</td>
<td>FromRed</td>
<td>Uses only the red component of a pixel. Algorithm: (PR)</td>
</tr>
<tr>
<td>10</td>
<td>FromBlue</td>
<td>Uses only the blue component of a pixel. Algorithm: (PB)</td>
</tr>
<tr>
<td>11</td>
<td>FromGreen</td>
<td>Uses only the green component of a pixel. Algorithm: (PG)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>colorToGrayAlgorithm=0</th>
<th>The circle border is lighter.</th>
</tr>
</thead>
<tbody>
<tr>
<td>colorToGrayAlgorithm=1</td>
<td>The circle border is darker.</td>
</tr>
</tbody>
</table>
Print Trapping Considerations

- If you enter a numerical parameter value that is outside of the allowed range, the Card Printer Driver uses the nearest maximum or minimum value. For example, if the allowable values range from 0 to 5, and you specify a value of 6, the Card Printer Driver uses the maximum allowable value of 5. An error message is not issued to indicate that the parameter value is not valid.

- The colorTrapDirection, monoTrapDirection, and colorToGaryAlgorithm parameters use the default value if you specify a value that is not valid.

- Print trapping increases the card processing time. Because the process examines every pixel and its surrounding pixels, it makes the Card Printer Driver perceptibly slower.

- When the .INI file is present in C:\ProgramData\Datacard\XPS Card Printer, the Card Printer Driver uses the .INI file settings for all retransfer card printers installed on the computer.

- You may need to print multiple test cards to determine the best settings for your card design.

- Different card designs may require different settings.

Use the Rasterization File

The RasterizationConverter.INI file improves the font rendering so that all characters print correctly. The RasterizationConverter.INI file is supported only on direct-to-card printers connected to systems running Windows 10.

When the Card Printer Driver is installed on a Windows 10 computer, the driver always uses the Windows 10 rasterizer. The RasterizationConverter.INI file uses the Windows 10 rasterizer to improve monochrome font rendering at all resolutions supported by the printer so that all characters print correctly.

The RasterizationConverter.INI file has the following format:

```
[Rasterization]
1BppDitherThreshold=220
```

Where 1BppDitherThreshold-Specifies how dark to print the black text. Valid values are 0-255. The higher the value, the darker the black text prints.
The RasterizationConverter.INI file does not need to be in `C:\ProgramData\Datacard\XPS Card Printer` to use the Windows 10 rasterizer. However, the Card Printer Driver uses a default value of 220 for the 1BppDitherThreshold setting. If you require a different value for the setting, do the following:

a. Copy the RasterizationConverter.INI file to `C:\ProgramData\Datacard\XPS Card Printer`.

b. Edit the RasterizationConverter.INI file and change the 1BppDitherThreshold value.

c. Save the file with your changes.
You can “print” without having a printer attached using the XPS Card Printer Driver. The result is a zip file that contains the PNG images that normally would be sent to the printer.

The following procedure is supported only for direct-to-card printers.

Do the following to print a card job to a file.

1. Create a folder to hold the files (for example: D:\Temp\DriverPrintFiles). This folder is used in step 3iii.

2. Install a network printer (if not already installed). Use the XPS Card Printer installation instructions to install a network printer, if necessary. When the Configure Port window displays, follow the instructions in Step 3.

3. Create and assign the printer to a local port. If you are installing a new printer, the installation displays the Ports tab on the Printer Properties window. If a printer is installed already, open the Printer Properties window for the printer and click the Ports tab.

   a. Create a new local port:

      i. Click Add Port.

      ii. Select Local Port and click New Port.

      iii. Enter the path to the folder you created in step 1 and add the file name: pages.zip. For example: D:\Temp\DriverPrintFiles\pages.zip.
b. Assign the printer to the new local port. The new local port is selected automatically.
   i. Click **Apply**. The screen resembles the following.

   ![Printer Properties Window](image)

   i. Click **OK** to close the Printer Properties window.

4. Send the print job to the printer, as usual. After printing, open the folder created. A list of files similar to the following displays:

   ![File List](image)
5. Inspect the printer-ready image files. Unzip the job you want to inspect. A list of files similar to the following displays:

![File List Example]

If you encoded magnetic stripe data, the list includes an additional XML file containing that data formatted for the printer.
Appendix E: Silent Install and Driver Utility Commands

Organizations may find it convenient to install, update, or uninstall the XPS Card Printer Driver using an unattended process. The unattended, or silent, process does not require user interaction and does not display any messages or windows in a user interface.

The Card Printer Driver provides two command files that allow you to install, update, or uninstall the driver:

- SilentInstall.cmd
- DriverUtility.cmd

The XPS Card Printer Driver silent process does not support the following:

- Printer sharing
- Printer pooling
- Downgrading the Card Printer Driver to a previous version

Prepare the Files

Do the following to prepare to use the silent install and driver utility files.

1. Download the XPSCardPrinter_x.x.xxx.x.zip file from the Entrust website, or contact your service provider.
2. Extract the .zip file to a location on your computer.
3. Open a command prompt window. Select Run as administrator when opening the window.
4. Navigate to the directory where the files were extracted.
5. Select the appropriate command file.
   - Use the silentinstall.cmd command to continue with one of the following:
     - Silent Install Command on page E-2
     - Install Support Files on page E-5
Use the driverutility.cmd command to do the following:

- **Silent Update** on page E-6
- **Silent Uninstall** on page E-7

## Silent Install Command

The silentinstall.cmd allows the unattended network or USB install of the XPS Card Printer Driver. The command allows you to print a sample card and start the Printer Dashboard or Printer Manager as part of a network or USB install. You also use the command to install driver support files.

- You cannot perform both a network and a USB connection using a single command.
- If the Card Printer Driver already is installed, use the DriverUtility.cmd to update to a newer version.
- The silentinstall.cmd command includes help text that describes the command and provides usage examples. Enter the command with no parameters to display the help information.

### Network Install

Use the silentinstall.cmd command to install the Card Printer Driver using a network connection. The command has the following format:

```
silentinstall.cmd network IPaddress PrintSampleCard DisplayDashboard
```

**network** Installs a network printer.

**IPaddress** Enter the IP address of the printer. If no IP address is specified, the command installs the driver at 0.0.0.0.

**PrintSampleCard** Prints the driver sample card.

*Note:* If the driver installed at 0.0.0.0, you cannot print a sample card.

**DisplayDashboard** Opens a browser window that allows you to start the Printer Dashboard or Printer Manager.

*Note:* If the driver installed at 0.0.0.0, you cannot display the Printer Dashboard or Printer Manager.

When the command completes, the message “Network Printer Driver install successful” displays. The printer icon is added to the Devices and Printers window and the Printer Dashboard icon is placed on the computer desktop.
Network Install Examples

- Install the Card Printer Driver. The driver installs with an IP address of 0.0.0.0. You cannot print a sample card or start the Printer Dashboard.

  silentinstall.cmd network

- Install the Card Printer Driver at IP address 123.45.6.789.

  silentinstall.cmd network 123.45.6.789

- Install the Card Printer Driver at IP address 123.45.6.789 and start the Printer Dashboard or Printer Manager.

  silentinstall.cmd network 123.45.6.789 DisplayDashboard

- Install the Card Printer Driver at IP address 123.45.6.789 and print a driver sample card.

  silentinstall.cmd network 123.45.6.789 PrintSampleCard

- Install the Card Printer Driver at IP address 123.45.6.789, print a driver sample card, and start the Printer Dashboard or Printer Manager.

  silentinstall.cmd network 123.45.6.789 PrintSampleCard DisplayDashboard

USB Install

Use the silentinstall.cmd command to install the Card Printer Driver using a USB connection. The command has the following format:

  silentinstall.cmd usb PrintSampleCard DisplayDashboard

where:

  usb             Installs a USB printer.
  PrintSampleCard Prints the driver sample card.
  DisplayDashboard Opens a browser window that allows you to start the Printer Dashboard or Printer Manager.

**Caution:** Do not plug in the USB cable until instructed.

The message “USB Printer Driver install successful” displays, followed by the message “Connect USB cable to printer.” Plug in the USB cable to complete the installation. The printer icon is added to the Devices and Printers window and the Printer Dashboard icon is placed on the computer desktop.
USB Install Examples

- Install the Card Printer Driver using a USB connection. Plug in the USB cable when prompted.
  
  `silentinstall.cmd usb`

- Install the Card Printer Driver using a USB connection, and start the Printer Dashboard or Printer Manager.
  
  `silentinstall.cmd usb DisplayDashboard`

- Install the Card Printer Driver using a USB connection and print a driver sample card.
  
  `silentinstall.cmd usb PrintSampleCard`

- Install the Card Printer Driver using a USB connection, print a driver sample card, and start the Printer Dashboard.
  
  `silentinstall.cmd usb PrintSampleCard DisplayDashboard`

Silent Install Messages

If the Card Printer Driver does not install successfully, one of the following messages displays:

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
</table>
| · Network Printer Driver install failed  
· USB Printer Driver install failed | The network or USB driver did not install properly. This can result from one of the following:  
· The network IP address entered is not valid. Verify the IP address and run the silent install command again.  
· The USB printer was plugged in before running the silent install command. Do not plug in the printer until prompted. |
| Windows updates are pending | One or more Windows updates are pending. Finish installing the Windows updates and run the silent install command again. |
| · Network Printer Driver update needed  
· USB Printer Driver update needed | A previous version of the driver is already installed on the computer. Update the Card Printer Driver. Refer to “Silent Update” on page E-6. |
| Newer driver already installed | A newer version of the Card Printer Driver is already installed. |
Install Support Files

Additional support files are available for the Card Printer Driver. Some support files are not installed automatically when the driver is installed, or copied to a shared client when installing the driver on a client system.

The silentinstall.cmd does not install the magnetic stripe font support files (MagstripeFonts and LegacyMagstripeFonts). If you need to install the magnetic stripe font support files, refer to “Install Support Files” on page 24.

Shared Printer Client Support

Use the following command to install the support files on a shared printer client system:

```
silentinstall.cmd CustomMaskingBitmaps
```

where:

- **CustomMaskingBitmaps** installs bitmap files on a shared printer client. You can modify the files to create user-defined bitmaps for print blocking or erase areas. The message “Printer Driver CustomMaskingBitmaps successful” displays when the install completes.

Legacy Application Support

The following command installs files that support legacy desktop printers. Use the command to install the files on both the local computer and shared client systems:

```
silentinstall.cmd XpsCardPrinterPlugin
```

where:

- **XpsCardPrinterPlugin** installs the XPS Card Printer plug-in for Datacard ID software. You must have Datacard ID Works® Identification Software or Datacard IDCentre™ Identification Software already installed on your system.

  The plug-in install is not silent. A wizard displays to guide you through the installation.
If a support file does not install successfully, one of the following messages displays.

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Printer Driver CustomMaskingBitmaps failed</td>
<td>The install of the selected support file failed. Restart the computer and try installing the selected support file again.</td>
</tr>
<tr>
<td>• Printer Driver XpsCardPrinterPlugin failed</td>
<td></td>
</tr>
<tr>
<td>Windows updates are pending</td>
<td>One or more Windows updates are pending. Finish installing the Windows updates and run the silent install command again to install the support file.</td>
</tr>
</tbody>
</table>

**Driver Utility Command**

The DriverUtility.cmd command allows you to update or uninstall the Card Printer Driver.

**Silent Update**

Use the DriverUtility.cmd command to update the installed driver to the latest version. Do the following to start the silent update of the Card Printer Driver.

1. Enter the following command in the command prompt window:
   
   ```cmd
   driverutility.cmd update
   ```

   Make sure that all print jobs have completed before starting the update.

   When the update completes successfully, the message “Printer Driver update successful” displays, followed by “Please restart the computer.”

2. Restart the computer to allow the driver update to take effect.
If the Card Printer Driver silent update does not succeed, one of the following messages displays:

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Driver update failed</td>
<td>The driver update did not succeed.</td>
</tr>
<tr>
<td></td>
<td>1. Remove the printers and uninstall the Card Printer Driver. Refer to “Silent Uninstall” or “Uninstall the Card Printer Driver” on page 63.</td>
</tr>
<tr>
<td></td>
<td>2. Run the silentinstall.cmd command to install the new driver version. Refer to “Silent Install Command” on page E-2.</td>
</tr>
<tr>
<td>Windows updates are pending</td>
<td>One or more Windows updates are pending. Finish installing the Windows updates and run the DriverUtility command again to update the Card Printer Driver.</td>
</tr>
<tr>
<td>Newer driver already installed</td>
<td>A newer version of the Card Printer Driver already is installed.</td>
</tr>
</tbody>
</table>

Silent Uninstall

Use the DriverUtility.cmd command to uninstall the Card Printer Driver.

Remove all XPS card printers before starting the uninstall process (refer to “Remove Devices” on page 63). Then, do the following to start the silent uninstall of the Card Printer Driver.

1. Enter the following command in the command prompt window:

   `driverutility.cmd uninstall`

   When the uninstall completes successfully, the message “Printer Driver uninstall successful” displays, followed by “Please restart the computer.”

2. Restart the computer to complete the uninstall.

   If you are removing a USB-connected printer, disconnect the USB cable from the printer when the uninstall completes. Restart the computer to complete the uninstall.
If the Card Printer Driver silent uninstall does not succeed, one of the following messages displays:

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Driver uninstall failed</td>
<td>The driver uninstall did not succeed. Make sure that there are no print jobs in the print queue before you remove the printers.</td>
</tr>
<tr>
<td>Windows updates are pending</td>
<td>One or more Windows updates are pending. Finish installing the Windows updates and run the silent install command again to uninstall the Card Printer Driver.</td>
</tr>
<tr>
<td>Driver cannot be uninstalled until printers are removed. The driver has not been uninstalled.</td>
<td>Remove the printers. Refer to “Remove Devices” on page 63, and then run the DriverUtility uninstall again.</td>
</tr>
</tbody>
</table>
CE-Series printers with an embosser can emboss up to three braille (Tactile Identifier Mark or TIM) characters on a card. Braille uses a 6-dot format to represent letters, numbers, and combinations of sounds. The embosser must have embosser font 11 installed to use this feature.

The braille characters are expressed as a sequence of numbers that indicate the position of the dots, with dots 1–3 in the left column, and dots 4–6 in the right column.

1 ●  ● 4
2 ●  ● 5
3 ●  ● 6

The CE system uses a single emboss character to form each dot. Up to three 6-dot characters can be embossed in any allowed location on the card.

The vertical and horizontal spacing between the embossed dots is 0.091 in (2.3 mm). The distance between characters is 0.240 in (6.1 mm).

Because there is no one-to-one correlation between the ASCII value and the braille character, use the following conversion table to map your ASCII data to the braille characters. The table includes the dot sequence for each character and its binary representation.

Some characters must be sent as an ASCII sequence because they are reserved XML characters. In addition, some characters have more than one valid value. All are shown in the following table.
<table>
<thead>
<tr>
<th>ASCII (dec)</th>
<th>ASCII (hex)</th>
<th>ASCII (char)</th>
<th>Braille Dots (dec)</th>
<th>Braille Dots (bin)</th>
<th>Cell</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>20</td>
<td>(space)</td>
<td>(none)</td>
<td>00000000</td>
<td></td>
<td>(space)</td>
</tr>
<tr>
<td>33</td>
<td>21</td>
<td>!</td>
<td>2-3-4-6</td>
<td>00101110</td>
<td>:➋</td>
<td>the</td>
</tr>
<tr>
<td>35-113-117-111-116-59</td>
<td>26-71-75-6F-74-3B</td>
<td>&quot;</td>
<td>5</td>
<td>00010000</td>
<td>⋅</td>
<td>(contraction)</td>
</tr>
<tr>
<td>35</td>
<td>23</td>
<td>#</td>
<td>3-4-5-6</td>
<td>00111100</td>
<td>⋅➋</td>
<td>(number prefix)</td>
</tr>
<tr>
<td>36</td>
<td>24</td>
<td>$</td>
<td>1-2-4-6</td>
<td>00101011</td>
<td>⋅➋</td>
<td>ed</td>
</tr>
<tr>
<td>37</td>
<td>25</td>
<td>%</td>
<td>1-4-6</td>
<td>00101001</td>
<td>⋅➋</td>
<td>sh</td>
</tr>
<tr>
<td>38-97-109-112-59</td>
<td>26-61-6D-70-3B</td>
<td>&amp;</td>
<td>1-2-3-4-6</td>
<td>00101111</td>
<td>⋅➋</td>
<td>and</td>
</tr>
<tr>
<td>40</td>
<td>28</td>
<td>(</td>
<td>1-2-3-5-6</td>
<td>00110111</td>
<td>⋅➋</td>
<td>of</td>
</tr>
<tr>
<td>41</td>
<td>29</td>
<td>)</td>
<td>2-3-4-5-6</td>
<td>00111110</td>
<td>⋅➋</td>
<td>with</td>
</tr>
<tr>
<td>42</td>
<td>2A</td>
<td>*</td>
<td>1-6</td>
<td>00100001</td>
<td>⋅</td>
<td>ch</td>
</tr>
<tr>
<td>43</td>
<td>2B</td>
<td>+</td>
<td>3-4-6</td>
<td>00101100</td>
<td>⋅</td>
<td>ing</td>
</tr>
<tr>
<td>44</td>
<td>2C</td>
<td>,</td>
<td>6</td>
<td>00100000</td>
<td>⋅</td>
<td>(uppercase prefix)</td>
</tr>
<tr>
<td>45</td>
<td>2D</td>
<td>-</td>
<td>3-6</td>
<td>00100100</td>
<td>⋅</td>
<td>-</td>
</tr>
<tr>
<td>46</td>
<td>2E</td>
<td>.</td>
<td>4-6</td>
<td>00101000</td>
<td>⋅</td>
<td>(italic prefix)</td>
</tr>
<tr>
<td>47</td>
<td>2F</td>
<td>/</td>
<td>3-4</td>
<td>00001100</td>
<td>⋅</td>
<td>st</td>
</tr>
<tr>
<td>48</td>
<td>30</td>
<td>0</td>
<td>3-5-6</td>
<td>00110100</td>
<td>⋅➋</td>
<td>“</td>
</tr>
<tr>
<td>49</td>
<td>31</td>
<td>1</td>
<td>2</td>
<td>00000010</td>
<td>⋅</td>
<td>,</td>
</tr>
<tr>
<td>50</td>
<td>32</td>
<td>2</td>
<td>2-3</td>
<td>00000110</td>
<td>⋅</td>
<td>;</td>
</tr>
<tr>
<td>51</td>
<td>33</td>
<td>3</td>
<td>2-5</td>
<td>00100100</td>
<td>⋅</td>
<td>:</td>
</tr>
<tr>
<td>52</td>
<td>34</td>
<td>4</td>
<td>2-5-6</td>
<td>00110010</td>
<td>⋅</td>
<td>.</td>
</tr>
<tr>
<td>ASCII (dec)</td>
<td>ASCII (hex)</td>
<td>ASCII (char)</td>
<td>Braille Dots (dec)</td>
<td>Braille Dots (bin)</td>
<td>Cell</td>
<td>Meaning</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>--------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>53</td>
<td>35</td>
<td>5</td>
<td>2-6</td>
<td>00100010</td>
<td>.</td>
<td>en</td>
</tr>
<tr>
<td>54</td>
<td>36</td>
<td>6</td>
<td>2-3-5</td>
<td>00010110</td>
<td>:</td>
<td>!</td>
</tr>
<tr>
<td>55</td>
<td>37</td>
<td>7</td>
<td>2-3-5-6</td>
<td>00110110</td>
<td>: :</td>
<td>( or )</td>
</tr>
<tr>
<td>56</td>
<td>38</td>
<td>8</td>
<td>2-3-6</td>
<td>00100110</td>
<td>: :</td>
<td>“ or ?</td>
</tr>
<tr>
<td>57</td>
<td>39</td>
<td>9</td>
<td>3-5</td>
<td>00010100</td>
<td>.</td>
<td>in</td>
</tr>
<tr>
<td>58</td>
<td>3A</td>
<td>:</td>
<td>1-5-6</td>
<td>00110001</td>
<td>:</td>
<td>wh</td>
</tr>
<tr>
<td>59</td>
<td>3B</td>
<td>;</td>
<td>5-6</td>
<td>00110000</td>
<td>:</td>
<td>(letter prefix)</td>
</tr>
<tr>
<td>124</td>
<td>7C</td>
<td></td>
<td></td>
<td>1-2-6</td>
<td>:</td>
<td>gh</td>
</tr>
<tr>
<td>61</td>
<td>3D</td>
<td>=</td>
<td>1-2-3-4-5-6</td>
<td>00111111</td>
<td>: :</td>
<td>for</td>
</tr>
<tr>
<td>126</td>
<td>7E</td>
<td>~</td>
<td>3-4-5</td>
<td>00011100</td>
<td>:</td>
<td>ar</td>
</tr>
<tr>
<td>63</td>
<td>3F</td>
<td>?</td>
<td>1-4-5-6</td>
<td>00111001</td>
<td>:</td>
<td>th</td>
</tr>
<tr>
<td>64</td>
<td>40</td>
<td>@</td>
<td>4</td>
<td>00001000</td>
<td>*</td>
<td>(accent prefix)</td>
</tr>
<tr>
<td>65 or 97</td>
<td>41 or 61</td>
<td>A or a</td>
<td>1</td>
<td>00000001</td>
<td>*</td>
<td>a</td>
</tr>
<tr>
<td>66 or 98</td>
<td>42 or 62</td>
<td>B or b</td>
<td>1-2</td>
<td>00000011</td>
<td>:</td>
<td>b</td>
</tr>
<tr>
<td>67 or 99</td>
<td>43 or 63</td>
<td>C or c</td>
<td>1-4</td>
<td>00001001</td>
<td>: :</td>
<td>c</td>
</tr>
<tr>
<td>68 or 100</td>
<td>44 or 64</td>
<td>D or d</td>
<td>1-4-5</td>
<td>00011001</td>
<td>: :</td>
<td>d</td>
</tr>
<tr>
<td>69 or 101</td>
<td>45 or 65</td>
<td>E or e</td>
<td>1-5</td>
<td>00010001</td>
<td>*</td>
<td>e</td>
</tr>
<tr>
<td>70 or 102</td>
<td>46 or 66</td>
<td>F or f</td>
<td>1-2-4</td>
<td>00001011</td>
<td>: :</td>
<td>f</td>
</tr>
<tr>
<td>71 or 103</td>
<td>47 or 67</td>
<td>G or g</td>
<td>1-2-4-5</td>
<td>00011011</td>
<td>: :</td>
<td>g</td>
</tr>
<tr>
<td>72 or 104</td>
<td>48 or 68</td>
<td>H or h</td>
<td>1-2-5</td>
<td>00010011</td>
<td>: :</td>
<td>h</td>
</tr>
<tr>
<td>73 or 105</td>
<td>49 or 69</td>
<td>I or i</td>
<td>2-4</td>
<td>00001010</td>
<td>*</td>
<td>i</td>
</tr>
<tr>
<td>74 or 106</td>
<td>4A or 6A</td>
<td>J or j</td>
<td>2-4-5</td>
<td>00011010</td>
<td>: :</td>
<td>j</td>
</tr>
<tr>
<td>75 or 107</td>
<td>4B or 6B</td>
<td>K or k</td>
<td>1-3</td>
<td>00000101</td>
<td>:</td>
<td>k</td>
</tr>
<tr>
<td>ASCII (dec)</td>
<td>ASCII (hex)</td>
<td>ASCII (char)</td>
<td>Braille Dots (dec)</td>
<td>Braille Dots (bin)</td>
<td>Cell</td>
<td>Meaning</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>--------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>76 or 108</td>
<td>4C or 6C</td>
<td>L or l</td>
<td>1-2-3</td>
<td>00000111</td>
<td>:</td>
<td>l</td>
</tr>
<tr>
<td>77 or 109</td>
<td>4D or 6D</td>
<td>M or m</td>
<td>1-3-4</td>
<td>00001101</td>
<td>:</td>
<td>m</td>
</tr>
<tr>
<td>78 or 110</td>
<td>4E or 6E</td>
<td>N or n</td>
<td>1-3-4-5</td>
<td>00011101</td>
<td>:</td>
<td>n</td>
</tr>
<tr>
<td>79 or 111</td>
<td>4F or 6F</td>
<td>O or o</td>
<td>1-3-5</td>
<td>00010101</td>
<td>:</td>
<td>o</td>
</tr>
<tr>
<td>80 or 112</td>
<td>50 or 70</td>
<td>P or p</td>
<td>1-2-3-4</td>
<td>00001111</td>
<td>:</td>
<td>p</td>
</tr>
<tr>
<td>81 or 113</td>
<td>51 or 71</td>
<td>Q or q</td>
<td>1-2-3-4-5</td>
<td>00011111</td>
<td>:</td>
<td>q</td>
</tr>
<tr>
<td>82 or 114</td>
<td>52 or 72</td>
<td>R or r</td>
<td>1-2-3-5</td>
<td>00010111</td>
<td>:</td>
<td>r</td>
</tr>
<tr>
<td>83 or 115</td>
<td>53 or 73</td>
<td>S or s</td>
<td>2-3-4</td>
<td>00001110</td>
<td>:</td>
<td>s</td>
</tr>
<tr>
<td>84 or 116</td>
<td>54 or 74</td>
<td>T or t</td>
<td>2-3-4-5</td>
<td>00011110</td>
<td>:</td>
<td>t</td>
</tr>
<tr>
<td>85 or 117</td>
<td>55 or 75</td>
<td>U or u</td>
<td>1-3-6</td>
<td>00100101</td>
<td>:</td>
<td>u</td>
</tr>
<tr>
<td>86 or 118</td>
<td>56 or 76</td>
<td>V or v</td>
<td>1-2-3-6</td>
<td>00100111</td>
<td>:</td>
<td>v</td>
</tr>
<tr>
<td>87 or 119</td>
<td>57 or 77</td>
<td>W or w</td>
<td>2-4-5-6</td>
<td>00111010</td>
<td>:</td>
<td>w</td>
</tr>
<tr>
<td>88 or 120</td>
<td>58 or 78</td>
<td>X or x</td>
<td>1-3-4-6</td>
<td>00101101</td>
<td>:</td>
<td>x</td>
</tr>
<tr>
<td>89 or 121</td>
<td>59 or 79</td>
<td>Y or y</td>
<td>1-3-4-5-6</td>
<td>00111101</td>
<td>:</td>
<td>y</td>
</tr>
<tr>
<td>90 or 122</td>
<td>5A or 7A</td>
<td>Z or z</td>
<td>1-3-5-6</td>
<td>00110101</td>
<td>:</td>
<td>z</td>
</tr>
<tr>
<td>91</td>
<td>5B</td>
<td>[</td>
<td>2-4-6</td>
<td>00101010</td>
<td>:</td>
<td>ow</td>
</tr>
<tr>
<td>92</td>
<td>5C</td>
<td>\</td>
<td>1-2-5-6</td>
<td>00110011</td>
<td>:</td>
<td>ou</td>
</tr>
<tr>
<td>93</td>
<td>5D</td>
<td>]</td>
<td>1-2-4-5-6</td>
<td>00111011</td>
<td>:</td>
<td>er</td>
</tr>
<tr>
<td>94</td>
<td>5E</td>
<td>^</td>
<td>4-5</td>
<td>00011100</td>
<td>:</td>
<td>(contraction)</td>
</tr>
<tr>
<td>95</td>
<td>5F</td>
<td>_</td>
<td>4-5-6</td>
<td>00111000</td>
<td>:</td>
<td>(contraction)</td>
</tr>
</tbody>
</table>